No man is an island, even in Salesforce. Complete tasks quickly and efficiently by collaborating with people either inside or outside of your organization.

Here you’ll find information on collaboration tools like Chatter, Salesforce CRM Content, and even documents. There’s no limit to what you can accomplish with others—figure out the best way to do it here.

IN THIS SECTION:

**Collaborate Within Your Company**
Stay current with what’s happening in your company. Share your knowledge in Chatter posts and comments, collaborate in groups, and access files and data across your organization.

**Collaborate with Partners and Customers**
Share updates with customers and partners in Chatter groups.

**Other Resources**
Need more info? Check out these videos and tipsheets.

---

**Collaborate Within Your Company**

Stay current with what’s happening in your company. Share your knowledge in Chatter posts and comments, collaborate in groups, and access files and data across your organization.

IN THIS SECTION:

**Share Updates with People (Chatter)**
Share updates with coworkers, collaborate in Chatter groups, and view record updates.

**Create, Share, and Organize Files**
Post files to feeds and records, share files with customers in the Salesforce cloud, and sync files between your local drive and Salesforce.

**Skype for Salesforce (Beta)**
Skype for Salesforce integrates Salesforce and Skype for Business®, allowing your users to chat with and make audio and video calls to other users without leaving Salesforce. Skype for Salesforce is available only if your business has a Skype for Business online license.

---

**Share Updates with People (Chatter)**

Share updates with coworkers, collaborate in Chatter groups, and view record updates.

IN THIS SECTION:

**Chatter Overview**
Use Chatter features like feeds, profiles, groups, and more to share information, collaborate, and keep up with the latest updates in your company.
Get Started with Chatter
Connect with people and share business information securely and in real time.

Work with Feeds
Stay up to date on posts and comments you and other people make, as well as record changes across your Salesforce organization.

Chatter Streams
Chatter streams are custom feeds that you create from the information that’s most useful to you. Look for streams on your Chatter home page. Create up to five streams that combine posts from up to 25 different feeds and feed types. Create streams that combine feeds from people, groups, and records, like accounts, opportunities, cases, and more.

Work with Posts
Share information and collaborate with other people inside and outside your organization.

People in Your Organization
Update your personal profile and view the profile of other people in your organization.

Records and List Views
Configure your follow settings for records, view Chatter feeds on list views, and learn more about record recommendations.

Collaborate in Chatter Groups
Use public, private, or unlisted Chatter groups to collaborate with specific people in your company.

Chatter Messenger (Chat)
Chat instantly and securely with coworkers. Chatter Messenger is not available in new orgs created after the Spring ’16 release.

Private Messages
Use Chatter messages for secure private conversations with other Chatter users.

Chatter Questions
Got questions? Use Chatter Questions to post a question in your Chatter feed, then watch the solutions roll in.

Chatter Overview
Use Chatter features like feeds, profiles, groups, and more to share information, collaborate, and keep up with the latest updates in your company.

Chatter works in accordance with all of the security and permission settings in your Salesforce organization. Chatter is enabled by default for organizations created after June 22, 2010. For existing organizations, your administrator must enable Chatter. You can access the Chatter app in the app menu in the top right corner of any page. If your administrator added Chatter tabs to other apps and you previously customized your display, you need to add the tabs manually.

Some third-party Web browser plug-ins and extensions can interfere with the functionality of Chatter. If you experience malfunctions or inconsistent behavior with Chatter, disable the Web browser’s plug-ins and extensions and try again.

Chatter is not supported:
- Using Microsoft® Internet Explorer version 6.0
- For external users in Customer Portals or partner portals
- In the Console tab

Posts and comments that users make in Chatter are retained during the entire time that a customer’s applicable org remains provisioned. We reserve the right to enforce limits on:

EDITIONS
Available in: both Salesforce Classic and Lightning Experience
Available in: Group, Enterprise, Professional, Performance, Unlimited, Contact Manager, and Developer Editions
• The number of system-generated tracked feed updates. Currently tracked feed updates that are older than 45 days and have no likes or comments are deleted automatically. The tracked feed updates no longer appear in the feed. However, if auditing is enabled for a tracked field, the audit history for that field is still available.

• The number of email notifications that can be sent per org per hour.
The limits are subject to change. Contact Salesforce for more information.

Get Started with Chatter
Connect with people and share business information securely and in real time.

IN THIS SECTION:

Chatter Tab Overview
The Chatter tab is your collaboration home base and gives you instant access to most of the collaboration features in Chatter.

The People and Records You Auto-Follow Initially
Like Posts and Comments
Like posts or comments to show your support and receive email notifications if others comment on that post.

Replying to Chatter Email Notifications
Navigate to Chatter Email Settings
Find your Chatter email settings so you can change your preferences for receiving email notifications and digests.

Chatter Email Digests
Email digests conveniently summarize recent activity in Chatter so you don’t miss important discussions. You can choose to receive daily or weekly summaries of updates from your personal feed or any group’s feed.

Guidelines for Managing Your Personal Chatter Email Settings
Control the number of Chatter emails you receive by choosing the most important emails and the appropriate frequency of personal and group digests.

What do “company” and “organization” mean in Chatter?
Can I invite people from my company who don’t have Salesforce licenses?

Chatter Tab Overview
The Chatter tab is your collaboration home base and gives you instant access to most of the collaboration features in Chatter.

From the Chatter tab you can:

• Make a post that’s shared with people who follow you, or comment on someone else’s post.
• Like posts or comments to show your support.
• Share a post to your profile or to a group, or send a link to the post to other Chatter users in an email or instant message.
• View, filter, and sort your feed on the left side to view posts from people and records you follow and groups you’re a member of, posts that mention you, posts you bookmarked, or all posts from your company.
• Search the feed to quickly find information in the feed posts and comments on the Chatter tab.
• Bookmark a post to keep track of future comments on the post, or to remember to follow up on the post later.
• Add topics to a post to categorize the post and give it more visibility.
• Access your people, groups, files, and topics lists.
• View or update your profile, such as your profile photo or your contact information.
• Read or send private messages that are only visible to certain people.
• Access your favorites to see the latest posts and comments for your favorite topics, list views, and Chatter feed searches.
• View your recommendations for people, groups, files, and records that closely relate to your job and interests.
• View trending topics that people are discussing in Chatter right now.
• Invite people to join your Chatter network if they don’t have Salesforce licenses to use Chatter.

Chatter Desktop

Chatter Desktop Overview

Chatter Desktop is a free desktop application that lets you collaborate in Chatter without a browser. Use Chatter Desktop to post and comment in Chatter, and receive updates about your groups and the people, records, and files you follow. Chatter Desktop also supports chat, private Chatter messages, and displays Chatter updates and private messages as popup notifications in your Windows taskbar or Mac OS X Dock.

Note: Customer users can install and use Chatter Desktop but can’t access all of its functionality. For example, customer users can’t follow users or records, chat, or access administration options.

Install Chatter Desktop

Salesforce provides two Chatter Desktop installers: a standard version for individual installations and a managed version for enterprise deployments.

The following are the minimum requirements for using Chatter Desktop:

• Windows
  – 2.33GHz or faster x86-compatible processor, or Intel Atom™ 1.6GHz or faster processor for netbook devices
  – 512MB of RAM (1GB recommended)

• Mac
  – Intel® Core™ Duo 1.83GHz or faster processor
  – Mac OS X v 10.5, 10.6, or v10.7
  – 512MB of RAM (1GB recommended)

Important: Chatter Desktop uses Adobe® Integrated Runtime (AIR®), Adobe’s cross-platform runtime environment for desktop applications, and only runs on operating systems that Adobe AIR supports. Chatter Desktop does not run on operating systems that Adobe AIR does not support, such as 64-bit Linux. See the Adobe website for information on Adobe AIR.
The standard version:

- Requires administrator privileges on your machine
- Doesn’t require administrator privileges in Salesforce
- Automatically installs the required version of Adobe® Integrated Runtime (AIR®)
- Requires acceptance of an end user license agreement the first time Chatter Desktop launches
- Posts “Installed Chatter Desktop” to Chatter the first time Chatter Desktop launches
- Periodically checks Salesforce for new versions

To install the standard version:

1. From your personal settings, enter Chatter Desktop in the Quick Find box, then select Chatter Desktop.
2. Click the Download Now badge.
3. Follow the on-screen instructions.

Note: Administrators can disable the Chatter Desktop download page and block users from accessing Chatter Desktop.

Important: Chatter Desktop uses Adobe® Acrobat® Reader to preview PDF files. Before previewing files with Chatter Desktop, download Adobe Acrobat from Adobe’s website, install it, and open it at least once to complete the installation.

SEE ALSO:

Uninstalling Chatter Desktop

Connecting Chatter Desktop

If you have multiple Salesforce or Chatter logins, create a connection for each login. The connection lets Chatter Desktop access the Chatter data you can access with that login on the Web.

1. Click ⚙️ and select Settings.
2. In the Connections section, enter a name for the connection and the URL from which you log in. The URL must begin with https:// and end with salesforce.com or chatter.com. For example, if your organization has a European division that you log into from https://emea.salesforce.com, enter that URL and name the connection Europe.

By default, Chatter Desktop connects to your main instance of Salesforce (Production) or your Force.com sandbox.

3. Click Authorize and follow the on-screen instructions to authorize Chatter Desktop to connect using the login.

Use the radio buttons on the Settings screen to specify a default connection. To quickly switch connections while using Chatter Desktop, click ⚙️, select Switch Connection, and choose the connection.

Note: You can create multiple connections, but Chatter Desktop can log into only one connection at a time. You cannot use Chatter Desktop to display data from multiple connections simultaneously.

SEE ALSO:

Configuring Chatter Desktop
Configuring Chatter Desktop

The default Chatter Desktop configuration is appropriate for most users, but several Chatter Desktop settings are configurable. To access Chatter Desktop settings, click \[ puck \] and select Settings. From the Settings screen, you can:

- Configure Chatter Desktop to launch when you start your computer.
- Configure Chatter Desktop to minimize when you close it.
- Turn popup notifications on or off. Popup notifications are enabled by default.
- Manage alerts for new feed posts and comments (advanced settings).
- Configure Chatter Desktop to always display in the foreground (advanced settings).
- Move the chat window to the foreground when you receive a new message.
- Play sounds when someone starts a new chat with you, or play a sound for every chat message when a chat is minimized or out of focus (for example, if you have multiple chats or are using another application).
- Edit your connections.

SEE ALSO:
Chatter Desktop Troubleshooting Tips

Using Chatter Desktop

In the Chatter Desktop window:

<table>
<thead>
<tr>
<th>Click:</th>
<th>To:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your profile photo</td>
<td>Change your chat status. Select [ Available ], [ Away ], or [ Offline ]. People can’t chat with you when you’re [ Offline ].</td>
</tr>
<tr>
<td>[ facebook ]</td>
<td>See feed updates from everyone and everything you follow, and post an update.</td>
</tr>
<tr>
<td>[ facebook ]</td>
<td>For any feed post, click [ Comment ] to add a comment, [ Like ] to receive email notifications if others comment on that post, or [ Delete ] to delete the post, if you have access.</td>
</tr>
<tr>
<td>[ facebook ]</td>
<td>To post a file from your computer, drag the file to [ office ], or click [ office ], which appears when you type a post.</td>
</tr>
<tr>
<td>[ facebook ]</td>
<td>To post a link, type the link in the text box at the top of your feed, or click [ office ], which appears when you type a post.</td>
</tr>
<tr>
<td>[ facebook ]</td>
<td>Use the [ Sort By ] filter at the top of a feed to sort updates:</td>
</tr>
<tr>
<td></td>
<td>- Post Date—Sorts feeds by post date. To see comments, you must click [ Show All Comments ] below a post.</td>
</tr>
<tr>
<td></td>
<td>- Post and Comment Date—Sorts feeds by post and comment date. Each comment appears again when you click [ Show All Comments ] under its associated post.</td>
</tr>
</tbody>
</table>
Collaborate with Everyone

See and comment on updates directed to you.

Chat with people and see their updates. Chat messages are displayed in a separate window.

- Click **Chat Favorites** to see people or chats you’ve added as favorites. To add a favorite, click 🌟 next to someone’s name or in any active chat with one or more people.
- Click **Following** or **Followers** then click a person’s name to see their updates or post to their feed.
- Hover over someone’s name:
  - Click 💌 to send them a private message.
  - Click 🌟 to add them as a favorite chat. Their name appears in your **Chat Favorites** list.
  - Click 👤 to follow someone or ✖️ to stop following them.
  - Click 📬 to start a chat. You can then add up to 10 people to the same chat by clicking 👤 in the chat window and searching for people to add. You can’t chat with people who are ✅ Offline.

**Note:** Chat is only available if it’s enabled in your organization.

Read and reply to private Chatter messages. Click a message to view it, or click **New Message** to send a new message.

**Note:** Messages are only available if they are enabled in your organization.

See feed updates from groups:

- Click a group name or search for a group to view its feed or to post updates. You can post in all public groups and any private groups that you belong to.
- Click **Join** to join a group, or **Member** to leave the group.
- Click 📨 to view the group description.

See and comment on records you follow. From the drop-down menu at the top, select the type of record you want to view, for example, Account. If you’re not following records, there won’t be any records in the list. Click a record’s name to view its details. Chatter Desktop shows the first eight fields on a record.

Edit your **Chatter Desktop settings** or switch your connection.

Instantly synchronize your data. While Chatter Desktop synchronizes your data automatically, it does not always happen instantly.

SEE ALSO:

Chatter Desktop Troubleshooting Tips
## Chatter Desktop Troubleshooting Tips

Find solutions for troubleshooting Chatter Desktop.

Chatter Desktop uses Adobe® Integrated Runtime (AIR®). This table describes solutions to common AIR-related issues. For more information, consult the Adobe® knowledge base.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
</table>
| The Chatter Desktop installation fails | Delete the Shared Local Object (SLO) and Encrypted Local Store (ELS) directories and reinstall Chatter Desktop.  
The SLO stores persistent information like last screen position and size and is located at  
- **Mac OS:** /\[USER\]/Library/Preferences/sfdc-desktop*  
- **Windows Vista, Windows 7, Windows 8.x:** C:\Users\<USER>\AppData\Roaming\sfdc-desktop*  
- **Windows XP:** C:\Documents and Settings\<USER>\Application Data\sfdc-desktop*  
The ELS stores the OAuth2.0 identities for users and is located at  
- **Mac OS:** /\[USER\]/Library/Application Support/Adobe/AIR/ELS/sfdc-desktop*  
- **Windows Vista, Windows 7, Windows 8x:** C:\Users\<USER>\AppData\Roaming\Adobe\AIR\ELS\sfdc-desktop*  
- **Windows XP:** C:\Documents and Settings\<USER>\Application Data\Adobe\AIR\ELS\sfdc-desktop* |
| Chatter Desktop on Linux freezes, presents an empty window, doesn’t save your password, or malfunctions in another way | If you’re using the managed installation, verify  
- The .chatterdesktop file is well-formed and contains valid XML  
- The URLs in the .chatterdesktop file are valid and each URL begins with https:// and ends with salesforce.com  
Also troubleshoot your Encrypted Local Storage (ELS) keystore. For more information, see  
http://kb2.adobe.com/cps/492/cpsid_49267.html |
| Chatter Desktop doesn’t preview PDF files | Chatter Desktop uses Adobe® Acrobat® Reader to preview PDF files. Before previewing files with Chatter Desktop, download Adobe Acrobat from Adobe’s website, install it, and open it at least once to complete the installation.  
Photos with comments don’t refresh | Click the sync icon. |

SEE ALSO:  
Configuring Chatter Desktop
Disabling Chatter Desktop Remotely

If the computer on which you installed Chatter Desktop is stolen or lost, you can block Chatter Desktop from accessing your Salesforce data.

1. From your personal settings, enter Advanced User Details in the Quick Find box, then select Advanced User Details. No results? Enter Personal Information in the Quick Find box, then select Personal Information.
2. Click Revoke next to Chatter Desktop in the Remote Access section.

SEE ALSO:
  Chatter Desktop Troubleshooting Tips

Uninstalling Chatter Desktop

How to uninstall Chatter Desktop.

Windows:
1. Go to Start > Control Panel > Uninstall a program.
2. Double click Chatter Desktop. You can also right-click it and select Uninstall.
3. Click Yes when prompted.

Mac:
1. Go to your applications folder. You can also type applications in Spotlight.
2. Find the salesforce.com folder with Chatter Desktop in it and drag it to the trash.

Chatter Desktop Releases

This table describes the updates in each Chatter Desktop release.

<table>
<thead>
<tr>
<th>Version</th>
<th>Updates</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.2.3</td>
<td>• Installer certificate update</td>
</tr>
<tr>
<td>3.2.2</td>
<td>• Installer certificate update</td>
</tr>
<tr>
<td>3.2.1</td>
<td>• Installer certificate update</td>
</tr>
</tbody>
</table>
| 3.2     | • Configure desktop alerts for new feed posts and comments  
|         | • Configure Chatter Desktop to always display in the foreground  
|         | • Delete feed posts if you have access  
|         | • Post in all public groups  
|         | • Scrolling and active links supported in group descriptions  

SEE ALSO:
  Uninstalling Chatter Desktop

Available in: both Salesforce Classic and Lightning Experience

Available in: Group, Enterprise, Professional, Performance, Unlimited, Contact Manager, and Developer Editions
<table>
<thead>
<tr>
<th>Version</th>
<th>Features</th>
</tr>
</thead>
</table>
| 1.3.3    | - Global search for @mentions  
|         | - Create new instances on the Login screen  
|         | - Switch and authenticate instances without restarting  
|         | - Miscellaneous bug fixes, including an issue that generated empty notifications and an issue with the installer |
| 1.3.2    | - An intermediate build to accommodate changes to Adobe AIR. Chatter Desktop immediately performs an additional update after 1.3.2 installs. |
| 1.2.1    | - Locale fixes for Norwegian, Danish, Finnish and Dutch |
| 2.0      | - A new user interface and visual design  
|         | - View records |
| 2.1      | - Support for customer users  
|         | - Support for private Chatter messages  
|         | - Miscellaneous bug fixes, including an issue with popup notifications stealing OS focus |
| 3.0      | - Chat with one or more people in your organization  
|         | - Like comments  
|         | - View a list of people who like a post or comment  
|         | - View files attached to comments  
|         | - View dashboard snapshots  
|         | - View shared messages  
|         | - Several miscellaneous bug fixes, including feed improvements using new components and an issue that prevented adding an @mention after a #topic |
| 3.1      | - Installer certificate update |
| 3.1.1    | - Miscellaneous bug fixes including negative counts and names displayed twice in likes and broken hash tag topic links. |
| 2.1      | - Support for customer users  
|         | - Support for private Chatter messages  
|         | - Miscellaneous bug fixes, including an issue with popup notifications stealing OS focus |
| 2.0      | - A new user interface and visual design  
|         | - View records |
| 1.3.3    | - Global search for @mentions  
|         | - Create new instances on the Login screen  
|         | - Switch and authenticate instances without restarting  
|         | - Miscellaneous bug fixes, including an issue that generated empty notifications and an issue with the installer |
| 1.3.2    | - An intermediate build to accommodate changes to Adobe AIR. Chatter Desktop immediately performs an additional update after 1.3.2 installs. |
| 1.2.1    | - Locale fixes for Norwegian, Danish, Finnish and Dutch |
### 1.2.0
- User and group details
- Links to indicate you like a post
- @mentions, which render in feeds and link to the mentioned user's profile
- #topics, which render in feeds and link to search results in your browser
- Auto-complete for @mentions and #topics
- Performance improvements including image caching
- Norwegian language support
- Miscellaneous bug fixes

### 1.1.1
- Updated for use with chatter.com
- Minor bug fixes

### 1.1.0
- Click files to preview them
- Select the To:Me tab to see posts directed to you
- Click groups and users to view their walls
- Write on the walls of groups and users

### 1.0.7
- Photo loading issue resolved

### 1.0.6
- Performance optimizations for people and groups
- Release of Chatter Desktop managed version

### 1.0.5
- An option to log into your Developer Sandbox
- Performance optimizations
- Korean locale fixes

SEE ALSO:
- Install Chatter Desktop
The People and Records You Auto-Follow Initially

Starting in June 2010, when your administrator initially turns on Chatter, we help get you started by automatically following certain users and records in your organization. Who and what you auto-follow differ based on the size of your organization:

<table>
<thead>
<tr>
<th>If Your Organization Has:</th>
<th>Users You Follow</th>
<th>Records You Follow</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 users or fewer</td>
<td>All users in your organization</td>
<td>Up to 25 of your most recently used records, in the following order:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1. Open opportunities you own</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2. Accounts you own</td>
</tr>
<tr>
<td></td>
<td></td>
<td>3. Open cases you own</td>
</tr>
<tr>
<td></td>
<td></td>
<td>4. Contacts you own</td>
</tr>
<tr>
<td></td>
<td></td>
<td>5. Open opportunities you created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6. Accounts you created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7. Open cases you created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8. Contacts you created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9. Open opportunities you last modified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10. Accounts you last modified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>11. Open cases you last modified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>12. Contacts you last modified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>13. Open opportunities you viewed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>14. Accounts you viewed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>15. Open cases you viewed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>16. Contacts you viewed</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>16 or more users</th>
<th>Up to 25 users in your organization, including (if available):</th>
<th>Up to 25 of your most recently used records, in the following order:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Your manager</td>
<td>1. Open opportunities you own</td>
</tr>
<tr>
<td></td>
<td>• Users that report to your manager</td>
<td>2. Accounts you own</td>
</tr>
<tr>
<td></td>
<td>• Your subordinates</td>
<td>3. Open cases you own</td>
</tr>
<tr>
<td></td>
<td>• Teammates on your account teams</td>
<td>4. Contacts you own</td>
</tr>
<tr>
<td></td>
<td>• Teammates on your opportunity teams</td>
<td>5. Open opportunities you created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>6. Accounts you created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>7. Open cases you created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>8. Contacts you created</td>
</tr>
<tr>
<td></td>
<td></td>
<td>9. Open opportunities you last modified</td>
</tr>
<tr>
<td></td>
<td></td>
<td>10. Accounts you last modified</td>
</tr>
</tbody>
</table>

Available in: both Salesforce Classic and Lightning Experience
Available in: Group, Enterprise, Professional, Performance, Unlimited, Contact Manager, and Developer Editions
If Your Organization Has:

Users You Follow

Records You Follow

11. Open cases you last modified
12. Contacts you last modified
13. Open opportunities you viewed
14. Accounts you viewed
15. Open cases you viewed
16. Contacts you viewed

Note: The auto-follow setting for records only applies to the records that already exist at the time your administrator turns on Chatter. For any future records you create, auto-follow is disabled by default to reduce the number of updates you receive in your Chatter feed. However, if you want to receive updates on all future records you create, you can enable auto-follow in your personal settings.

SEE ALSO:
- People Recommendations
- Record Recommendations
- Automatically Follow Records You Create

Like Posts and Comments

Like posts or comments to show your support and receive email notifications if others comment on that post.

Below a post or comment, click Like.

After you click Like on a post, you receive email notifications if others comment on that post. If you click Like on a comment, only the user who posted the comment receives an email notification. You receive an email notification for any subsequent comments. You can change your email notification settings on page 16.

- To stop liking a post or a comment, click Unlike. When you stop liking a post or a comment, you don’t receive email notifications for subsequent comments or likes.
- View the profiles of others who have liked a post by clicking their name at the bottom of the post or comment, for example, “John Smith likes this.”
- If more than three people like a post, click the link to see the full list; for example, “You, John Smith, and 2 others like this.” From that list, you can follow or stop following people.
- Likes on comments show how many people have liked the comment, for example, “1 person” or “7 people”. To see their names, click the link.

SEE ALSO:
- Guidelines for Managing Your Personal Chatter Email Settings
Replied to Chatter Email Notifications

When you receive certain email notifications, you can conveniently perform some actions by replying directly from your email. You can reply to the types of email listed in the table, or any notification that displays a From address of reply@chatter.salesforce.com.

**Note:** To reply to email notifications, your administrator must enable email replies for your organization.

<table>
<thead>
<tr>
<th>Action</th>
<th>Type of Email</th>
<th>Text to Include in Your Reply</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bookmark a post</td>
<td>Someone posted to your profile or a group, mentioned you in a post, or shared your post</td>
<td>bookmark</td>
<td>N/A</td>
</tr>
<tr>
<td>Comment on a post</td>
<td>Someone posted, commented on your post, also commented after you, or mentioned you in a post or comment</td>
<td>The text of your comment</td>
<td>1,000 characters maximum. Replies that exceed the limit are truncated to the first 1,000 characters.</td>
</tr>
<tr>
<td>Follow someone</td>
<td>Someone posted, commented on your post, also commented after you, or mentioned you in a post or comment</td>
<td>follow</td>
<td>N/A</td>
</tr>
<tr>
<td>Like a comment</td>
<td>Someone commented on your post or also commented after you</td>
<td>like or +1</td>
<td>N/A</td>
</tr>
<tr>
<td>Like a post</td>
<td>Someone posted to your profile or a group, mentioned you in a post, or shared your post</td>
<td>like or +1</td>
<td>N/A</td>
</tr>
<tr>
<td>Mute a post</td>
<td>Any post or comment email when you no longer want to receive notifications for the original post</td>
<td>mute</td>
<td>N/A</td>
</tr>
<tr>
<td>Respond to a Chatter message</td>
<td>Someone sent you a message</td>
<td>The text of your response</td>
<td>10,000 characters maximum. Replies that exceed the limit are truncated to the first 10,000 characters.</td>
</tr>
</tbody>
</table>

**EDITIONS**

Available in: both Salesforce Classic and Lightning Experience

Available in: **Group, Enterprise, Professional, Performance, Unlimited, Contact Manager, and Developer** Editions
Consider these tips when sending email replies.

- Replies must be sent from the email address specified on your profile. If you use email aliases or email forwarding services that send replies from a different email address, your replies aren’t processed.

- Replies to bookmark, mute, like or unlike, and follow or unfollow must contain only the single word or exact text, such as like (case insensitive) or +1. If you include extra white spaces or the original message that some email applications automatically include, we ignore them and process the reply as a like, bookmark, etc. However, if you include any other text in the body, such as Like! or Like this?, we process your reply as a comment rather than a like, bookmark, etc.

- If replies contain your personal email signature, the signature text is treated as part of your comment. Default signatures inserted by mobile devices, such as Sent from my iPhone, are automatically removed from replies. Before replying, delete custom signatures and any extra text you don’t want posted to Chatter. Or, add a separator line to the top of your signature to have it automatically removed. The separator line must have a minimum of one of the following characters:
  – Dash (-)
  – Equal sign (=)
  – Underscore (_)  

You can also use any combination of these characters or dash dash space ( -- ), which respects RFC 3676 4.3.

- Attachments and mentions in replies are ignored.

- Before replying, check the email address that displays in the To field of your email. Valid addresses contain tokens, or long character strings, both before and after the @ symbol, such as w8t27apy1@j321imd9gbs.d8rx.d.chatter.yourInstance.salesforce.com. Some email applications automatically use the From address from the original email, reply@chatter.salesforce.com, which is not a valid address for receiving replies. If you see this shortened address in the To field of your reply email, replace it with the valid reply-to address in the email header information. For example, in an application such as IBM® Lotus Notes®:

  1. Open the original email.
  2. Click View > Show > Page Source.
  3. In the Reply-To section, copy the email address that looks like:
      w8t27apy1@j321imd9gbs.d8rx.d.chatter.yourInstance.salesforce.com.
  4. Paste the reply-to address in the To field of your reply email.

SEE ALSO:
  Like Posts and Comments
Navigate to Chatter Email Settings

Find your Chatter email settings so you can change your preferences for receiving email notifications and digests.

- From your personal settings, enter Chatter in the Quick Find box, then select Chatter Email Settings or Email Notifications—whichever one appears.
- Or, from any group page, click Email Me... > Email Settings.

To receive Chatter email notifications and digests, your administrator must enable email notifications for your organization. Select Receive emails to receive Chatter email.

⚠️ Warning: Deselecting this option prevents you from receiving all Chatter email notifications.

SEE ALSO:
- Chatter Email Digests
- Guidelines for Managing Your Personal Chatter Email Settings

Chatter Email Digests

Email digests conveniently summarize recent activity in Chatter so you don’t miss important discussions. You can choose to receive daily or weekly summaries of updates from your personal feed or any group’s feed.

Personal digests include the updates you see in your own Chatter feed, such as updates about the people, records, and files you follow and your groups. Group digests include the updates you see in a particular group's Chatter feed.

Daily digests include up to the 50 latest posts from the previous day while weekly digests include up to the 50 latest posts from the week. Both include the three latest comments on each post. Chatter sends daily digests at approximately 12:00 a.m. every day, and weekly digests at approximately 12:00 a.m. on Sunday. For user digests, the time is according to the user’s time zone. For group digests, the time is according to the organization’s time zone. Neither time is configurable.

When you join or are added to a group, you don’t receive email notifications initially because they’re turned off by default. You can use Set default frequency for groups I join: to choose how often you want to receive emails when joining new groups. Changing the default frequency doesn’t affect the groups you already belong to. If your organization existed before Summer ’11 and is a Professional, Enterprise, Unlimited, or Developer Edition organization, you might still be receiving daily digests by default.

SEE ALSO:
- Navigate to Chatter Email Settings
- Guidelines for Managing Your Personal Chatter Email Settings
Guidelines for Managing Your Personal Chatter Email Settings

Control the number of Chatter emails you receive by choosing the most important emails and the appropriate frequency of personal and group digests.

### Email Me When Someone

Be selective about your personal email settings. They should help you stay on top of important discussions without becoming overwhelmed by too much email.

<table>
<thead>
<tr>
<th>Option</th>
<th>Most Important</th>
<th>Recommendations and Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Follows me</td>
<td></td>
<td>If you’re not already following the person, you can click a link in the email to start following your new follower.</td>
</tr>
<tr>
<td>Posts on my profile</td>
<td>✅</td>
<td>People reach out to you directly by posting questions or information on your profile, so make sure that you get notified.</td>
</tr>
<tr>
<td>Shares a post I made</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Likes a post or a comment I made</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments on my status or a change I made</td>
<td></td>
<td>This setting provides notification for actions taken on feed-tracked changes. A feed-tracked change is a change that you make in Salesforce that triggers an automatic post to your Chatter feed. Enabling this option notifies you when someone comments on that post.</td>
</tr>
<tr>
<td>Comments on a post on my profile</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Comments after me</td>
<td></td>
<td>After you’ve commented on an item, get notifications for up to 10 comments after yours. Commenting again later in the post resets the count, so you receive notifications for up to another 10 subsequent comments.</td>
</tr>
<tr>
<td>Comments on an item I bookmarked</td>
<td>✅</td>
<td>If you use bookmarks to track items you’re interested in, get an email each time someone comments. If you typically use likes to track items of interest, then this option is less important.</td>
</tr>
<tr>
<td>Comments on an item I like</td>
<td>✅</td>
<td>After you like an item, get notifications for up to 10 comments after your like.</td>
</tr>
<tr>
<td>Mentions me in a post</td>
<td>✅</td>
<td>People use mentions to ask for your input and draw you into discussions, so make sure that you get notified.</td>
</tr>
</tbody>
</table>
**Recommendations and Notes**

<table>
<thead>
<tr>
<th>Option</th>
<th>Most Important</th>
<th>Recommendations and Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mentions me in a comment</td>
<td>✅</td>
<td>People use mentions to ask for your input and draw you into discussions, so make sure that you get notified.</td>
</tr>
<tr>
<td>Sends me a message</td>
<td>✅</td>
<td>Get sends me a message notifications when people send you private Chatter messages, including notifications about files that have been shared with you.</td>
</tr>
<tr>
<td>Endorses me on a topic</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Set Frequency for Personal Digest

<table>
<thead>
<tr>
<th>Option</th>
<th>Recommended</th>
<th>Recommendations and Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>✅</td>
<td>Daily digests include the 50 latest posts from the previous day and the three latest comments on each post.</td>
</tr>
<tr>
<td>Weekly</td>
<td></td>
<td>Weekly digests include the 50 latest posts from the week and the three latest comments on each post.</td>
</tr>
<tr>
<td>Limited</td>
<td></td>
<td>If you’re selective about the options in the “Email me when someone” section, you might not need to receive personal digests at all.</td>
</tr>
</tbody>
</table>

Personal digests aren’t supported in communities.

### Set Default Frequency for Groups I Join

Changing the default frequency for groups you join doesn’t affect the groups you already belong to.

<table>
<thead>
<tr>
<th>Option</th>
<th>Recommended</th>
<th>Recommendations and Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email on every post</td>
<td></td>
<td>In communities, the Email on every post option is disabled once more than 10,000 members choose this setting for the group. All members who had this option selected are automatically switched to Daily digests.</td>
</tr>
<tr>
<td>Daily digests</td>
<td></td>
<td>Daily digests include the 50 latest posts from the previous day and the three latest comments on each post.</td>
</tr>
<tr>
<td>Weekly digests</td>
<td></td>
<td>Weekly digests include the 50 latest posts from the week and the three latest comments on each post.</td>
</tr>
<tr>
<td>Limited</td>
<td>✅</td>
<td>Keep this default setting for all new groups. Whenever you join a group that you expect to monitor and contribute to actively,</td>
</tr>
</tbody>
</table>
Recommendations and Notes

such as one for an important team or project, you can change to more frequent notifications for that specific group.

SEE ALSO:
- Chatter Email Digests
- Navigate to Chatter Email Settings

What do “company” and “organization” mean in Chatter?

An organization is a single deployment of Salesforce with a defined set of licensed users who may or may not use Chatter. The words “company” and “organization” are used interchangeably in Chatter. So for example, if you see “share a file with all Chatter users in your company,” it means you’re sharing with everyone in a specific Salesforce organization who uses Chatter.

SEE ALSO:
- Chatter Overview

Can I invite people from my company who don’t have Salesforce licenses?

If enabled by your administrator, you can invite other people from your company. Invited users can view profiles, post on their feed, and join groups, but can’t see your Salesforce data or records.

You can invite users from the People tab or when adding members to a group.

Additionally, you can add customers to private groups you own or manage.

Work with Feeds

Stay up to date on posts and comments you and other people make, as well as record changes across your Salesforce organization.

IN THIS SECTION:
- Chatter Feeds Overview
  Follow people and records to see updates about them in Chatter feeds on profiles, groups, the Home tab, topic detail pages, and on record detail pages.
- View a Particular Feed
  Change your Chatter feed to display a particular subset of posts.
- Filter and Sort Your Feeds
  Use the filter and sort options to see updates that are relevant to you.
- Create a Task from a Post
  Read a post that you want to follow up on? Use the Create New Task action to create a task directly from that post.
- Viewing Your Recommendations
- Chatter Favorites Overview
Chatter Feeds Overview

Follow people and records to see updates about them in Chatter feeds on profiles, groups, the Home tab, topic detail pages, and on record detail pages.

Typically, following lets you see updates about:

- Chatter feed comments and posts
- Posts, comments, and files on Chatter groups you’re a member of
- Shared files and links
- Tasks and events
- Converted leads
- Record field changes, like changes to record owner and closed opportunities and cases.

Record updates are also called system-generated posts. They are updates that Salesforce automatically generates when someone creates a record or changes a tracked field on a record. The record updates you see depend on how your administrator has configured feed tracking and whether you have access to the record. You don’t see tracked feed updates that are older than 45 days and have no likes or comments, because they are deleted automatically.

SEE ALSO:
Sharing a Chatter Post

View a Particular Feed

Change your Chatter feed to display a particular subset of posts.

By default, you see your What I Follow feed when you go to your Chatter page. Use the feed selections on the left sidebar of the Chatter page to view a subset of posts in your feed. For example, view only posts that mention you, or posts you bookmarked, or all posts in your company.

1. Click Feed to see the available feeds.
2. Click a feed to display the associated subset of posts in your feed.

What I Follow
Shows updates for everything you follow, including posts from people you follow, groups you are a member of, and files and records you’re following. Use the drop-down list at the top of your feed to further narrow the subset of posts.

To Me
Shows posts that are made on your profile page, including

- Posts others make on your profile page
- Posts and comments where you have been mentioned
- Posts you made that have comments

Bookmarked
Shows your bookmarked posts in your feed.

All Company (Salesforce Classic)
Shows posts and comments from your entire company, including posts and comments from:

- People in your company
- Public groups
• Private groups you are a member of
• Feed tracked changes for records and fields and system-generated posts, if someone liked or commented on the post. You must have access to the record to see the post.

Company Highlights (Lightning Experience)
Shows the most popular posts across your entire company and posts with lots of engagement, like comments, likes, and views.

SEE ALSO:
Filter Your Files List

Filter and Sort Your Feeds
Use the filter and sort options to see updates that are relevant to you.
Filtering and sorting your feed is useful when you want to view a particular set of posts instead of all posts in your feed.

IN THIS SECTION:
Filter Your Feed
Use filters to condense the number of posts that appear in your feed.
Sort Your Feed
Sort your feed by most recent posts or by most recent comments.
Available Filters Per Feed
The feed filter options vary, depending on how your administrator sets up Salesforce and which feed you’re viewing. Not all filters are available on all feeds.

Filter Your Feed
Use filters to condense the number of posts that appear in your feed.
The filters you see depend on how your administrator has set up Salesforce. Filter your feed on the Chatter page, your profile, group pages, record detail, and search result pages. Not all filters are available on all feeds.
• Above a feed, click next to Show and select a filter option.

All Updates (Default)
Shows all posts and comments from people and records you follow, posts from groups you’re a member of, and all system-generated posts.
Fewer Updates
• Shows all posts and comments from people and records you follow and groups you’re a member of
• Hides system-generated posts from records that nobody has commented on

People
Shows the posts and comments from people you follow.

Groups
Shows the posts in groups you’re a member of.
Files

Shows posts that include:

- Files you follow
- File posts that someone you follow has commented on

**Example:** Use the Fewer Updates filter to hide system-generated posts. For example, you’re following the Acme account, and the account executive for Acme creates an opportunity. Later, the account executive also changes a tracked field on the Acme account. In both cases, Salesforce automatically generates an update about each change and posts the updates in your Chatter feed and the feed on the Acme account detail page. The Fewer Updates filter hides these system-generated posts in your feed, unless someone has commented on the posts. If you want to see the system-generated posts, select the All Updates filter.

SEE ALSO:
Available Filters Per Feed

Sort Your Feed

Sort your feed by most recent posts or by most recent comments.

1. Above a feed, click 🗓️ next to Show.
2. Below Sort By, select Post Date to sort by most recent posts, or Most Recent Activity to sort by posts with the most recent comments, including polls with new comments.

Your feed is sorted by Most Recent Activity by default. You can toggle between sorting by Post Date and Most Recent Activity at any time.

**Example:** For example, let’s say you’re following many people and records and bookmarked the posts you’re interested in. At the end of your work day, you want to know whether there are any updates for your bookmarked posts. You click Bookmarked to view all your bookmarked posts and then sort the posts using the Most Recent Activity filter. The posts are listed in the order of recent comments, starting with the post that has the latest comment.

SEE ALSO:
Filter Your Feed

Available Filters Per Feed

The feed filter options vary, depending on how your administrator sets up Salesforce and which feed you’re viewing. Not all filters are available on all feeds.

<table>
<thead>
<tr>
<th>Feed</th>
<th>Available Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>What I Follow</td>
<td>• All Updates</td>
</tr>
<tr>
<td></td>
<td>• Fewer Updates</td>
</tr>
<tr>
<td></td>
<td>• People</td>
</tr>
<tr>
<td></td>
<td>• Groups</td>
</tr>
<tr>
<td></td>
<td>• Files</td>
</tr>
<tr>
<td></td>
<td>• Sort By Most Recent Activity/Post Date</td>
</tr>
</tbody>
</table>

EDITIONS

Available in: both Salesforce Classic and Lightning Experience

Available in: Group, Enterprise, Professional, Performance, Unlimited, Contact Manager, and Developer Editions
<table>
<thead>
<tr>
<th>Feed</th>
<th>Available Filters</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Me</td>
<td>• Sort By Most Recent Activity/Post Date</td>
</tr>
<tr>
<td>Bookmarked</td>
<td>• Sort By Most Recent Activity/Post Date</td>
</tr>
<tr>
<td>All Company (Salesforce Classic)</td>
<td>• Sort By Most Recent Activity/Post Date</td>
</tr>
<tr>
<td>Company Highlights (Lightning Experience)</td>
<td>• Sort By Top Posts/Latest Posts/Most Recent Activity</td>
</tr>
<tr>
<td>Group</td>
<td>• All Updates</td>
</tr>
<tr>
<td></td>
<td>• Fewer Updates</td>
</tr>
<tr>
<td></td>
<td>• Sort By Most Recent Activity/Post Date</td>
</tr>
<tr>
<td>Profile</td>
<td>• Sort By Most Recent Activity/Post Date</td>
</tr>
<tr>
<td>Record</td>
<td>• All Updates</td>
</tr>
<tr>
<td></td>
<td>• Internal Only</td>
</tr>
<tr>
<td></td>
<td>(This filter only shows posts to the internal organization and is only available in Salesforce Communities.)</td>
</tr>
<tr>
<td></td>
<td>• Fewer Updates</td>
</tr>
<tr>
<td></td>
<td>• Sort By Most Recent Activity/Post Date</td>
</tr>
<tr>
<td>Search</td>
<td>• All Updates</td>
</tr>
<tr>
<td></td>
<td>• Fewer Updates</td>
</tr>
<tr>
<td></td>
<td>• People</td>
</tr>
<tr>
<td></td>
<td>• Groups</td>
</tr>
<tr>
<td></td>
<td>• Files</td>
</tr>
<tr>
<td></td>
<td>• Sort By Most Recent Activity/Post Date</td>
</tr>
</tbody>
</table>

SEE ALSO:
- Filter Your Feed
- Sort Your Feed
Feeds FAQs

I see updates to private groups in my profile feed. Who else can see these updates?

Only the members of a private group can see updates to that group, even on your profile feed.

SEE ALSO:
- Post Visibility

Can I see a list of records and people I'm following?

To see people and records you follow, view the Following list on your profile and filter the results by user or by an object type. You can also see a list of people following you in the Followers list on your profile.

SEE ALSO:
- Chatter Profile Overview

Why do I only see certain people and records in my Chatter feed?

You only see updates by people and records that you follow. Follow more records and people to see more updates in your Chatter feed on your Home tab and Chatter tab. Click People on the Chatter tab to find a list of people in your organization to follow or unfollow.

SEE ALSO:
- The People and Records You Auto-Follow Initially

Bookmark Posts

Bookmarks Overview

Bookmarking lets you keep track of individual posts you’re interested in.

After you bookmarked a post, you can quickly find it using the Bookmarked feed on the left sidebar. The Bookmarked feed shows you only the posts you bookmarked.

When someone comments on a post you bookmarked, you receive an email notification. Email notifications for bookmarks are enabled by default, but you can change your email notifications on page 16.

Bookmarks are private and other users can’t see which posts you bookmark. There is no limit on the number of bookmarks you can add. When you are no longer interested in a post you saved, you can remove the bookmark and the post no longer appears in your saved posts when you click Bookmarked.

SEE ALSO:
- Like Posts and Comments
- View a Particular Feed
- Guidelines for Managing Your Personal Chatter Email Settings
**Bookmark a Post**

Track the posts you’re interested in and view your saved posts in your Bookmarked feed.

1. Click at the top right corner of the post you want to bookmark to expand the drop-down menu.
2. Click Bookmark.
   - The bookmark icon ( ) displays next to the post to indicate that you successfully saved the post to your bookmarks.

Click Feed > Bookmarked on the Chatter sidebar to see your saved posts in your feed. There is no limit for the number of bookmarks. You can add as many bookmarks as you like.

SEE ALSO:
   - Like Posts and Comments

**Remove a Bookmark**

1. Click Feed > Bookmarked on the sidebar to see your saved posts in your Chatter feed.
2. Find the saved post in your Chatter feed.
3. Click at the top right corner of the post to expand the drop-down menu.
4. Click Remove Bookmark.

When you remove a bookmark from a post, the post no longer appears in your saved posts when you click Bookmarked.

**Create a Task from a Post**

Read a post that you want to follow up on? Use the Create New Task action to create a task directly from that post.

You can create a task from any post made by you or someone else in your organization, including posts with attachments. You can’t create a task from a system-generated post, like a record update.

1. Click on a post.
2. Click Create New Task.
   - If you don’t see the Create New Task action, your Salesforce administrator didn’t enable this action for your organization.
3. In the Create New Task dialog, add a subject and a due date. If applicable, associate the task with a contact or lead and an object, like an account. Use the search boxes to find available contacts, leads, and objects.
4. Click Create, when you’re done.

The task is assigned to you and posted to your profile feed. The task also appears in your My Tasks section on your Home tab.
Click the task subject link (1 or 2) to open the task. Click the post link (3) to display the post from which the task was created.

**Viewing Your Recommendations**

Chatter provides recommendations to help you identify the people, groups, files, and records that closely relate to your job and interests. The more recommendations you accept, the more updates you see in your feed.

- Click **Follow** next to the person, record, or file you want to follow.
- Click **Join** to become a group member.
- Click **More** to dismiss a recommendation.
- Click **More** to display the Recommendations page where you can use the side filters to narrow your recommendations to people, files, records, or groups.

**SEE ALSO:**
- People Recommendations
- Chatter Group Recommendations
- Record Recommendations
- File Recommendations

**Find Information in Feeds**

**Searching in Feeds**

Quickly find information in posts and comments across Chatter.

- Use the header search box (Global Search) to find information in feeds across Chatter.
- To find information in a specific Chatter feed, use **feed search ( )** in that context.
- To create a quick shortcut to a frequently performed search in Chatter, **save a feed search as a favorite** and click the favorite link from the Chatter page.
Chatter Feed Search Results

Watch a Demo: Search in Salesforce Classic

Search results for Chatter feeds display posts and comments that include your search terms. Chatter feed searches aren’t affected by your search scope; Chatter feed search results include matches across all objects.

Note: Changes to record fields aren’t included in search results. For example, if you’ve enabled feed tracking on the Billing Address field for the Acme account and modified the Acme billing address, search results for Acme include Acme — Suzanne Powell Looking for volunteers to help with the Acme account, but don’t include Acme — Suzanne Powell changed Billing Street to 10 Main Road.

- Sort your search results by posts only or by posts and comments, just as in feeds.
- Comment on, like, share, bookmark, and delete posts in the search results, just as in feeds.
- Add, edit, or delete topics on posts in the search results, just as in feeds.
- Follow, share, download, preview, and upload new versions of files in the search results, just as in feeds.
- View the detail pages for Chatter files, groups, topics, and people by clicking the respective name in the update.
- View a single feed update by clicking the timestamp below the update, for example, Yesterday at 12:57 AM.
- Click Add to Favorites to save a Chatter feed search to your favorites on the Chatter tab.

To view search results for records, such as accounts, contacts as well as Chatter people, groups, topics, and files, click Records at the top left of the page.

Tip: For a more focused search of the feeds in a specific group, profile, record, or other Chatter feed, use feed search.

Searching in a Specific Feed

Use feed search to find information in a specific context.

You can search for information in feeds on records, groups, topic pages, user profiles, and on the Chatter and Home tabs. A contextual feed search is helpful when you want to confirm if something was once discussed in that specific feed.

1. Click above the feed to look for information in that feed. For example, use the feed search on a group’s page to find information in that group.
2. Type your search terms and press ENTER or click 🔎.

You can search for hashtag topics, mentions, and files posted in the feed, or refine your search using wildcards, operators, and quotation marks to match on exact phrases.

Tip: To search for hashtag topics with multiple words, use brackets after the hashtag and around the words. For example, to find all instances of #Universal Paper, type `#[universal paper]` in the search box.

Search results display with matching terms highlighted. Filters or sorting criteria used in the feed apply to feed search results as well.

Click ✗ to clear your search results and return to the feed.

Feed search behavior may vary slightly depending on where you perform the search.

- Feed search is not supported for feeds on list views.
- You can only search feeds you have access to via sharing rules.
- On the Chatter tab, feed search results are also limited by your feed type selections. For example, if you select the To Me feed type, and select additional filters and sorting criteria, all of those criteria apply to the feed search results.
- Feed search results are limited to the posts that are accessible from the context you search within. For example, if you search the feed on a user’s profile, the results include the posts and comments accessible from the user’s profile. This includes both the posts and comments shared by or with the user.
- Feed search returns matches for file or link names shared in posts, but not in comments.
- Record field changes aren’t included in record feed search results.
Adding a Chatter Feed Search as a Favorite

Add a Chatter feed search as a favorite to access feed updates quickly without leaving the Chatter tab.

1. Enter terms in the header search box and click **Search**.
2. Click **Search Feeds** to see the posts and comments that include your search terms.
3. Click **Add to Favorites**.

Example:
The favorite name on the Chatter page is the same as the search terms you entered. For example, if you searched for competitive analysis, your favorite is competitive analysis.

Tip: Save a search for a Chatter group name as a favorite to quickly access the group feed from the Chatter page. Similarly, save a search for a person’s name as a favorite to quickly see that person’s posts, comments, and mentions.

SEE ALSO:
- Chatter Feed Search Results

Chatter Favorites Overview

Chatter favorites on the Chatter tab give you easy access to list views, Chatter feed searches, and topics that you want to stay on top of. For example, if you and your coworkers use the hashtag topic #acme to track information about your customer Acme, you might want to add #acme as a favorite so you can easily access these updates without leaving the Chatter tab.

You can have up to 50 favorites. If you haven’t added any favorites, the Favorites section doesn’t appear on the Chatter tab.

Chatter displays the four favorites most recently added or viewed.

- Click a favorite to see the updates.
- Click X more to see all your favorites.
- Click X, which appears on hover, to remove a favorite.

Chatter Streams

Chatter streams are custom feeds that you create from the information that’s most useful to you. Look for streams on your Chatter home page. Create up to five streams that combine posts from up to 25 different feeds and feed types. Create streams that combine feeds from people, groups, and records, like accounts, opportunities, cases, and more.
You don’t have to follow a person, group, or record before you add it to a stream. The great thing about adding a feed to a stream is it doesn’t count against the number of follows you’re allowed.

**Tip:** To include a person account in your stream, add it as an Account in the Include in Stream field. If you add a person account as a Contact, the related feed posts don’t appear.

Because a stream is made up of multiple feeds, no publisher is provided for posting to a stream.

**Note:** You can add 25 unique feeds, records, groups, and people to a stream. If your access to any of the 25 is removed, the removed entity is still counted as part of the 25. You can’t replace it with something else.

**IN THIS SECTION:**

**Create a Chatter Stream**

In Lightning Experience, create a Chatter stream to get a combined view of feeds from the profiles, groups, and records that you select. Create up to five Chatter streams. Include up to 25 objects in each stream.

**Edit a Chatter Stream**

Edit a stream to change its name or to add or remove some of its feeds.

**Delete a Chatter Stream**

Deleting a Chatter stream doesn’t delete the records or posts it contains. It deletes only the stream, which frees up space for you to create new streams.
Create a Chatter Stream

In Lightning Experience, create a Chatter stream to get a combined view of feeds from the profiles, groups, and records that you select. Create up to five Chatter streams. Include up to 25 objects in each stream.

To create a Chatter stream, provide a title and select the feed types and feeds you want in your stream.

1. In Lightning Experience, go to the Chatter home page, and click the icon to open the New Stream dialog (2).
2. Enter a name for your stream.
3. In the Include in Stream field, click the down arrow (3) and choose a type of feed you want to add to your stream.
4. When you’ve made a selection, click in Include in Stream again to search for the selected type of feed (5).
5. Select one of the listed feeds.

Repeat steps 3 through 5 until you have all the feeds (up to 25) that you want in this stream (6).

**Note:** You can add 25 unique feeds, records, groups, and people to a stream. If your access to any of the 25 is removed, the removed entity is still counted as part of the 25. You can’t replace it with something else.

To include a person account in your stream, add it as an Account in the **Include in Stream** field. If you add a person account as a Contact, the related feed posts don’t appear.

6. To save your selections, click **Save**.

7. To save your stream, click **Save** again.
Your stream is listed in the left column on the Chatter home page, under STREAMS (7). To see its contents, click its name.

SEE ALSO:
- Chatter Streams
- Edit a Chatter Stream
- Delete a Chatter Stream

**Edit a Chatter Stream**

Edit a stream to change its name or to add or remove some of its feeds.

To edit a Chatter stream, go to the Chatter home page, open the stream, and click Edit.

1. In Lightning Experience, go to the Chatter home page, and click the stream you want to edit to open its home page.

2. On the right side of the stream’s home page, click Edit (1) to open the Edit Stream dialog (2).
3. Edit the stream.
   - Edit the stream name.
   - To add more feeds to the stream, click in the **Include in Stream** field to select a feed type. And follow the steps in **Create a Chatter Stream**.
   - To remove a feed from the stream, click its icon.

4. To save your changes, click **Save**.
5. To save your stream, click **Save** again.

SEE ALSO:
- Chatter Streams
- Create a Chatter Stream
- Delete a Chatter Stream

### Delete a Chatter Stream

Deleting a Chatter stream doesn't delete the records or posts it contains. It deletes only the stream, which frees up space for you to create new streams.

To delete a Chatter stream, go to the Chatter home page, open the stream, and click **Delete**.

1. In Lightning Experience, go to the Chatter home page, and click the stream you want to delete to open its home page.
2. On the right side of the stream’s home page, click **Delete** (1) to open the Delete stream dialog (2).
3. Click **Delete**.

SEE ALSO:
- Chatter Streams
- Create a Chatter Stream
- Edit a Chatter Stream

Work with Posts

Share information and collaborate with other people inside and outside your organization.

IN THIS SECTION:
- Posting Overview
  Use the Chatter publisher to post, comment, ask questions, and create polls.
- Post Visibility
  Can I prevent people from seeing my posts?
  Do posts that I make on a group appear on my profile where others can see them?
- Mute a Post
  Control what appears in your news feed and mute posts you’re no longer interested in.
- Live Feeds
  When you’re in a group in Lightning Experience, the Chatter feed is live. Live feeds offer real-time posts and comments without requiring a page refresh. You see content when it’s posted.
- Live Comments
  In Lightning Experience feeds, comments are live. Live comments offer a real-time comment experience that doesn’t require a page refresh. You see comments when they’re posted.
- Who Can See My Attached Files and Links?
  Share files and links with people by attaching them to posts or comments.
Posting Overview

Use the Chatter publisher to post, comment, ask questions, and create polls.

The publisher appears on your Home tab, Chatter tab, user profile page, group, and record detail pages. Use publisher to write a post (1), comment on a post, attach a file (2) or link (3) to your post, add a poll (4), or ask a question (5). Posts and comments can be up to 10,000 characters long. Use the rich text editor to format your posts (6).

Tip: In Lightning Experience, power users can use the keyboard to complete posts and comments. On Windows, enter content and press Ctrl+Enter. On macOS, press either Control+Enter or Command+Enter.

In questions, shortcut keys work with question details, but not on the question itself. So if you just ask a question, the shortcuts don’t work. But if you include details with the question, shortcuts work.

By default, the publisher displays the Post, File, Link, Poll, and Question actions. Your Salesforce administrator can change the order of the actions and add more actions. Therefore, the actions you see depend on how your administrator configured the publisher.

When you post to a feed, everyone with access to the post can comment on the post, like the post, and share it (1). From the drop-down menu (2), they can also bookmark the post and add topics.

In Lightning Experience, comments are live and don’t require a page refresh to update.

Note: Live comments is a new feature with lots of potential for enhancement and a few known issues.

- When new comments are made on a feed post that you’re engaged in, you receive notifications only in Lightning Experience. Notifications appear when you’re actively typing comments or you’ve clicked in the comments box.
The number of participants supported for live comments depends on your org’s subscription limits. If you’re not getting live comments, click in a comment field. If comments still aren’t live, looks like your org has hit its limit! You can still get updates the old-fashioned way by refreshing the page.

Click **Edit** to modify your own posts and comments. If you’re a group owner or manager, you can also edit other people’s posts on the group feed. Click **Delete** to remove your post from the feed. However, you can’t delete other people’s posts or posts that are automatically generated by Salesforce. For example, you can’t delete record updates like a post about a changed field on an account.

**Note:** If the Edit option isn’t available, your administrator disabled this feature for your organization.

SEE ALSO:
- Post Visibility
- Live Feeds
- Live Comments

### Post Visibility

The following table describes where you can post and where your post displays.

<table>
<thead>
<tr>
<th>EDITIONS Available in: Salesforce Classic Available in: <strong>Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer</strong> Editions</th>
<th>EDITIONS Available in: Salesforce Classic Available in: <strong>Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer</strong> Editions</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Collaborate with Everyone

<table>
<thead>
<tr>
<th>I’m posting on</th>
<th>I can post to</th>
<th>Who gets my post directly?</th>
<th>Where does my post show up?</th>
<th>File Considerations</th>
</tr>
</thead>
</table>
| Home tab, Chatter tab, or my profile | My followers | - People following you see your post in the What I Follow feed.  
- People that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds. | - Everyone who navigates to your profile can see your post on your profile.  
- Your post shows up in feed search results.  
- Everyone can see your post in the All Company feed (Salesforce Classic).  
- Your post shows up in feed search results.  
- Everyone can see your post in the All Company feed. | If you attach a file to the post, the file is available to all employees. The file also shows up in search results and file lists. |
| A public group | | - Members of this group see your post in the What I Follow feed.  
- Group members that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds. | - Everyone who navigates to the group can see your post on the group page.  
- Your post shows up in feed search results.  
- Everyone can see your post in the All Company feed. | If you attach a file to the post, the file is available to anyone who has access to the group. The file also shows up in search results and file lists. |
| A private group | | - Members of this group see your post in the What I Follow feed.  
- Group members that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds. | Only members of the group see your post on the group feed, in feed search results and in the All Company feed. | If you attach a file to the post, the file is available to anyone who has access to the group. The file also shows up in search results and file lists. |
| An unlisted group | | - Members of this group see your post in the What I Follow feed.  
- Group members that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds. | Only group members and users with the “Manage Unlisted Groups” permission see your post in the group feed, the All Company feed, and on your profile. | If you attach a file to the post, the file is viewable and searchable by anyone who has access to the group. |
| A customer group | | - Members of this group see your post | Only members of the group see your post on the post, the file is available | |

---

Share Updates with People (Chatter)

Collaborate with Everyone
<table>
<thead>
<tr>
<th>I’m posting on</th>
<th>I can post to</th>
<th>Who gets my post directly?</th>
<th>Where does my post show up?</th>
<th>File Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>to anyone who has access to the group. The file also shows up in search results and file lists.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>in the What I Follow feed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Group members that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>the group feed, in feed search results, and in the All Company feed. Members include employees and customers.</td>
<td></td>
</tr>
<tr>
<td>Topic detail page</td>
<td>My followers</td>
<td>• People following you see your post in the What I Follow feed.</td>
<td>Everyone can see your post on the topic detail page.</td>
<td>If you attach a file to the post, the file is available to all employees. The file also shows up in search results and file lists.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• People that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds.</td>
<td>Everyone who navigates to your profile can see your post on your profile.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Your post shows up in feed search results.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Everyone can see your post in the All Company feed.</td>
<td></td>
</tr>
<tr>
<td>A public group</td>
<td></td>
<td>• Members of this group see your post in the What I Follow feed.</td>
<td>Everyone can see your post on the topic detail page.</td>
<td>If you attach a file to the post, the file is available to anyone who has access to the group. The file also shows up in search results and file lists.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Group members that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds.</td>
<td>Everyone who navigates to the group can see your post on the group page.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Your post shows up in feed search results.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Everyone can see your post in the All Company feed.</td>
<td></td>
</tr>
<tr>
<td>A private group</td>
<td></td>
<td>• Members of the group see your post in the What I Follow feed.</td>
<td>Only members of the group see your post on the topic detail page, group feed, in feed search results and in the All Company feed.</td>
<td>If you attach a file to the post, the file is available to anyone who has access to the group. The file also shows up in</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Group members that are mentioned in the</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

1 This footnote applies to all mentions of the All Company feed in this table: The Company Highlights feed in Lightning Experience may show the post, depending on its popularity ranking and engagement (such as comments, likes, and views).
<table>
<thead>
<tr>
<th>I'm posting on</th>
<th>I can post to</th>
<th>Who gets my post directly?</th>
<th>Where does my post show up?</th>
<th>File Considerations</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>post see the post in the What I Follow, To Me, and profile feeds.</td>
<td></td>
<td>search results and file lists.</td>
</tr>
<tr>
<td>A customer group</td>
<td></td>
<td>Members of this group see your post in the What I Follow feed.</td>
<td>Only members of the group see your post on the topic detail page, group feed, in feed search results, and in the All Company feed. Members include employees and customers. Although customers see your post, they don’t see or have access to topics.</td>
<td>If you attach a file to the post, the file is available to anyone who has access to the group. The file also shows up in search results and file lists.</td>
</tr>
<tr>
<td>An unlisted group</td>
<td>You can’t use topics in unlisted groups. You can add a hashtag topic when writing a post or comment in an unlisted group, and the topic will be formatted as a link after you post. However, a topic detail page isn’t created, and the link won’t work.</td>
<td>People following this person see your post in the What I Follow feed.</td>
<td>Everyone who navigates to that person’s profile can see your post on your profile.</td>
<td>If you attach a file to the post, the file is available to all employees. The file also shows up in search results and file lists.</td>
</tr>
<tr>
<td>Another person’s profile</td>
<td>That person’s profile only</td>
<td>People that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds.</td>
<td>Your post shows up in feed search results.</td>
<td>Everyone can see your post in the All Company feed.</td>
</tr>
<tr>
<td>A public group</td>
<td>To the public group only</td>
<td>Members of this group see your post in the What I Follow feed.</td>
<td>Everyone who navigates to the group can see your post on the group page.</td>
<td>If you attach a file to the post, the file is available to anyone who has access to the group. The file also shows up in search results and file lists.</td>
</tr>
<tr>
<td>A private group</td>
<td>To the private group only</td>
<td>Members of this group see your post</td>
<td>Only members of the group see your post on the group feed, in feed</td>
<td>If you attach a file to the post, the file is available to anyone who has access to the group. The file also shows up in search results and file lists.</td>
</tr>
<tr>
<td>I'm posting on</td>
<td>I can post to</td>
<td>Who gets my post directly?</td>
<td>Where does my post show up?</td>
<td>File Considerations</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------</td>
<td>------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| An unlisted group   | To the unlisted group only | • Members of this group and users with the "Manage Unlisted Groups" permission see your post in the What I Follow feed.  
• Group members that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds. | Only members of the group see your post on the group feed, in feed search results, and in the All Company feed. | If you attach a file to the post, the file is viewable and searchable by anyone who has access to the group. |
| A customer group    | To the customer group only | • Members of this group see your post in the What I Follow feed.  
• Group members that are mentioned in the post see the post in the What I Follow, To Me, and profile feeds. | Only members of the group see your post on the group feed, in feed search results, and in the All Company feed.  
Members include employees and customers. | If you attach a file to the post, the file is available to anyone who has access to the group. The file also shows up in search results and file lists. |
| A record page       | To the record only         | • Everyone following this records and has permission to access the record sees your post in the What I Follow feed.  
• People that are mentioned in the post and have permission to access the record see the post in the What I Follow, To Me, and profile feeds. | Everyone with permission to access the record can see your post on the record detail page, on your profile, in feed search results, and in the All Company feed. | If you attach a file to the post, the file is associated with the record. Everyone with sharing rights to the record has access to the file. |
Note: You can’t create new posts on archived groups. Comments on existing posts in an archived group follow the same visibility settings as before the group was archived.

Can I prevent people from seeing my posts?

Anyone except customers can see your posts on your profile, and people following you can see your posts in their Chatter feed. However, if you change a record, only people who have permission to see the record can see the record update a feed.

SEE ALSO:

- Sending Chatter Messages

Do posts that I make on a group appear on my profile where others can see them?

Yes, but who can see the posts depends on the type of group. If you post to a group that is:

- Public, anyone except customers can see the post on your profile.
- Private, only other group members can see the post on your profile.
- Private and allows customers, all members can see the post in the group. Customers who are members of the group can see your posts on the group page but not on your profile.
- Unlisted, only group members and users with the “Manage Unlisted Groups” permission can see the post on your profile. Customers who are members of the group can see your posts on the group page but not on your profile.

SEE ALSO:

- Chatter Groups

Mute a Post

Control what appears in your news feed and mute posts you’re no longer interested in.

You can mute posts from the feed and from a feed post’s detail view. Muting is available on the Home and Chatter tabs, but not on group, profile, or record feeds. If your admin enabled email replies, you can mute posts by replying to post emails with the single word mute.

To mute a post in a feed, select Mute from the post’s drop-down menu.

To mute a post from its detail view:

1. Go to detail view in the feed by clicking the post’s date stamp, or, in an email notification, by clicking the View/Comment button.
2. From the post’s drop-down menu, select Mute.

After you muted a post,

- In Salesforce Classic, the post no longer appears in your feed on the Home and Chatter tab. In Lightning Experience and in communities based on the Customer Service (Napili) template, the post stays in place.
- You no longer get notifications for updates to that post.
- You can use the Muted filter to view your muted posts.
- If someone mentions you on a muted post, the post is automatically unmuted. It reappears in your feed and if you have email notifications enabled, you get a notification about the update.
- If the post was originally posted to a group, profile, or record feed, it still appears on that feed.
For example, someone posts to a group that you’re a member of. The post appears on the group feed and your news feed on the Home and Chatter tab. You can mute the post in your news feed, but the post remains visible in the group feed.

**Example:** Here’s how you mute a post from the drop-down menu.

To view all posts you muted, select the Muted filter.

**Live Feeds**

When you’re in a group in Lightning Experience, the Chatter feed is live. Live feeds offer real-time posts and comments without requiring a page refresh. You see content when it’s posted. In a live feed, new posts trigger a message that appears briefly at the top of the feed (1).
Live comments appear in all feeds in Lightning Experience and not just group feeds. While people are entering comments, an animation shows activity on the post (2). When a live comment is first posted, it briefly flashes yellow.
There are a few differences between live and non-live, or served, feeds:

- Live feeds show content posted by users—that is, by human beings. They don’t show system-generated posts, like feed tracked changes (FTCs) and custom event posts. (To see these posts, refresh the feed.)
- Live feeds show content posted directly to the group feed. They don’t show posts that were mentioned into the group nor edits made to existing posts. (Refresh the feed.)
- A live feed is as good as its network connection. It’s possible that some posts are not served up live nor appear in the exact order that they were posted. Consider refreshing the feed from time-to-time to get all the goodness.

If you go idle for awhile or navigate away from a live feed, refresh the page to make it live.

For developers, live updates are not transactional. The server and the browser are a distributed system, and there is no transaction coordination between them. The served feed is a snapshot of the state of the feed in time. The live feed is a series of incremental updates to the current page, which are best efforts. They’re not intended to be equivalent to the snapshot delivered by the next served page.

Live feeds are optimized for human consumption. We don’t recommend writing code that consumes them that depends on the delivery of specific entities or the format of the pushed (live) data.

Note: The number of participants supported in a live feed depends on your org’s subscription limits. If you’re not getting a live group feed or live comments, refresh the page or click in a comments field. If the feed still isn’t live, it’s likely that your org has hit its limit. You can still get updates the old-fashioned way by refreshing the page.

Live Comments

In Lightning Experience feeds, comments are live. Live comments offer a real-time comment experience that doesn’t require a page refresh. You see comments when they’re posted.

To see live comments in a feed, you must be subscribed. Subscription is easy:

- Click in the Comment field.
- Post something.
- Click more comments.

If you go idle for awhile or navigate away from a feed, click in a comment field to resubscribe.

When you are subscribed to live comments in a feed, a typing indicator shows you when people are actively entering comments.
When the comment is posted, it briefly flashes yellow.

- When new comments are made on a feed post that you’re engaged in, you receive notifications only in Lightning Experience. Notifications appear when you’re actively typing comments or you’ve clicked in the comments box.
- The number of participants supported for live comments depends on your org’s subscription limits. If you’re not getting live comments, click in a comment field. If comments still aren’t live, it’s likely that your org has hit its limit. You can still get updates the old-fashioned way by refreshing the page.
Mention People and Groups

@Mention People and Groups in Posts and Comments
@Mention individual people or a group to keep them informed when you’re discussing something relevant to them.

1. When you write a post, type @ followed by the first few letters of the person or group name.
2. Select the person or group from the list of matches.
   The list includes all matches for
   • People, typically users you interact with the most
   • Public groups
   • Private groups you’re a member of
   You can have up to 25 mentions in a single post or comment. You can’t mention archived groups, unlisted groups, customer groups, and private groups you’re not a member of.
3. Click Share to post your update.
   After you posted your update,
   • The person’s name becomes a link to their profile, and the group name becomes a link to the group page.
   • For people you mention, your update appears on the mentioned person’s profile feed and in their To Me feed.
   • For people who choose to receive emails when mentioned, Chatter sends an email notification.
     Note: There’s an exception: if you @mention yourself, you don’t receive a notification.
   • For groups you mention,
     – Your update appears on the group feed and each group member’s What I Follow feed.
     – Chatter sends an email notification to the group members who enabled the Email Every Post preference for the group.
     Note: On mobile devices, we don’t currently send push notifications for group mentions.
     – If the mention is on a record feed, the record appears in the group records list.

Example: Your coworker Madison posts that she’s looking for information about an Acme product feature. You reply to Madison’s post with the comment: “Talk to @Bob Smith—he’s the Acme account manager. @Acme Products, do you have any additional information for Madison about this feature?” Both Bob Smith (if he chose to receive emails when mentioned) and members of the Acme Products group get an email notification about your post. Madison can click @Bob Smith in the update to view Bob’s profile, or click @Acme Products to see their group page.

Chatter enforces security and sharing rules in Salesforce. Let’s say you make a post to a record or a private or unlisted group and @mention someone who doesn’t have access to that record or isn’t a member of the group. In this case, the @mention appears as a gray link. The mentioned person can’t see your post and doesn’t get notified about the post. For example, Madison creates a private group for her project team and forgets to add her coworker Sandy Dunn to the group. When Madison posts an update to this group and @mentions...
Sandy Dunn, Sandy isn’t notified about the update. Sandy also and can’t see the update because she’s not a member of the private group. If Madison later adds Sandy to the group, Chatter doesn’t notify Sandy about the previous mentions.

SEE ALSO:
- Sharing a Chatter Post
- Sharing a Link to a Chatter Post
- View a Single Chatter Post
- User and Group @Mentions—Visibility

User and Group @Mentions—Visibility

When you @mention people or groups in an update, anyone who has access to the update can see the post and all comments.

This table describes where you can find posts and comments that mention people, public groups, and private groups. You can’t mention private groups with customers and unlisted groups.

<table>
<thead>
<tr>
<th>If the post was made on</th>
<th>And mentions</th>
<th>Then these people can see the post and comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>A person’s profile</td>
<td>Other people</td>
<td>Anyone with access to the person’s profile.</td>
</tr>
<tr>
<td></td>
<td>Public group</td>
<td>Anyone with access to the person’s profile.</td>
</tr>
<tr>
<td></td>
<td>Private group</td>
<td>Anyone with access to the person’s profile, even if they’re not a member of the private group.</td>
</tr>
<tr>
<td>Public group A</td>
<td>Other people</td>
<td>Anyone with access to public group A.</td>
</tr>
<tr>
<td></td>
<td>Public group B</td>
<td>Anyone with access to public group A.</td>
</tr>
<tr>
<td></td>
<td>Private group</td>
<td>Anyone with access to public group A, even if they’re not a member of the private group.</td>
</tr>
<tr>
<td>Private group A</td>
<td>Other people</td>
<td>Members of private group A.</td>
</tr>
<tr>
<td></td>
<td>Public group</td>
<td>Members of private group A.</td>
</tr>
<tr>
<td></td>
<td>Private group B</td>
<td>Members of private group A, even if they’re not a member of private group B. People who are members of both private groups can also see the post in the feed of private group B.</td>
</tr>
<tr>
<td>Unlisted group A</td>
<td>Other people</td>
<td>Members of unlisted group A and users with the “Manage Unlisted Groups” permission.</td>
</tr>
<tr>
<td></td>
<td>Public group</td>
<td>Members of unlisted group A and users with the “Manage Unlisted Groups” permission.</td>
</tr>
<tr>
<td></td>
<td>Private group B</td>
<td>Members of private group B who are members of unlisted group A or have the “Modify Unlisted Groups” permission.</td>
</tr>
<tr>
<td>Record detail page</td>
<td>Other people</td>
<td>People with sharing access to the record.</td>
</tr>
</tbody>
</table>
Then these people can see the post and comments

<table>
<thead>
<tr>
<th>If the post was made on</th>
<th>And mentions</th>
<th>Then these people can see the post and comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public group</td>
<td>People with sharing access to the record.</td>
<td></td>
</tr>
<tr>
<td>Private group</td>
<td>People with sharing access to the record, even if they’re not a member of the private group.</td>
<td></td>
</tr>
</tbody>
</table>

The visibility of posts and comments depends on sharing access to the post. Anyone with access to the original post also has access to all subsequent comments on the post.

**Who Can See My Attached Files and Links?**

Share files and links with people by attaching them to posts or comments.

Attach links and files to posts and comments from your device, Salesforce Files, Files Connect external sources, and Salesforce CRM Content libraries. All file types are supported, including everything from Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs and image files. Audio and video files can be uploaded and downloaded, but not parsed or previewed.

This table describes who can see a file that you attached and where it appears:

<table>
<thead>
<tr>
<th>If You Attach a File:</th>
<th>Who Can See It?</th>
<th>Where Does it Appear?</th>
</tr>
</thead>
</table>
| On a Chatter feed     | All Chatter users in your company | • In your and your followers’ Chatter feeds, and profile  
|                       |                 | • On the Files list and Salesforce CRM Content of all Chatter users in your company |
| On your Chatter profile or on someone else’s Chatter profile | All Chatter users in your company | • In your feed, their feed, your followers’ feeds, and their followers’ feeds and profiles  
|                       |                 | • In the Files Owned list on your profile  
|                       |                 | • On the Files list and Salesforce CRM Content of all Chatter users in your company |
| On a public group     | All Chatter users in your company | • In your feed, your followers’ feeds, and the group members’ feeds  
|                       |                 | • In your feed on your profile  
|                       |                 | • In the feed on the group  
|                       |                 | • In the Group Files list on the group |

**EDITIONS**

Available in: both Salesforce Classic and Lightning Experience

Available in: Group, Enterprise, Professional, Performance, Unlimited, Contact Manager, and Developer Editions
<table>
<thead>
<tr>
<th>If You Attach a File:</th>
<th>Who Can See It?</th>
<th>Where Does it Appear?</th>
</tr>
</thead>
<tbody>
<tr>
<td>On a private group that you're a member of</td>
<td>Members of the group and users with “Modify All Data” and “View All Data” permissions</td>
<td>• On the Files page and Salesforce CRM Content of all Chatter users in your company. • In your feed and the group members’ feeds • In your feed on your profile • In the feed on the group • In the Group Files list on the group • On your Files lists, group members' Files lists, and Salesforce CRM Content</td>
</tr>
<tr>
<td>On an unlisted group that you’re a member of</td>
<td>Members of the group and users with the “Manage Unlisted Groups” permission</td>
<td>• In your feed and the group members’ feeds • In your feed on your profile • In the feed on the group • In the Group Files list on the group • On your Files lists, group members' Files lists, and Salesforce CRM Content</td>
</tr>
<tr>
<td>On a record</td>
<td>Anyone with sharing rights to the record</td>
<td>• Record detail page • Your profile page • Feed search results • All Company or Company Highlights feed</td>
</tr>
</tbody>
</table>

SEE ALSO:
- Post Visibility
Attach Files or Links

Attach a File to a Post or Comment

Share files and links from Salesforce or from your computer with people by attaching them to posts or comments.

You can attach all file types, including Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs, image files, audio files, and video files. The maximum file size is 2 GB.

When you attach a file, consider the following:

• When a file is posted to a feed, everyone in your company can see it even if the file started out as private. Only files posted in a private group stay private within that group.
• Attaching a file from a group or library creates a reference to the file. If you update a file in Salesforce CRM Content, the updates are also reflected in the feed.
• In Lightning Experience, you can attach up to ten files to a feed post.
• You can post a file from an external data source. From the file selector, choose an external source and navigate through the folders to the file you want to post. A new file reference or copy is created in Salesforce for the corresponding external file. If a file reference already exists for the file you select, it will be reused.

1. Click **File** at the top of your feed to attach a file to a post, or **Attach File** below a comment to attach a file to a comment. If you’re commenting on an update resulting from feed tracking on a file, the **Attach File** option isn’t available.

2. Do one of the following:
   • Click **Select a file from Salesforce** to attach a file that has already been uploaded to Salesforce, synced from your Salesforce Files Sync folder, or that exists in a Files Connect external data source.
   • Click **Upload a file from your computer** to attach new files from your computer.

3. Browse for the file you want to attach.
   Links, Google docs, documents from the Documents tab, and attachments from the Notes and Attachments related list aren’t included in the Select a File to Attach list. For more information about finding files to attach, see Searching for Files to Attach to a Chatter Feed.

4. Add a post or comment about the file.
   If you don’t enter any text, a generic update is posted with your attachment.

5. Below the text box, select **My Followers** to publish the post on your profile. To post to a group, select **A Group**. Type part of the group’s name in the Search Groups field, and select the group from the drop-down list. You can only select a group you’re a member of.

6. Click **Share**.

SEE ALSO:
Upload and File Sharing Overview
Upload a New Version of a File
Access and Share External Files Using Files Connect
Searching for Files to Attach to a Chatter Feed

From the file selector, you can see a list of Salesforce files you own and have access to. In Salesforce Classic, click File above the feed, and then select a file from Salesforce. In Lightning Experience, click the paperclip icon below the post to open the Select File window. The 25 most recently viewed files are listed by default.

From the file selector you can see and search a certain group of files by clicking a specific filter on the sidebar.

- **All Files**—All files you own and have access to, including:
  - Files that have been shared with you
  - Files you’re following
  - Files in your Chatter groups
  - Files in your libraries
  - Files attached by other people to a Chatter feed, including files attached to all public groups and private groups you’re a member of. You don’t have access to files attached to private groups you’re not a member of.

  This filter is only available in Salesforce Classic.

- **Recent**—The most recent files you’ve viewed.

- **MY FILES**—All files you own, files shared with you, and files you follow.
  - **Owned by Me**—Files you have:
    - Uploaded on the Home or Files page. These files are private and not shared with anyone, but you can view them, share them, and attach them to Chatter feeds.
    - Attached to Chatter feeds from your computer.
    - Synced using your Salesforce Files Sync folder.
    - Uploaded to Salesforce CRM Content libraries you’re a member of and your private library.
  - **Shared with Me**—All files that have been shared with you either by a private share or a public post to your profile.
  - **Following**—All files that you’re following. *(Requires Chatter)*

- **FILES IN MY GROUPS**—All files you and other people shared to groups you’re a member of. The last five groups you’ve visited are listed.

- **FILES IN MY LIBRARIES**—All files you and other people uploaded to libraries you’re a member of and all files you uploaded to your private library. The first five libraries you’re a member of, including your private library, are listed. If you’re a member of more than five libraries, click More to see a complete list.

- **Synced**—All files that have been synced in your Salesforce Files Sync folder. This filter is available only to users who have the “Sync Files” permission.

- **EXTERNAL FILES**—All files you have access to in Files Connect external data sources. Search is restricted to the selected external data source.

**Note:**

- Only files from libraries that you’re a member of and where you have Post Content to Chatter Feeds or Manage Library checked in your library permission definition are listed.

- Users who have the “Sync Files” permission don’t see the **All Files, MY FILES,** or **FILES IN MY GROUPS** filters. Users who don’t have the “Sync Files” permission don’t see the **Synced** filter.

To search for files from the search box:
1. Optionally, click a filter on the sidebar to restrict your search to a specific set of files.
2. Enter your search terms in the search box. You can search by file name, description, owner, type, or within the file’s text.
3. Click **Search** to see a filtered list of all relevant files based on your search terms. Or click **Clear** to clear your search terms.

The Select a File to Attach list doesn’t include:
- Documents from the Documents tab.
- Attachments from the Notes and Attachments related list.
- Links attached to posts in Chatter
- Files from your personal library

**SEE ALSO:**
- Search for Files

### Performing Actions on a File in a Chatter Feed
You can perform the following actions on files in feeds.

- **Preview**—Click the file thumbnail or click **More Actions > Preview** next to the file.
- **Download**—Click **More Actions > Download** next to the file.
- **Upload new version**—Click **More Actions > Upload New Version** next to the file.
- **View file detail page**—Click the file name or **More Actions > View File Details** next to the file.
- **Follow**—Click **Follow** next to a file to receive updates about the file in the Chatter feed. Click **Stop** to stop receiving updates about the file.
- **Share**—Click **More Actions > File Sharing Settings** next to the file to share the file with people, groups, or via link.

- If you have the “Sync Files” permission and are the owner of the file, click **Sync** to sync a file between your Salesforce Files Sync folder on your computer and Chatter. Click **Unsync** to stop syncing the file.

To learn who can perform which actions on a file, see **Who Can See My File?**

**SEE ALSO:**
- View File Details
- Upload a New Version of a File
- View Where a File is Shared
Downloading and Previewing a File in a Chatter Feed

Not only can you download and save files posted to Chatter feeds, you can also preview files in your browser without downloading them.

There are several places in Chatter where you can download and preview files:

• On the Files page—Click Download or click the preview icon next to the file.
• On any Chatter feed—Click More Actions > Download next to the file, or to preview the file, click on the file thumbnail or click More Actions > Preview.
• On the Files Owned by list on a profile—Click Download or click the preview icon next to the file.
• On the Files Shared with list on a group—Click Download or click the preview icon next to the file.
• In the Notes and Attachments related list on a record, click Download next to the feed attachment, or to preview the file, click Preview next to the feed attachment.

Previewing a file opens it in your browser with the enhanced document viewer. The enhanced document viewer provides the following capabilities for viewing documents:

• In addition to using the next page, previous page, first page, and last page icons on the document toolbar, you can navigate page-by-page through a document by right-clicking and choosing Next Page and Previous Page.
• You can use the scroll bar to move continuously through a document without needing to click the Next Page and Previous Page icons. Continuous scrolling is not available for PowerPoint files.
• You can jump directly to a page by entering the page number in the page field and pressing Enter.
• From the right-click menu you can choose Fit Width to expand the width of the document, or Fit Full Page to preview the whole page of the document. The fit width icon and fit full page icon are also available on the toolbar.
• From the right-click menu you can choose Full Screen to preview the document in full screen mode, or Exit to exit full screen mode. The full screen icon and exit icon are also available on the toolbar.
• From the right-click menu you can choose Zoom In or Zoom Out. The zoom-in icon and zoom-out icon are also available on the toolbar.
• You can use the keyboard arrow keys to navigate page-by-page through a document. Click on the document viewer and use the keys as follows:
  – Right-arrow key: moves a PowerPoint document forward one slide and moves a PDF, Word, or Excel document forward one page.
  – Left-arrow key: moves a PowerPoint document backward one slide and moves a PDF, Word, or Excel document backward one page.
  – Up-arrow key: moves a PowerPoint document forward one slide and scrolls a PDF, Word, or Excel document up the page.
  – Down-arrow key: moves a PowerPoint document backward one slide and scrolls a PDF, Word, or Excel document down the page.

Note:

• Not all files can be previewed, such as encrypted files, password-protected files, copy-protected PDFs, unknown file types, and any file larger than 25 MB. For files that can’t be previewed, the Preview option isn’t available on feeds or list views, and files appear as generic file type icons in the feed. Some Microsoft Office 2007 features don’t display correctly in previews. If a file can be previewed, but a preview doesn’t exist, contact your Salesforce administrator who may be able to regenerate the preview.
• In Internet Explorer 11, the Preview option redirects to the file detail page.

SEE ALSO:
Who Can See My Attached Files and Links?
Delete Files and Links from Feeds

Delete Files and Links from Feeds
To delete a file from a Chatter feed, simply delete its post. To delete a file, go to the file detail page or content detail page. Only a file owner can delete the file. Users with the “Modify All Data” permission can delete all comments, posts, files, and links.

Delete a File from a Chatter Feed on a Record
There are two ways to remove a file on a Chatter feed on a record:

• Remove the file on a Chatter feed by deleting its post. This deletes the post, removes the file from the feed and from the Notes and Attachments related list, but the file remains in its original location. If the file isn’t posted anywhere else, it goes back to being private, but can be shared again later.

• Remove the file on a Chatter feed by clicking Del next to the feed attachment on the Notes and Attachments related list. This action removes the file from all Chatter feeds where it’s been shared and deletes the file from the Notes and Attachments related list. Restore the file by clicking the Recycle Bin, selecting the file, and then clicking Undelete. If the file was attached from your computer, a Chatter feed, group, or a Salesforce CRM Content library, deleting it from the Notes and Attachments related list removes it from the post but doesn’t delete it from its original location.

Deleting a link from a Chatter Feed
To delete a link on a Chatter feed, you must delete its post.

Deleting a File from a File Detail Page
Click Delete on a file’s detail page to delete the file and remove it from all locations where it’s been shared. If the file is shared via link, anyone with the link will no longer have access to the file. To restore the deleted file, click on the Recycle Bin link on the Home page. Select the file and click Undelete. The file is restored as well as all of the shares that were associated with it.

Deleting a File from a Content Detail Page
When you post a file in Chatter, the file also appears in Salesforce CRM Content. To delete the file from Chatter, Salesforce CRM Content, and all locations where it’s been shared, click the name of the file on the Libraries, Content, or Subscriptions tab. From the content details page, click Edit > Delete Content to delete the file. Deleting a Chatter file from the content details page deletes the file from Salesforce CRM Content and from Chatter. Select the checkbox for the content file you want to restore, and click Undelete.

SEE ALSO:
Post Visibility
Attaching a Link to a Post

Share links with people by attaching them to a post.

If you share a URL for which we provide rich media support, your post shows a preview of the linked content. For information about currently supported URLs, see Sites That Generate a Preview in Posts.

1. Above your feed, click Link.
2. Type the URL to share.
3. Optionally, type a Link Name.
   If you leave the Link Name field blank, the preview shows the title or name from the site URL.
4. Optionally, type a post.
   If you don’t type any text, a generic update is posted with your link.
5. Below the text box, select My Followers to publish the post on your profile. To post to a group, select A Group. Type part of the group’s name in the Search Groups field, and select the group from the drop-down list. You can only select a group you’re a member of.
   If you’re posting on someone else’s profile or on a record, the My Followers and A Group options aren’t available.
6. Click Share.

SEE ALSO:
Sites That Generate a Preview in Posts

Sites That Generate a Preview in Posts

Salesforce provides rich media support for over 400 URLs. When you share a supported URL in a post, your post shows a preview of link content.

Embed.ly, a third-party service, powers file previews, which include thumbnails, descriptions, and video players for links to videos. If a post doesn’t render a link as a rich preview, the URL domain isn’t supported or Embed.ly was unable to return the preview content.

We don’t share any content, user, organization, or account data with Embed.ly. We share only the URLs that are on Embed.ly’s custom provider whitelist. The whitelist also includes versions of URLs that are shortened by third-party shorteners, like bitly, goo.gl, and tinyurl.com. All our URL requests pass through a Salesforce proxy. Embed.ly never receives calls directly from the client and therefore doesn’t have information about who’s making the URL request.

Note: For a look-up list of supported URL domains, see “URL Domains for Rich Link Previews in Feeds.”

SEE ALSO:
Attaching a Link to a Post
Post a Poll

Polls

Use polls to conduct a survey. A poll contains a list of choices in a feed post that lets people cast a vote by selecting one of the choices.

Polls are a great way to get people’s opinions. For example, you are in charge of planning an annual sales meeting and need to find out when most people are available to attend the meeting. Instead of emailing everybody in the sales organization, you could create a poll in the Sales Chatter group that lists possible dates and ask people to vote for the date that works best for them.

When you create a poll, anybody with access to the feed or the poll can vote on the poll. So when you post a poll, consider who you want to participate. For example, if you post a poll in a private group, only the members of that group can see the poll and vote. Keep the following in mind about polls:

- When you create a poll, you can add up to ten choices.
- When voting on a poll, you can only select one choice.
- Polls are anonymous. You can see how many people voted, but you can’t see who voted.
- Click Refresh to see the latest poll result and the number of votes that were cast.
- You can’t repost a poll.
- People can only cast one vote, but they can change their vote.
- You can mention someone and include hashtag topics in the poll question.
- You and others can add topics to your poll question after posting.
- The email notification options you enabled in your Chatter Email Settings apply to polls just as they do to posts. For example, if you get a notification whenever someone comments on a post you made, you also get an email notification when someone comments on a poll you posted.

Note: The poll result doesn’t always add up to 100 percent due to rounding. For example, if a poll has three choices and each gets one vote, the result adds up to 99 percent.

SEE ALSO: Like Posts and Comments

Create a Poll

Post a poll in your feed to gather people’s opinions.

1. Above the feed, click Poll.
2. Type a question in the text box.
   - Add a hashtag or mention someone.
3. Type at least two choices.
   - Click Add more choices to add another choice. You can enter up to ten choices.
4. Select to post the poll to your followers or to a group.
   - If you’re posting the poll to a group, select the name of the group from the drop-down list.
Collaborate with Everyone

5. Click **Share** to post the poll.

SEE ALSO:

- Vote on a Poll

**Vote on a Poll**

1. In the post that contains the poll, select your choice. You can only select one choice.

2. Click **Vote**. The post shows the current result of the poll. To change your vote click **Change vote** and select your new choice.

**Note:** The poll result doesn’t always add up to 100 percent due to rounding. For example, if a poll has three choices and each gets one vote, the result adds up to 99 percent.

SEE ALSO:

- Create a Poll

**Categorize Posts with Topics**

**Viewing All Topics**

Use the topics list to discover the topics that people are talking about in your organization. All topic names appear in this list, including topics used solely in private groups or on records.

Watch a Demo: [Discover and Organize with Chatter Topics (Salesforce Classic)](#)

To view the topics list, on the left side of the Chatter page, click **Topics**.

In the topics list, you can:

- Click a topic name to see the topic detail page.
- Click **Follow** to see updates in your Chatter feed.
- Filter the list of topics to narrow down what you’re looking for.
- Search for topics by name.

**Tip:** Use global search to search topic names and descriptions.

---

**EDITIONS**

Available in: **both Salesforce Classic and Lightning Experience**

Available in: **Group, Enterprise, Professional, Performance, Unlimited, Contact Manager, and Developer** Editions

---

**Tip:** Use global search to search topic names and descriptions.
Filters for Sorting the Topics List

Use the topic filters to narrow the topics list to your favorite topics or topics you use, and then sort the topics by the number of people talking about them or alphabetically by name.

On the Topics list, under Show, you can filter the topics.

**All**
- All topics that have been added to posts in your organization

**My Favorites**
- Topics you added to your favorites

**Topics I Use**
- Topics you added to posts and topics on posts that you commented on

Within the topics you filtered, you can sort by the following columns.

**People Talking About This**
- Sorts by the number of people talking about the topic. This includes:
  - The number of people adding the topic to updates
  - The number of people commenting on posts with the topic

**Name**
- Sorts alphabetically by the topic name.

Viewing Details about a Topic

View a topic detail page to see the topic description and a feed with topic updates from all users and public groups.

To open a topic detail page, click a topic or hashtag. On the topic detail page, you can:

- **Search a topic feed** to quickly find relevant information. Or scan the feed to learn about the topic and discover which people and public groups are interested in it.
- Add a post directly to the topic feed. Your followers automatically see the post, and you can even add the post to a group you’re a member of by using an @mention. Because you added the post on the topic feed, the topic is automatically added to your post.
- Discover **who’s knowledgeable** about the topic and endorse people you think are knowledgeable. If you appear in the Knowledgeable People list and you don’t want to, you can hide yourself.
- Click **Follow** to follow the topic and see updates to the topic in your feed.
- Edit the topic name and description. In the upper right, click **Edit Details**, and choose Edit Details. You can change only the capitalization and spacing of topic names.
  
  **Note:** Topic names and descriptions are not private, even those that appear solely in private groups and on records. Posts and records with topics have the same security and privacy as those without topics.

- If available, find out more about a topic using the lists on the right.

**Related Topics**
- Other topics that were added together with the current topic.

**Recent Files**
- Files you have access to that were most recently posted to the topic feed.
**Groups Talking**

Public groups and groups you’re a member of that most recently used the topic.

**Following Topics**

Follow topics so you can see updates in your Chatter feed.

To follow a topic, click **Follow** on the:

- Topic detail page
- Topics list

You can follow a maximum combined total of 500 people, topics, and records. To see how many items you’re following, view the Following list on your profile.

To stop following a topic, click **x** next to Following. After you stop following a topic, you don’t see future updates to the topic in your Chatter feed.

If your administrator disables feed tracking for topics, you can’t follow new topics but you continue to follow the ones you followed when feed tracking was enabled. These topics count toward the maximum number of people, topics, and records that you can follow. To stop following a topic after your administrator disables feed tracking, you must use the Chatter REST API.

**Find and Endorse People Knowledgeable about a Topic**

Discover and recognize experts using the Knowledgeable People section of topic pages and the Overview tab of user profile pages.

The topic page shows the five most knowledgeable people based on their activity on the topic and recognition received for the topic. For example, Chatter considers how often people:

- Were mentioned in posts or in comments on posts with the topic
- Received likes on comments on posts with the topic
- Received endorsements for the topic

Endorsements are a strong signal of knowledge, so if someone endorses you, you’re automatically included in the list of knowledgeable people.

**Note:** Knowledgeable people are calculated and updated once a day.
To change endorsements:

- Endorse someone you think is knowledgeable about a topic by clicking **Endorse** under the person’s name. If the person you want to endorse doesn’t appear in the Knowledgeable People section, click **Endorse People** to see the full list and to search for other people. (You can’t endorse yourself, Chatter Free users, or customers.)

- Remove your endorsement of someone at any time by clicking ![X] next to Endorsed under the person’s name. Removing your endorsement of someone doesn’t necessarily remove them from the knowledgeable people list; they might be endorsed by other people or have significant activity on the topic.

To remove yourself from the knowledgeable people list:

- Opt out by clicking **Hide me** under your name. No one can see you in the list after you hide yourself. If you change your mind, you can opt back in by clicking **Endorse People** and then **Show me** next to your name.

To see a person’s full range of expertise:

- Navigate to their user profile page, and click the Overview tab. Then click topic names to see topic detail pages, or click thumbs-up icons to add or remove your endorsements.

---

**Important:** If Work.com Skills are enabled, they replace knowledgeable topics on profile pages. (For Salesforce Communities users, skills replace topics only in the default community.) Self-declared skills are considered when calculating knowledge levels.
**Add Topics to Posts**

Add topics to posts to organize them or to increase their visibility. You can add topics to your own posts immediately after posting, or you can add topics to any posts at any time directly in the feed.

**Note:** All topic names appear in the topics list and all topic names and descriptions are searchable, including topics used solely in private groups or on records.

**Note:** When you add topics to posts that contain files, the topics are also added to those files.

1. In the top corner of the post, click  
2. Click **Add Topics** or **Edit Topics**.
3. In the topic editor, start typing your text. As you type, you can pick a topic from the list of suggestions, or keep typing to create your own unique topic. To add more than one topic, type a comma after each topic.
   
   **Note:** Commas (,) and closing square brackets (]) automatically end a topic. Other punctuation, symbols, and separators are supported in topic names.

   Posts can have up to 10 topics.

4. When you’re done adding topics, click **Done** or press ENTER.

The topics you add become links to the topic detail pages.

**SEE ALSO:**
- Add Hashtag Topics to Posts and Comments
- Adding a Topic as a Favorite

---

**Add Hashtag Topics to Posts and Comments**

Add topics to posts and comments to organize them or to increase their visibility.

For example, if you post that you’re working on a sales presentation for your customer Universal Paper, you might want to add the hashtag topic #Universal Paper in your update. Anyone can click the topic to find out more information about Universal Paper and to see which people and groups are talking about Universal Paper.

**Note:** When you add topics to posts that contain files, the topics are also added to those files.

To add a hashtag topic:

1. When writing an update, type # followed by any text. As you type, you can pick a topic from the list of suggestions, or press ENTER at any time to add a new topic that can be up to three words.

   **Note:** Commas (,) and closing square brackets (]) automatically end a topic. Other punctuation, symbols, and separators are supported in topic names.

2. Click **Share**.
The hashtag topic becomes a link to the topic detail page. The topic (without the hashtag) is also automatically added to the top-level post in the update. For example, if you include #Universal Paper in a comment under your coworker’s post, the topic Universal Paper is added to your coworker’s post.

Once you post an update, the only way to remove a hashtag topic is to delete the entire post or comment. You can, however, remove the topic from the top-level post.

SEE ALSO:
Add Topics to Posts

Add Topics to Files

Use topics to make files more visible. Topics added to feed posts are also added to any files in the post or its comments. When you search for those topics, the files are included in results.

To add topics to files posted in feeds, simply add the topics you want to the feed post on page 63 where the file is attached. You can add regular topics or hashtag topics on page 63. The topics are automatically added to any files attached to the post or its comments.

Note: While Lightning Experience supports adding hashtag topics, searching and viewing topic details are available only in Salesforce Classic.

Example:
Since Kimmy added the topics Sales Training, Western Region, and Feedback Request to her post, these topics are also added to the file she attached. Now, her coworkers can click a topic to find other posts, files, and records associated with that topic. If the topic is associated with records other than files, go to the Records tab and choose Files. Otherwise, use the Feeds tab to see all posts and files for the topic.
### Remove Topics from Posts

Remove a topic from a post if it no longer applies. You can remove topics from posts in the feed, whether they're regular topics or hashtag topics. Removing topics doesn't delete them altogether; it only removes them from the post. Deleting the text of hashtags doesn't delete hashtag topics. Before you remove a topic from a post, consider whether you or someone else added it. Someone else may be tracking the update with topics you're not aware of.

1. In the top corner of the post, click ![Edit](edit.png).
2. Click **Edit Topics**.
3. Click ![X](delete.png) next to the topic you want removed from the post.
4. Click **Done** or press ENTER.

Removing a topic from a post removes the post from the topic feed on the topic detail page and from the feeds of any followers.

### Adding a Topic as a Favorite

Add a topic as a favorite to quickly see the latest on the topics you're interested in.

1. Click a topic name to navigate to the topic detail page.
2. In the upper-right, click ![Add to Favorites](add-to-favorites.png), and choose **Add to Favorites**.

   The favorite name is the same as the topic name.

   **Tip:** When viewing a topic favorite, you can click the topic name at the top of the feed to go directly to the topic detail page.

### Viewing the Topics People Are Talking About

The topics you're talking about appear in your Chatter profile in the Recently Talked About section. This section helps people learn which topics you're knowledgeable about or interested in. These are the topics that you and others have frequently and recently (within the last two months) added to your posts and to posts you've commented on. For privacy reasons, Recently Talked About topics don't include topics used solely in private groups or record feeds. You can see up to five topics, with the most frequently and recently added topic appearing first. If you're new to topics or if you haven't used topics in the last two months, the Recently Talked About section doesn't appear until you start using topics more frequently. Click a topic in this section to see the topic detail page.

**Note:** If the Knowledgeable About list or Work.com Skills are enabled, those features replace the Recently Talked About section on profile pages.
View the Topics Groups Are Talking About

The topics that a group is talking about appear on the group detail page in the Recently Talked About section. This section helps people understand which topics a group is knowledgeable about or interested in. These are the topics most frequently and recently added to group posts over the last two months. You can see up to five topics, with the most frequently and recently added topic appearing first. If a group isn’t using topics, the Recently Talked About section doesn’t appear until the group starts using topics more frequently. Click a topic in this section to see the topic detail page.

Viewing Your Company’s Trending Topics

The Trending Topics area on the Chatter tab shows the topics being discussed right now in Chatter. The more frequently people add a specific topic to their posts and comments and comment on or like posts with the same topic over a short period of time, the more likely it is to become a trending topic. For example, if your coworkers are attending the upcoming Dreamforce conference and have started discussing it in Chatter, you may see a trending topic for Dreamforce. A trending topic is not solely based on popularity and usually relates to a one-time or infrequent event that has a spike in activity, such as a conference or a project deadline. For privacy reasons, Trending Topics don’t include topics used solely in private groups or record feeds.

SEE ALSO:

Viewing the Topics People Are Talking About
View the Topics Groups Are Talking About

Share Posts

Sharing a Chatter Post

Sharing lets you quickly copy a public post to your profile or a group. This change applies to Salesforce Classic only.

You can share public Chatter posts that contain text, links, or files to your profile, with a group, or using a link to the post.

When you share a post, keep in mind:

• You can share a post to your own profile, but not to another person’s profile.
• You can share the original post, including any files and attachments, but you can’t share any comments or likes.
• You can comment on the shared post, but you can’t edit a shared post.
• You can’t share feed tracked items and custom feed items, such as approvals, dashboard snapshots, or case interactions.
• You can’t share a post from a record feed.
• You can only share posts with a group you’re a member of.
• You can share a post to a group that allows customers. However, customers and other group members can’t share posts from a private group.
Only Chatter users inside your company can see a post that you shared using a link in an email or instant message. When someone shares your post, you receive an email notification. To change your email notifications, from Setup, enter Chatter Email Settings in the Quick Find box, then select Chatter Email Settings.

SEE ALSO:
  View a Single Chatter Post

### Sharing a Chatter Post to Your Profile

Copy a public post to your profile to share it with the people who follow you.

You can share public posts, but you can’t share feed tracked items and custom feed items, such as approvals, dashboard snapshots, or case interactions.

1. Find the post you want to share in your Chatter feed.
2. Click Share.
3. Write a comment about the post or leave the comment field blank.
4. In the drop-down list, select My profile.
5. Click Share.
   The shared post appears in the Chatter feed on your profile.

SEE ALSO:
  Post Visibility

### Share a Chatter Post with a Group

You can share posts with a group that you’re a member of.

You can share public posts, but you can’t share feed tracked items and custom feed items, such as approvals, dashboard snapshots, or case interactions. You can’t share posts with archived or unlisted groups.

1. Find the post you want to share in your Chatter feed.
2. Click Share.
3. Type a comment about the post or leave the comment field blank.
4. In the drop-down list, select A group.
5. Type part of the group name and select the group from the list.
   If you are sharing a post with a file, select Viewers to allow group members to only view the file, or select Collaborators to allow group members to download and modify the file.
6. Click Share.
   The shared post appears in the feed of the group.

SEE ALSO:
  Post Visibility
Sharing a Link to a Chatter Post

Share a post with other Chatter users via email or instant message.

When sharing a link to a post, keep in mind:

- You can’t share a link to a post from a private group.
- You can share public posts, but you can’t share feed tracked items and custom feed items, such as approvals, dashboard snapshots, or case interactions.
- In order to see the post, the people to whom you send the link to the post must be Chatter users.

1. Find the post you want to share in the Chatter feed.
2. Click Share.
3. In the top corner, click Show link to post.
4. Copy and paste the link in an email or instant message and send it to the people with whom you want to share the post. When recipients of the email or instant message click the link to the post, the post appears in their Chatter updates.

SEE ALSO:
- Post Visibility

View a Single Chatter Post

You can view a single Chatter post in a feed for a user, record or group.

- In a feed, click the timestamp displayed below the post, for example, Yesterday at 12:57 AM.
- In a Chatter email notification, click the link in the body of the email to view only the related post.
- To view the full feed, above the post, click All Updates.

SEE ALSO:
- Sharing a Link to a Chatter Post

People in Your Organization

Update your personal profile and view the profile of other people in your organization.

IN THIS SECTION:
- People Overview
- Chatter Profile Overview
  Customize your personal Chatter profile with a photo and information about yourself so others can learn more about you.
- Profile Best Practices
- Using the Following and Followers Lists
- People Recommendations
Give Thanks to Your Coworkers
Recognize your coworkers with badges and post your thanks directly to their Chatter feed.

Files Owned Lists on Profile Pages
The Files Owned list on a person’s profile shows the files that person most recently attached to a Chatter post.

Chatter Activity and Influence
See your personal Chatter activity statistics, such as how many posts you’ve made and how many likes you’ve received, and check your relative Chatter influence.

Inviting People to Join Chatter

People Overview
The People tab and the People list on the Chatter tab display a list of the users in your organization.

- Click a person’s name or photo to view his or her profile.
- Click Follow to see a person’s updates in the Chatter feed. You can’t follow customers.
- Click Following to stop seeing a person’s updates in the Chatter feed.
- Click a column header to sort the list:
  - Name sorts alphabetically by name. By default, the list is sorted alphabetically, in ascending order.
  - Following sorts based on who you’re following and not following.
- Search for users by typing characters of a first or last name in the search box at the top of the page. The list automatically filters based on what you type.
- At the top of the list, click a letter to list everyone whose last name begins with that letter.
- Your organization’s size determines what you see in the people list. For example, in the largest organizations, we don’t display any users until you start searching for a person’s name. We count all Salesforce user license types when calculating the approximate number of users, including internal users, Communities users, and Chatter users.

<table>
<thead>
<tr>
<th>Approximate number of users</th>
<th>Defaults to view</th>
<th>All People filter defaults to</th>
</tr>
</thead>
<tbody>
<tr>
<td>25 or fewer</td>
<td>All People</td>
<td>Everyone in the organization</td>
</tr>
<tr>
<td>26 to 25,000</td>
<td>Recently Viewed People</td>
<td>People whose profiles you recently viewed</td>
</tr>
<tr>
<td>More than 25,000</td>
<td>Recently Viewed People</td>
<td>No one until you start searching</td>
</tr>
</tbody>
</table>

- Invite people to join your Chatter network. Invited users can view profiles, post on their feed, and join groups, but can’t see your Salesforce data or records.
- View the people that Chatter recommends you follow. Click More in the Recommended People section to view all of your recommendations. If no recommendations appear, then you’re already following all the recommended people.

Chatter, Profile, People, Groups, and Files tabs are available by default in the Chatter app. Select the Chatter app from the app menu in the top right corner of any page. If your administrator has added these tabs to other apps, you see the tabs in those apps unless you previously customized your display. In that case, add the tabs to those apps.

SEE ALSO:
  - Chatter Moderators
Chatter Profile Overview

Customize your personal Chatter profile with a photo and information about yourself so others can learn more about you.

Click your name anywhere around the application to view your profile. If available, you can also click the Profile tab or Your Name > My Profile at the top of the page. View other people’s profiles by clicking their name.

From this page you can:

1. Change your profile picture.
2. Click 🖌️ in the Contact section to edit your contact information.
3. View content on different tabs. Your administrator configures the tabs and can add custom tabs or remove the default tabs.
   - Feed tab—View your Chatter feed or post an update.
   - Overview tab—Update your About Me section, view your activity in a Q&A or Ideas community, view your groups, or see who’s following you and who you’re following.
4. Edit your profile or access your personal settings.
Note: More options are available when viewing someone else's profile. For example, if available, you can follow or unfollow someone or send them a private message.

SEE ALSO:
- Profile Best Practices
- People Recommendations

Profile Best Practices

When using profiles, consider these tips:

- Information in the About Me section is searchable and makes you more visible to others.
- Your posts display in your Feed tab and the feeds of people following you. To delete your posts from feeds, hover over the post and click ✗.
- To change your email address in your contact information, you must click the link in the confirmation email sent to your new email address.
- Not all users have profiles. This includes portal users and the Connection User in organizations using Salesforce to Salesforce.

Using the Following and Followers Lists

View the Following and Followers lists on your profile to see who, what, and how many items you’re following, and who is following you. If you’re not following anyone, click Find people to follow in the Following list to view the People list and start following people. You can also view the Following and Followers lists on other people's profiles.

Note: When your Salesforce admin enables Chatter, you automatically follow some users and records in your org.

In either list, click Show All to view the full list in alphabetical order.

- Use the Next and Previous links to see more of the list.
- Optionally filter the Following list by people or objects, for example, accounts or files.
- In your Following list, click ✗ to stop following a person or record.
- In another person’s Following list, click ➕ Follow to follow a person or record.
- In any Followers list, click ➕ Follow to follow a person, or ✗ to stop following them.
- Click Done to close the window.

SEE ALSO:
- Post Visibility
- People Recommendations
People Recommendations

Chatter recommends people in your organization that you might want to follow based on similar interests. For example, Chatter recommends people who:

- Follow the same people as you.
- Are in your management hierarchy, such as your manager, people who report to your manager, and people who report to you.

Salesforce uses the Manager field on your personal information page to determine these recommendations. If this field is blank, Chatter won’t recommend people based on your management hierarchy. Only your Salesforce administrator can edit the Manager field.

- Are popular, which means they have many followers.
- Are new to Chatter.
- Are interested in the same records as you. For example, someone who has looked at or edited an account that you’ve recently viewed.
- Are often followed together with people you already follow. For example, if you follow Madison Rigsby, you get a recommendation for Suzanne Powell if many people who follow Madison also follow Suzanne.

To see an expanded list of your recommendations, click More in the Recommendations section. If no recommendations appear, then you’re already following all the recommended people.

SEE ALSO:

Chatter Profile Overview

Give Thanks to Your Coworkers

Recognize your coworkers with badges and post your thanks directly to their Chatter feed.

Note: The Chatter Free license has limited functionality with Thanks features.

Rewards features require a Work.com license. This includes giving, creating, or receiving badges tied to rewards.

Thank someone if they’ve done a great job or to recognize an achievement.

Walk Through It: Give Thanks in Chatter

1. From the Chatter publisher, click Thanks.

   If Thanks isn’t displayed, click More and select Thanks from the publisher’s drop-down menu.

2. Type the name of the person you want to thank.

   Currently, you can only thank one person at a time, but you can mention other people in your post’s message.

3. Select Change Badge to select a different badge for your post or keep the default badge.

   You can choose from twelve pre-defined badges. Select the badge image to see more information about the badge.

4. Type a message for the person you’re thanking.

5. Select your audience.

   - My Followers to post to all your followers
- **A Group** to post to a specific group. Search for the group and select the group from the list. The person you’re thanking is @mentioned at the beginning of the post’s message. When you post to a private group, only the group’s members can see your post to the group. However, the badge will also appear publicly on the Recognition tab of the recipient’s profile.

6. **Click Share.**

Your Thanks post appears in your feed and the feed of the person you’re thanking. If you’re posting to a public group or a record page, the post appears on the group or record feed and their profile. If you’re posting to a private group, only members of the private group can see your post to the group. However, the badge will also appear publicly on the Recognition tab of the recipient’s profile.

### Files Owned Lists on Profile Pages

The Files Owned list on a person’s profile shows the files that person most recently attached to a Chatter post.

The list includes files that the profile owner attached to a post on the profile, a group, or record page, or uploaded to Salesforce CRM Content libraries. Hover to see available options or click the file name to go to the file detail page.

Click **Show All** to see a list of all the files the profile owner attached and uploaded. The list doesn’t include files you don’t have access to, documents from the Documents tab, and attachments from the Notes and Attachments related list. On this list you can:

- Upload private files or share files with people, groups, or via a link
- Preview a file, if a preview is available
- Follow a file to receive updates in your feed
- Click the file name to view the file detail page

**SEE ALSO:**

- Filter Your Files List

### Chatter Activity and Influence

See your personal Chatter activity statistics, such as how many posts you’ve made and how many likes you’ve received, and check your relative Chatter influence.

Chatter activity statistics include how many posts and comments you’ve made, how many comments you’ve received, and how many people liked your posts and comments. Chatter influence shows how your activity stacks up to other people’s.

- **Top Influencers** lead collaboration efforts by regularly sharing essential content.
- **Active Influencers** encourage others to get involved and share knowledge.
- **Observers** are quiet participants or just getting started in Chatter.

You can see your Chatter activity statistics and influence on your profile under your photo. You can also see your coworkers’ Chatter activity and influence on their profiles. When viewing a profile, hover over under the profile photo for details about how that person is uniquely influential.

**SEE ALSO:**

- Chatter Profile Overview
Inviting People to Join Chatter

You can invite people from your company that don't have Salesforce licenses to use Chatter. Invited users can view profiles, post on their feed, and join groups, but can't see your Salesforce data or records.

To invite people to Chatter:

1. Click **Invite People to Chatter** on the People page or **Invite Coworkers!** on the Chatter page.
   - **Note:** You can only invite people with email addresses in your company's domains. Portal users can't send invitations.

2. To send invitations from Chatter, enter email addresses and click **Send**.

3. To send invitations using your own email account, click **send your own email invitation**. If you have a default email client set, an email containing an invitation link opens in your mail program. Otherwise, you see an invitation link that you can copy and paste into an email.

You can also invite coworkers to join a public group even if they don’t use Chatter yet. Additionally, owners and managers of private groups can send invitations. If customer invitations are enabled, owners and managers can also invite customers. When someone accepts an invitation to join the group, they join Chatter as well.

1. Click **Groups** and click on a group name.

2. In the Members section on the group detail page, click **Invite People**.
   - If you are the group owner or manager, you can also click **Add/Remove Members**, then click **Invite them to Salesforce Chatter!**.

3. Enter email addresses and click **Send**.

   **Note:** If a user doesn’t accept the invitation within the first day, Chatter sends an email reminder the second day. If the user doesn’t accept that invitation, Chatter sends another reminder the following day.

   A user has up to 60 days to accept an invitation to join Chatter. If during that time, an administrator deselects **Allow Invitations** or removes the user’s domain from the list, the user can't accept the invitation.

   When delegated authentication single sign-on is enabled in your organization, invited users bypass the password registration page. If their username already exists, they won’t be able to accept the invitation.

SEE ALSO:

About Chatter Customers in Private Groups
**Moderate Chatter Free Users**

**Chatter Moderators**

A moderator is a Chatter user with some additional privileges such as:

- Activate or deactivate Chatter Free users
- Assign a Chatter Free user as moderator or take the privilege away
- Access to details about all users in your org
- Delete posts and comments that they can see

You can tell if someone is a moderator by the special banner on their profile picture.

SEE ALSO:

- What Your Chatter Group Role Allows You To Do

**Assign Moderator Privileges to Chatter Free Users**

As a moderator, you can assign moderator privileges to Chatter Free users in your organization. You can also remove them if needed.

1. Go to the person’s profile page by clicking their name in the People tab or on a feed.
2. On the profile page, you can take these actions from the user action menu.

- If you want the person to be a moderator, select Assign Moderator Privileges.
- If the person is a moderator and you want to revoke those privileges, select Remove Moderator Privileges.

SEE ALSO:

- Change Chatter Group Roles
Deactivate Chatter Free Users
As a moderator, you can deactivate Chatter Free users if, for example, they left the company.

1. Go to the person’s profile page by clicking their name in the People tab or on a feed.
2. On the profile page, click Deactivate User from the user action menu.

![User Menu with Deactivate User Option]

If you need to re-activate a Chatter Free user, you must use global search to find their profile, as deactivated users don’t show up on the People tab. To activate a user:

1. Find the person’s profile using global search.
2. On the profile page, click Manage User and select Activate User.

SEE ALSO:
What happens when the owner of a Chatter group is deactivated?

Records and List Views
Configure your follow settings for records, view Chatter feeds on list views, and learn more about record recommendations.

IN THIS SECTION:
- Automatically Follow Records You Create
- Viewing Record Feeds
- Can I create a custom report for records I'm following?
- Can other people follow records I own?
- Record Recommendations
- Viewing Chatter Feeds on List Views
- Adding a List View as a Chatter Favorite

Add a list view as a Chatter favorite to monitor key business processes directly from your Chatter tab.
Automatically Follow Records You Create

When you follow records you create, updates are sent to your Chatter feed when you or someone else changes a tracked field on those records.

By default, you don’t automatically follow the records you create. If you want to automatically follow the records you create, enable auto-follow in your Chatter Settings.

1. From your personal settings, enter My Feeds in the Quick Find box, then select My Feeds.
2. Select Automatically follow records I create.
3. Click Save.

Consider the following tips around auto-following records:

- When you create a child record, the owner of the parent record becomes the owner of the child record by default. So you don’t automatically follow the child record, unless you’re the owner of the parent record.
- The Account Owner field of a record is updated to change the account owner. The new account owner only follows the account automatically, if the Account Owner field is feed-tracked and the new account owner has auto-follow enabled.
- If a workflow changes the Account Owner field while the record is created, the user who created the record doesn’t automatically follow the account.

Consider the following scenario. You are creating a record. Saving the record starts a workflow that immediately reassigns the Account Owner field to another user and then saves the record. Meaning, the workflow changes the Account Owner field before the record is saved. In this case, you don’t follow the record automatically, because you never were the record owner, even though you technically created the record.

SEE ALSO:
- Viewing Record Feeds
- Record Recommendations

Viewing Record Feeds

View the Chatter feed associated with a record you follow to see updates about the record.

Record feeds allow you to track information for records you have access to. On the record detail page, click Show Feed to display the record feed above the account details.

Note: Access is all-important. For example, let’s say you reassign a record and then realize it needs an update. Often, you can open and update the record. But if, after the reassignment, you no longer have access, then you won’t be able to see or update the record.

In the record feed, you can

- View posts, comments, and tracked field changes.
- Write an update about the record and share it with other people who follow the record.

Updates on the record detail page also appear on the Chatter page of people who follow the record. Anyone who has access to the records can see the update in the All Company (Salesforce Classic) feed. They may see the update in the Company Highlights (Lightning Experience) feed, depending on the update’s popularity ranking and engagement (such as comments, likes, and views).
- See who is following the record.
Can I create a custom report for records I'm following?
Currently, you can’t customize a report based on records you're following in Chatter.

SEE ALSO:
The People and Records You Auto-Follow Initially

Can other people follow records I own?
Yes, provided that they can already see the record. People can only follow records they can see, and by extension, can only see updates to records they can see.

SEE ALSO:
Record Recommendations

Record Recommendations
Following records helps keep you up-to-date on important changes to accounts, contacts, opportunities, and more. Chatter recommends records that you’ve viewed or edited, records that you own (and aren’t already following), and parent accounts of records that you’re following.

Chatter won’t recommend records that your Salesforce administrator has disabled feed tracking for. Only opportunities, accounts, leads, contacts, and articles are included in record recommendations.

To see an expanded list of your recommendations, click More in the Recommendations section. To see your record recommendations by object, click the object in the side filters. For example, click Accounts to view only your account recommendations.

If no recommendations appear, then you’re already following all the recommended records.

SEE ALSO:
Viewing Record Feeds
Viewing Chatter Feeds on List Views

Switch to an object's Chatter feed directly from a list view to see updates for the records included in the list view.

If Chatter is enabled for your organization, Chatter feeds on list views are available for most feed-tracked objects. Some feed-tracked objects don't have a Chatter feed associated with their list view. Currently, you can view Chatter feeds on list views for opportunities, accounts, cases, leads, campaigns, contacts, and custom objects.

- Click Feed on a standard or custom object list view to see a Chatter feed with updates from the last 30 days for the records included in the list view.
  If drag-and-drop scheduling on list views is enabled, you won't see Chatter feeds on the list views for accounts, contacts, or leads.

- Click List to display the list view again.

SEE ALSO:
  Viewing Record Feeds

Adding a List View as a Chatter Favorite

Add a list view as a Chatter favorite to monitor key business processes directly from your Chatter tab.

1. Open an existing list view or create a list view for a set of records, like for example accounts, opportunities, or leads.
2. Click Feed in the top-right corner to see the Chatter updates for the list items.
3. Click Add to Favorites.
   The favorite name on the Chatter tab is the same as the list view name.

SEE ALSO:
  Viewing Record Feeds
Dashboards and Dashboard Components

Follow Dashboards and Dashboard Components

If feed tracking is enabled for dashboards, you can view updates and field changes in the Chatter feed.

Only unfiltered data is used to generate alerts. This prevents alerts being sent out (incorrectly) because a component’s value appeared to cross a breakpoint as a result of filtering.

If you don’t see feeds, ask your administrator to enable feed tracking for dashboards.

For example, to receive alerts when total sales for a gauge fall below a certain amount, set conditional highlighting on that component, then follow it.

1. To follow a dashboard, click Follow.
   
   When you follow a dashboard in Salesforce Classic, you automatically follow all eligible components.
   
   When you follow a dashboard in Lightning Experience, you don’t follow any components.

2. Optionally, to follow a specific dashboard component, if necessary, switch to Salesforce Classic.
   
   Hover over a component to display the menu. Then, click Follow this Component.
   
   To clear the hover menu, click an empty part of the screen.

To stop following a component, click and select Following.

Take note of these limitations to following dashboards and dashboard components.

- Lightning Experience doesn’t support following components. To follow dashboard components, switch to Salesforce Classic.
- Dynamic dashboards don’t support following components.

SEE ALSO:

Viewing Record Feeds

About Posting Snapshots to User and Group Feeds

When you post a component snapshot to a Chatter feed, consider who you would like to share and comment on the component.

A snapshot is a static image of a dashboard component at a specific point in time posted to a Chatter feed. Post a component snapshot to a user or group feed to share and comment on that component. For example, post a snapshot of this month’s sales to your team.

Each snapshot has a “Viewing As” label. This is the name of the running user whose dashboard component you’re viewing.

You can also post snapshots of filtered components (except Visualforce or s-control components). When viewers click the snapshot title in the feed, they’re taken to your filtered view of the dashboard if the filters are still valid. If the filters aren’t valid, they see the unfiltered dashboard.

If you don’t see the option to post a snapshot, talk to your administrator about enabling dashboard component snapshots.

Important: Posting a snapshot to a user or group feed makes it potentially visible to the entire organization:

- Posting to a user feed makes the snapshot public. Anyone who views that user’s profile can see it.
Collaborate with Everyone

• Posting to a public group makes the snapshot public. Anyone who views your profile or the group feed can see it.
• Posting to a private group shows the snapshot to all group members.

People can see it whether they have access to the dashboard or not. Make sure the component doesn't contain sensitive information!

SEE ALSO:

Follow Dashboards and Dashboard Components

Posting Snapshots of Dashboard Components to Chatter

Post a snapshot of a dashboard component to a Chatter feed to help other users follow changes in the data.

A snapshot is a static image of a dashboard component at a specific point in time posted to a Chatter feed.

• Post a component snapshot to its dashboard feed to share information with everyone following the dashboard. For example, post a snapshot of a regional sales chart to let your team know that sales are down in the Midwest.
• Post a component snapshot to a user or group feed to spark comment or action from that user or group.

Each snapshot has a “Viewing As” label. This is the name of the running user whose dashboard component you’re viewing.

You can also post snapshots of filtered components (except Visualforce or s-control components). When viewers click the snapshot title in the feed, they’re taken to your filtered view of the dashboard if the filters are still valid. If the filters aren’t valid, they see the unfiltered dashboard.

If you don’t see feeds, ask your administrator to enable feed tracking for dashboards.

1. In Salesforce Classic: Hover over a component to display the menu.
   To clear the hover menu, click an empty part of the screen.

   In Lightning Experience: First expand a component by clicking , then click Share.

2. In Salesforce Classic: Choose where you want your snapshot to appear.
   • To show it in a dashboard, click Post Snapshot to Dashboard Feed.
   • To show it to a user or group, click Post Snapshot to User or Group Feed.

   In Lightning Experience: Choose where you want to share your snapshot.

   • To share it in the dashboard feed, click This dashboard.
   • To share it with a group, click A group.
   • To share it on your own feed, click My followers.

3. Write a comment in the text box. In Salesforce Classic, click OK. In Lightning Experience, click Post. If you’re posting a filtered component, you may want to mention that in your comment.

   The snapshot and comment immediately appear in the dashboard, user, or group feed.

   Note: Snapshot images display in feeds for four months. After four months, only the comments remain.
Collaborate in Chatter Groups

Use public, private, or unlisted Chatter groups to collaborate with specific people in your company.

IN THIS SECTION:

Chatter Groups
Chatter groups let you collaborate with specific people. For example, if you’re working on a team project, you can create a group for your team to share project-related files and information. Group feeds in Lightning Experience are live feeds that update in real time. They don’t require a page refresh to update.

Unlisted Groups Overview
Unlisted groups offer more privacy for compared to private groups. Only group members and users with the “Manage Unlisted Groups” permission can access unlisted groups in list views, feeds, and search results.

Broadcast Groups
Broadcast groups are a special type of public, private or unlisted group where only group owners and managers can create new posts. Group members can comment on the posts created by the group owner or manager.

Using the Chatter Groups Page
The Groups page displays a list of the Chatter groups in your company.

Join or Leave Groups
Join groups to collaborate with other people on projects or common areas of interest. Share project-related files and information with the group.

Chatter Groups
Chatter groups let you collaborate with specific people. For example, if you’re working on a team project, you can create a group for your team to share project-related files and information. Group feeds in Lightning Experience are live feeds that update in real time. They don’t require a page refresh to update.

You can join up to 300 groups, and your company can have a total of 30,000 groups. Chatter groups have different levels of access:

- **Public**: Anyone can see and add posts, comments, and files. Anyone can join a public group.
- **Private**: Only group members can see and add posts, comments, and files. People must ask to join or be added by the group’s owner or managers. Users with the “Modify All Data” and “View All Data” permission can see group posts, updates, and files across the organization. Users with the “Manage All Data” permission can also join private groups directly and change group settings.
- **Unlisted**: Only group members and users with the “Manage Unlisted Groups” permission can see and add posts, comments, and files. People cannot ask to join and must be invited by the group’s owner or managers. Unlisted groups offer more privacy and nonmembers cannot see or access unlisted groups in list views, feeds, and in search results. Unlisted groups aren’t available by default; your administrator must enable them for your organization.
- **Optionally, select Allow Customers.** The group owner and managers can invite customers to join a private or unlisted group. You can easily identify groups with customers by the orange upper left corner of the group photo.

After you allow customers in a group, you can’t change the group access level.

If your administrator has enabled the archive feature, some groups can be archived. When a group is archived, users can’t create posts but group data is retained for reference.
**Note:** Live group feeds is a new feature in Lightning Experience with lots of potential for enhancement and a few known issues.

- Content posted to the group is live, but mentions are not. If you post to group A, the post is live. If you mention group A in another feed, group A requires a page refresh to show that mention.
- When a group has a new post, you receive notifications only in Lightning Experience.
- When new comments are made on a feed post that you’re engaged in, you receive notifications only in Lightning Experience and only when you’re actively typing comments or you’ve clicked into the comments box.
- The number of participants supported in a live feed depends on your org’s subscription limits. If you’re not getting a live group feed or live comments, refresh the page or click in a comments field. If the feed still isn’t live, looks like your org has hit its limit! You can still get updates the old-fashioned way by refreshing the page.
- If you’re in a group feed that seems not to be live anymore, this is a known issue that we’ll resolve!

SEE ALSO:

- What Your Chatter Group Role Allows You To Do
- About Chatter Customers in Private Groups
- Live Feeds

### Unlisted Groups Overview

Unlisted groups offer more privacy compared to private groups. Only group members and users with the “Manage Unlisted Groups” permission can access unlisted groups in list views, feeds, and search results.

Unlisted groups are similar to private groups, in that, only members can view an unlisted group’s detail page, feed, or files. However, unlisted groups provide more privacy compared to private groups.

- Unlisted groups don’t display in list views, feeds, and search results for nonmembers. Only members and users with the “Manage Unlisted Groups” permission can find and access unlisted groups.
- Nonmembers can’t visit the group detail page.

(With private groups, nonmembers can see a truncated version of the detail page, which shows the name, description, and member list, but not the feed or files.)

- You can convert unlisted groups to public or private groups, but not the other way around.
- Only group owners, group managers, and users with the “Manage Unlisted Groups” permission can add group members. Users can’t ask to join them.
- Users can’t see unlisted groups on other user profiles unless they have access to the group.
- Files shared in unlisted groups are visible only to the members of the unlisted group. If the file is shared outside the unlisted group, then other users with permissions can update the file.
- Even users with the “Modify All Data” or “View All Data” permissions can’t access an unlisted group or its files unless they’re members. They also can’t change group settings unless they own or manage the group.
- Only users with the “Manage Unlisted Groups” permission can access or modify unlisted groups and its files and feed content without membership.

### Limitations

If you decide to create an unlisted group, make sure that you consider these limitations.
• Custom pages or third-party applications integrated with Salesforce could expose unlisted group information to users who don’t have access via the Salesforce UI. Check in with your administrator about who can access information in unlisted groups in your organization.

• You can’t use topics in unlisted groups. You can add a hashtag topic when writing a post or comment in an unlisted group, and the topic will be formatted as a link after you post. However, a topic detail page isn’t created, and the link won’t work.

• You can’t mention unlisted groups in posts or comments.

Broadcast Groups

Broadcast groups are a special type of public, private or unlisted group where only group owners and managers can create new posts. Group members can comment on the posts created by the group owner or manager.

By restricting the ability to post, group owners and managers can keep group discussions focused and relevant by cutting down noise from off-topic posts. Public, private, and unlisted groups support this feature.

To set a group to broadcast mode, select Broadcast Only in the group settings.

Example: Creating broadcast groups are ideal when one person or a fixed set of individuals regularly needs to communicate or share information with a large group of people. Some examples include:

• Organization-wide updates from the executive leadership in the company
• Policy changes from your company’s HR department
• Event updates from the organizer of large events or company conferences
• Important action alerts from key IT personnel, including their awesome Salesforce administrator

Broadcast group setting in Salesforce Classic.
Broadcast group setting in Lightning Experience.
Using the Chatter Groups Page

The Groups page displays a list of the Chatter groups in your company.

Click Groups on the sidebar of the Chatter page to display the list of Chatter groups. On the Groups page you can

Create a new group

Click New Group to access the New Group page and create your group.

Filter and sort the groups list

Use the following filters to filter your groups.

- Recently Viewed shows the groups you recently looked at, starting with the group you viewed last
- My Groups shows the groups you belong to, own, or manage
- Active Groups shows the active groups in your company

EDITIONS

Available in: both Salesforce Classic and Lightning Experience

Available in: **Group, Enterprise, Professional, Performance, Unlimited, Contact Manager, and Developer** Editions
• **My Archived Groups** shows the archived groups you belong to, own, or manage.

   Click a column header to sort the list. The Group column sorts by group name; the Last Activity column sorts by the date of the last post or comment on a group; the Membership column sorts based on your membership status.

**Search for a group**

   Search for groups by typing two or more letters of a group name or description in the Find Groups box. The list automatically filters based on what you type.

**View a group**

   Click a group name to view the group. You can view all groups, but you'll only see updates and files for public groups, and for private groups you belong to. Groups that allow customers say (With Customers).

**Join a public group or ask to join a private group**

   Click Join to join a public group. For private groups, click Ask to Join to email a request to join to the group's owner and managers. Users with the "Modify All Data" permission can directly join private groups, and therefore see Join for private groups.

**Leave a group or withdraw a request to join a group**

   Click to leave a group or to withdraw a request to join a group.

**View the group owner's profile**

   Click a group owner's name to see his or her profile.

**Get a group recommendation**

   View the groups that Chatter recommends you join based on the group's popularity and the number of connections you have in the group in the Recommendations section. Click More to see the full list. If you don't see recommendations, you already belong to all the recommended groups.

SEE ALSO:

   Group Files Lists

**Join or Leave Groups**

Join groups to collaborate with other people on projects or common areas of interest. Share project-related files and information with the group.

1. Go to group's detail page.
2. To join a public group, click Join or Join Group. To join a private group, click Ask to Join. Your request is sent to the private group's owner and managers, who accept or decline your request.

   You can join up to 300 groups. All groups count toward this limit, except archived groups. For example, if you're a member of 300 groups, of which 10 are archived, you can join 10 more groups.

   To leave a group you joined or withdraw your request to join a private group, go to the group detail page and click or Leave Group. If you don't see these options, ask your Salesforce admin to adjust the page layout.
Create and Manage Groups

Create Chatter Groups

Create public, private, and unlisted Chatter groups to collaborate with your teams and work together on projects.

1. Navigate to the list of groups.
   - In Salesforce Classic, click the Groups tab.
   - In Lightning Experience, click in the navigation menu.

2. To the upper-right, click New Group, and enter a group name and description.
   
   Note: Group names must be unique across public and private groups. Unlisted groups don’t require unique names.
   
   If Communities is enabled, public and private group names must be unique within the community.

3. Select an access level:
   - Public: Anyone can see and add posts, comments, and files. Anyone can join a public group.
   - Private: Only group members can see and add posts, comments, and files. People must ask to join or be added by the group’s owner or managers. Users with the “Modify All Data” and “View All Data” permission can see group posts, updates, and files across the organization. Users with the “Manage All Data” permission can also join private groups directly and change group settings.
   - Unlisted: Only group members and users with the “Manage Unlisted Groups” permission can see and add posts, comments, and files. People cannot ask to join and must be invited by the group’s owner or managers. Unlisted groups offer more privacy and nonmembers cannot see or access unlisted groups in list views, feeds, and in search results. Unlisted groups aren’t available by default; your administrator must enable them for your organization.

4. Optionally, select Allow Customers. The group owner and managers can invite customers to join a private or unlisted group.
   - You can easily identify groups with customers by the orange upper left corner of the group photo.
   - After you allow customers in a group, you can’t change the group access level.

5. Optionally, if your administrator has enabled group archiving, change the automatic archiving settings for the group. Disable automatic archiving only if a group must remain active at all times, despite extended periods of inactivity.

6. Click Save.
Note: You own groups you create. To assign a new owner, finish creating the group, then edit the group settings.

SEE ALSO:
Can I change a group’s access level, for example, to make a private group public?

Edit Group Settings

Edit the group settings to change the owner, modify archiving settings, group access level, and delete the group.

You can edit settings for Chatter groups you own or manage.

1. Click Group Settings on the group detail page in the Salesforce Classic. In the Lightning Experience, click Edit Group from the buttons in the group header.

2. Optionally, edit the group name and description.

3. Optionally, type a name or click the lookup icon to search the group members to assign a new Owner. Only the current owner or people with the “Modify All Data” permission can change the owner, and you must choose the owner from existing members. Customers can’t own groups.

4. Optionally, if your administrator has enabled archiving for groups, edit the automatic archiving settings for the group. Disable automatic archiving only if a group must remain active at all times, despite extended periods of inactivity.

5. Optionally, change the access level for the group. For example, you can convert an unlisted group to a public or private group if you want to open it up to a wider audience.

   Note: If you change a private group to public, updates and files are visible to all users, all pending requests to join the group are accepted, and anyone can join the group. Private groups with customers can’t be converted to other group types.

- **Public**: Anyone can see and add posts, comments, and files. Anyone can join a public group.
- **Private**: Only group members can see and add posts, comments, and files. People must ask to join or be added by the group’s owner or managers. Users with the “Modify All Data” and “View All Data” permission can see group posts, updates, and files across the organization. Users with the “Manage All Data” permission can also join private groups directly and change group settings.
- **Unlisted**: Only group members and users with the “Manage Unlisted Groups” permission can see and add posts, comments, and files. People cannot ask to join and must be invited by the group’s owner or managers. Unlisted groups offer more privacy and nonmembers cannot see or access unlisted groups in list views, feeds, and in search results. Unlisted groups aren’t available by default; your administrator must enable them for your organization.
- Optionally, select Allow Customers. The group owner and managers can invite customers to join a private or unlisted group. You can easily identify groups with customers by the orange upper left corner of the group photo.

   After you allow customers in a group, you can’t change the group access level.

6. Click Save.

   If you have the necessary permissions, you can also:

- Archive the group.
• Delete the group.

SEE ALSO:
   Add and Remove Chatter Group Members

Customize Groups

Use record types to create group types with the layout and branding you want, and use them to create custom groups.

Creating a group record type creates a Group Type that users can choose when they create Chatter groups.

1. From Setup, enter Groups in the Quick Find box, then select Record Type.
2. Click New.
3. Choose an existing record type as the basis for the new group type.
4. Choose a label and the name of the new record type. The label is what appears when users select a group type and the name is the unique API name.
5. Enter a description, which is visible to users.
6. Select Active to activate the record type.
7. Select Enable for Profile next to a profile to make the record type available to users with that profile. Select the checkbox in the header row to enable it for all profiles.
8. Click Next.
9. Choose a page layout option to determine what page layout displays for records with this record type.
10. Click Save.

Can I change a group’s access level, for example, to make a private group public?

If you’re a group owner or manager, you can change groups from private to public, or from public to private by editing the group settings. If you change a private group to public, updates and files are visible to all users, all pending requests to join the group are accepted, and anyone can join the group. Private groups with customers can’t be converted to other group types. You can’t change the group access level for private groups that allow customers.

SEE ALSO:
   What Your Chatter Group Role Allows You To Do
Add and Remove Chatter Group Members

Own or manage a Chatter group? Here’s how you add or remove group members.

1. In Salesforce Classic, on a group detail page, click Add/Remove Members. In Lightning Experience, click Add Member from the group highlights panel (your administrator must add this quick action to the group publisher).

2. Start typing the name of the user you want to add or remove to filter the list of users.

3. Click Add to add a member, or ✗ to remove a member. For people who have requested to join, click Accept to accept the request, or ✗ to decline.

4. Click Done when you’re finished.

SEE ALSO:
View Chatter Group Members

Accept or Decline Private Group Requests

As the owner or manager of a private Chatter group, you can accept or decline requests to join the group. Additionally, users with the “Modify All Data” permission can view and manage requests for all public and private groups, and users with “Manage Unlisted Groups” can manage group membership requests for all unlisted groups in the organization.

1. View the list of requests by doing one of the following:
   • On a group detail page, click the Request link, for example, 3 Requests
   • On a group detail page, click Add/Remove Members and then click the Requests filter, or scan for requests in the Everyone filter
   • Click the link provided in the email request

2. Accept or decline the requests.

   Note: An email is sent to each person to tell them that their request was accepted or declined.

   • Click Accept to accept. If there are more than two requests, you can accept them all by clicking Accept x of y, for example, Accept 3 of 3.
   • Click ✗ to decline. Optionally enter a message that will be included with your decline email and click Send. If you change your mind, you can click Cancel to go back.

3. Click Done to close the window.

If you make a private group public, any pending requests are automatically accepted.
# Group Roles

What Your Chatter Group Role Allows You To Do

This table describes the actions that can be performed by members, managers, and owners of public and private Chatter groups. Customers can be group members and managers, but not owners.

<table>
<thead>
<tr>
<th>Action</th>
<th>Owner</th>
<th>Manager</th>
<th>Member</th>
</tr>
</thead>
<tbody>
<tr>
<td>Post, comment, and search group feeds</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Add and remove records in groups (if configured)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Post group announcements</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Delete posts and comments</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Add and remove members</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Change member roles</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Edit group settings</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Edit the Information field</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Archive groups and activate archived groups</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Change group owner</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete group</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Users with the "Modify All Data" permission can perform all actions on all private and public groups, and users with the "View All Data" permission can view details of all private and public groups, regardless of membership.

Additionally, in unlisted groups:

- Users with the "Manage Unlisted Groups" permission can find and perform all of these actions in unlisted groups, even if they aren’t members.
- Users with the "Modify All Data" or "View All Data" permission can only find and access unlisted groups if they are members. Unlike public and private groups, users with the "Modify All Data" permission can’t perform group owner actions in unlisted groups. They can perform group manager actions if that role is assigned to them in the unlisted group.

SEE ALSO:

- What happens when the owner of a Chatter group is deactivated?
Change Chatter Group Roles

To change Chatter group roles for groups you own or manage:

1. Click Change Roles on a group detail page.
2. To search for members, start typing in the search box. Optionally sort the list by toggling between Managers and All Members.
3. Select the Manager checkbox for people you want to be managers. If a customer is selected as a manager, they will be able to see people who ask to join the group, even if they aren’t in other common groups, and will be able to approve requests.

Note: To change the group owner, you must own the group. Users with the “Modify All Data” permission can also change the owner in public and private groups, and users with the “Manage Unlisted Groups” permission can do this for unlisted groups. Click the Group Settings link next to the current owner to assign a new owner.

4. Click Done.

SEE ALSO:

What happens when the owner of a Chatter group is deactivated?

What happens when the owner of a Chatter group is deactivated?
The deactivated user still owns the group, but a user with the “Modify All Data” permission can assign a new owner for a public or private group. In the case of unlisted groups, a user with the “Manage Unlisted Groups” permission can assign a new owner.

SEE ALSO:

Change Chatter Group Roles

Archiving and Activating Chatter Groups

Archived Chatter Groups

When a Chatter group is archived, group members can no longer make posts or share files with the group. Previous posts, comments, and files remain available in the group for future reference.

Users can still comment on existing posts, mention people, and search the feed in archived groups. Users can also join and leave archived groups, create reports that include archived groups, and use global search to find archived groups and their content. Group owners and group managers can archive groups, activate them, and enable and disable automatic archiving at any time. Users with the “Modify All Data” permission can perform these actions on public and private groups in their organization. Users with the “Manage Unlisted Groups” permission can perform these actions on unlisted groups.

Archived groups allow users to focus on the active groups in your organization:

- Archived groups don’t count toward a user’s group membership limits.
- Posts from archived groups don’t display in Chatter feeds, unless someone adds a comment. Posts with new comments display in the All Company (Salesforce Classic) feed. They may display in the Company Highlights (Lightning Experience) feed, provided they rank highly due to their popularity or degree of engagement (such as their comments, likes, and views). Posts with new comments also display in the feed of each group member.
• File and feed sharing is limited to active groups only, making group searches more efficient.
• Archived groups display only in My Archived Groups and not in the Active Groups list.

**Example:** Archiving the group is useful for groups that have little or no feed activity, but contain useful information that you want to retain. Some examples include:

- A group that a sales team created while pursuing a deal. Though there probably won’t be much group activity after lead conversion, the sales team can still access important information about the customer.
- A group used for planning a company event. It can be archived after the event to reuse vendor information and planning discussions.
- A service desk type group used to track key issues for a major deployment for a customer. Archiving it after deployment issues are ironed out still gives support agents access to relevant information for future troubleshooting.
- When a new group replaces a legacy group with the same or broader purpose, the legacy group can be archived to redirect traffic to the new group.
- Team groups can be archived when a team changes or team members leave the company, while preserving team discussions for future reference.

Turning off automatic archiving is useful for groups that contain important information but aren’t updated on a regular basis, like a group used for company-wide announcements. Groups without activity for more than 90 days won’t get archived, and users won’t miss any important posts.

**Archive Chatter Groups**

Archive a group manually or edit automatic archiving settings.

Feed activity in groups is reviewed on a weekly basis. If a group has no new feed posts or comments for 90 consecutive days, the group is archived automatically. Mentioning a group doesn’t count as feed activity and doesn’t delay group archiving. Group owners, group managers, and users with the “Modify All Data” permission can manually archive or edit automatic archiving settings for groups at any time.

1. Click **Group Settings** on the group detail page in the Salesforce Classic. In the Lightning Experience, click **Edit Group** from the buttons in the group header.

2. Configure archiving for the group in one of two ways:
   - Click **Archive** to archive the group right away.
   - Select **Archive this group if there are no posts or comments for 90 days** and click **Save** to set up automatic archiving.

After you archive a group:

- The publisher on the group page is hidden and members can’t create new posts or share files in the group.
- The group no longer appears in the Active Groups filter on the Groups tab.
- Previous group posts and comments no longer appear in the Chatter feed, unless someone adds a comment. Posts with new comments display in the All Company feed (Salesforce Classic) and the feed of each group member. They may appear in the Company Highlights feed (Lightning Experience), depending on the post’s popularity ranking and engagement (such as likes, comments, and views).

Use the **My Archived Groups** filter in the Groups list to find the archived groups that you own, manage, or belong to. You can also use global search to find archived groups or associated content. Note that archived groups don’t count toward your group membership limit.
Note:

- Group members don’t receive email notifications when a Chatter group they own, manage, or belong to is archived or activated.
- If your administrator disables archiving for groups, you can’t archive groups or edit automatic archiving settings. You can activate archived groups at any time, even if the feature is disabled.

SEE ALSO:

- Archived Chatter Groups
- Activate Archived Chatter Groups

Activate Archived Chatter Groups

Group owners, group managers, and users with the “Modify All Data” permission can activate an archived Chatter group from the group detail page.

1. Navigate to the group you want to activate.
   - Use the My Archived Groups filter on the Groups list view to find the archived groups you own, manage, or belong to.
   - To find other archived groups, use global search, run a report, or ask your administrator for help.

2. Click Activate on the group detail page. You can also activate an archived group from the group settings page.

After a group is activated, the group detail page displays with the publisher enabled so members can create new posts and share files with the group.

Note:

- Group members don’t receive email notifications when a Chatter group they own, manage, or belong to is archived or activated.
- You can only activate one group at a time. To activate multiple groups at once, use the Salesforce API.

SEE ALSO:

- Archived Chatter Groups
- Archive Chatter Groups

Delete Chatter Groups

Only the group owner and users with the “Modify All Data” permission can delete a group.

In Lightning Experience, you can delete the group by clicking Delete Group from the buttons in the group highlights panel.

In Salesforce Classic:

1. Edit the group settings. Click Group Settings on a group detail page.
2. Click Delete.
3. Click OK.

Deleting a group permanently deletes the updates of the group, including any links posted to the group. When you delete a group that includes files, you’re not deleting the files, just the references...
to the files. The files remain in their original location, such as in each file owner’s Owned by Me. If the files were posted to the group and not shared in other locations, deleting the group also removes the references to the files. The files remain in the file owner’s Owned by Me, where they’re private but can be shared again later.

⚠️ Tip: To retain group data for future reference, archive groups instead of deleting them.

SEE ALSO:
- Archive Chatter Groups
- View Where a File is Shared

Working in Chatter Groups

Get Familiar with Your Chatter Group
Click a group’s name in a feed, in the Groups list, or on someone’s profile to see the group’s updates, files, and group members.

How much detail you see and what you can do on a group’s page depends on the type of group, whether you’re a member, owner or manager of the group, and on your group role.

Non-Members of Public Groups
If you’re viewing the group detail page of a public group you’re not a member of, you can

- Post and comment
  Type an update above the feed or comment below a post in the feed and click Share.

- Join the group
  Click Join to join the group.

- View group description and information
  The group description and information display in a separate column next to the feed.

- View the group’s members
  The Group Members section shows the group’s current members, including any customers invited to the group.

- View, download, and search files posted to the group
  Files posted to the group feed or shared with the group appear in the Group Files section.

- View the topics the group is talking about
  The group’s topics display below posts in the group feed.

- Search for group information
  Click above the feed to search for information in the group.

Non-Members of Private Groups
If you’re viewing the group detail page of a private group you’re not a member of, you can only

- Ask to join the group
  Click Ask to Join to send an email to the owner and managers of a private group requesting to join.

- View the group’s picture and description
  The group description displays below the group photo.
View the group’s members

The Group Members section shows the group’s current members, including any customers invited to the group.

Nonmembers of Unlisted Groups

If you’re not a member of an unlisted group, you can’t view the group detail page.

Group Members of Public, Private, and Unlisted Groups

When you’re a member of a public, private, or unlisted group, you can also

Change Email Settings and In-App Notifications for Salesforce1 Mobile Apps

In Salesforce Classic, click Email Me... to be emailed about activity in the group, either every time someone posts, daily, or weekly. Selecting Every Post also turns on in-app notifications for groups in the Salesforce1 mobile apps. To stop receiving email and mobile notifications for the group’s activity, click Turn Off Group Email. Click Email Settings to modify all your Chatter email settings.

In Lightning Experience, click Email Notifications from the group highlights panel to modify your group email settings.

 Invite People

If your administrator has enabled invitations, click Invite People to invite people not using Chatter to join the group. For private groups, only the group manager, group owner, or users with the “Modify All Data” permission can invite people. For unlisted groups, only the group manager, group owner, or users with the “Manage Unlisted Groups” permission can invite people.

Leave the group

Click X, or to withdraw a request to join a private group. To leave a group you own, you must first assign a new owner.

Group Owners and Group Managers

When you’re the owner or manager of a public, private, or unlisted group, you can also

Add or remove group members

Change the group photo

Edit group settings

Edit the Information section

Click Add Information or in the Information section to add additional information for the group’s members. You can customize this section, including its title, to say anything you want.

Edit the Description section

Click Add Description or in the Description section to add a description of the group.

Change member roles

Accept or decline requests for private groups

SEE ALSO:

Group Files Lists
**View Chatter Group Memberships**

The Groups list on your profile shows you the Chatter groups you belong to, sorted by the most recent activity date. You can join or create groups on the groups tab. You can also view the Groups list on other people’s profiles to see their group memberships.

Note: On other people’s profiles, you can see unlisted group memberships only if you’re also a member.

- To view the full list in alphabetical order, click Show All.
- To see more of the list, use the Next and Previous links.
- To leave a group or withdraw a request to join, click 
- To join a public group on another person’s groups list, click Join.
- To send a request to join a private group on another person’s groups list, click Ask to Join.
- To close the window, click Done.

**SEE ALSO:**

What Your Chatter Group Role Allows You To Do

**View Chatter Group Members**

The Members section on a Chatter group page shows all of the members of a group, including customers.

1. Click Show All in the Members section to view the full group member list in alphabetical order.
   In the Members window, you can:
   - Filter the list to see all members, managers, or the owner
   - Use the Next and Previous links to see more of the list
   - Search using the Find Members search box
   - Click Follow or next to a person’s name to start or stop following them.
     You can’t follow customers.

2. Click Done to close the window.

**Chatter Group Recommendations**

Chatter recommends groups that you might want to join based on:

- The popularity of the group determined by the number of members.
- The number of people you’re following in the group. Chatter recommends groups with the most members you’re following.
- If the group is new (created in the last month).

To see an expanded list of your recommendations, click More in the Recommendations section. If no recommendations appear, then you already belong to all the recommended groups. Hover over the recommendations and click to dismiss them, and they won’t appear again.
Use Email to Post to Chatter Groups

Email your posts to Chatter groups you have access to.

If your admin has enabled this feature, you can email your posts to any public group. Additionally, your admin can allow you to include attachments. You can email posts to a private or unlisted group only if you're a member. You must use the email address associated with your Salesforce user account.

1. In Salesforce Classic, from the group detail page, click Post by email below the group description to launch a blank email to the group using your local email client.

2. Type your message in the email body, including attachments if needed, and send the email. Attachments to the email are added as files in Chatter and shared with the group.

The email content displays as a post on the group detail page. Any hashtags you include in the email body (for example, #TeamExcellence) are converted to topics on the post. If more than one attachment is included with the email, the first attachment is included as part of the post. Additional attachments are added in comments.

Tip: Save the group's email address as a contact in your mail client or mobile device for easy access in the future. If you copy and paste the mailto: link directly into the contact's email field, some mail clients may consider the link invalid and prevent you from sending email to the contact. Try removing the parenthetical group name from the first part of the email address. For example, remove (My Group) from (My Group)0f9b000000004cmkaq@post.k-pxymac.kp0.chatter.salesforce.com.

The following limitations apply to posting to a group using email:

- The 10,000 character limit for Chatter posts applies to posts created using email. Any text in your email beyond this limit is not included in the post.
- The maximum message size is 25 MB, including text and attachments.
- The email subject is not included in the post.
- You can create text posts using email and include links in the text. You can also include up to 25 attachments. You can't mention people, create polls, or give titles to links when posting to the group by email.
- Character-level formatting, such as the use of bold or different type sizes, is not supported.
- Email addresses must be unique at the group level. If multiple user profiles in your organization use the same email address, and that email address is used to post to a group, then the user profile associated with that particular group is used for the post in the group feed. If the email address is shared between multiple user profiles in the same group, the email is blocked.
- Signature text is treated as part of your post. Default signatures inserted by mobile devices, such as Sent from my iPhone, are automatically removed. Before sending your email, delete custom signatures and any extra text you don't want posted to Chatter. Or, add a separator line to the top of your signature to have it automatically removed. The separator line must have a minimum of one of the following characters:
  - Dash (-)
  - Equal sign (=)
  - Underscore (_)

You can also use any combination of these characters or dash dash space (--) , which respects RFC 3676 4.3.
Post Announcements in Chatter Groups

Post group announcements to highlight important messages on the group page.

**Note:** Groups display the global publisher layout by default. If the Announcement action doesn’t appear in groups, ask your administrator to override the global publisher and add the Announcement action to a custom group publisher layout.

Only group owners, group managers, and users with the “Modify All Data” permission can post and delete group announcements.

1. On the group page, click **Announcement** in the publisher.
2. Type your message. The character limit is 5,000, and you can include links or mention users and groups in your announcement. Due to space constraints, approximately 137 characters of the announcement displays on the group page. Click **More** to see the rest of the message.
3. Specify an expiration date for the announcement.
4. Click **Share**.

Group announcements display until 11:59 p.m. on the selected expiration date, unless they’re replaced by a new group announcement. Users can discuss, like, and post comments on announcements in the group feed. Group members receive an email notification when you post an announcement, same as for other posts, depending on their selected group email notification frequency.

Deleting the feed post deletes the announcement. To remove the announcement from the group page without deleting the feed post, click 🗑 in the top corner of the announcement, then select the option to dismiss the banner.

**Send Email Notifications for Announcements**

Group owners and managers can now send email notifications to all group members for group announcements. Previously, only group members who opted to be notified for each post in the group were notified. Group owners and managers require the “Send announcement emails” permission to do this. If this feature is enabled, select **Email all group members** next to the announcement expiration date to notify all group members.

**Group Files Lists**

The Group Files list on a Chatter group page shows the recent files posted to that group.

Hover to see available options or click the file name to go to the file detail page. To see a list of all the files posted to a group, to search for a specific file, or to perform actions on a file, expand the files list **Show All**. The 25 most recently viewed files are listed by default. On this list you can:

- Search for files that have been posted to the group. The list includes files that you and other people have attached to the Chatter feed on the group. The list doesn’t include:
  - Documents from the Documents tab.
  - Attachments from the Notes and Attachments related list.
- Upload private files or upload and share files with people, groups, or via a file link.
- Preview a file without downloading it.
- Follow and receive updates about a file in the Chatter feed. Click ✉️ next to the file you’re following to stop receiving updates about the file. (Requires Chatter.)
- Click ☐️ to download, upload a new version, share with people, groups, or via link, and see sharing settings.
- To view the file detail page, click a file name.
- To see a file owner’s profile, click their name.
Note:

- Not all files can be previewed, such as encrypted files, password-protected files, copy-protected PDFs, unknown file types, and any file larger than 25 MB. For files that can’t be previewed, the Preview option isn’t available on feeds or list views, and files appear as generic file type icons in the feed. Some Microsoft Office 2007 features don’t display correctly in previews. If a file can be previewed, but a preview doesn’t exist, contact your Salesforce administrator who may be able to regenerate the preview.
- Files without a file extension or with an unrecognized file extension show "unknown" in the Type column.

SEE ALSO:
View Chatter Group Members

Records in Chatter Groups

Create Records in Chatter Groups

Use the group publisher to create records in Chatter groups.

The actions available to you in the group publisher depend on your permissions, your role in the group, the type of group, and how your administrator has configured the group publisher.

- Depending on how your administrator configures the groups publisher layout, you can create account, contact, lead, opportunity, contract, campaign, case, and custom object records. Other objects aren’t supported.
- When you create a record in a group, a record creation post displays several places, including in the group feed, on your profile, in the record feed, and in your company’s Chatter feed. Only users with the necessary permissions (via license, profile, permissions, and sharing rules) can view the record and the record creation feed post.

Tip: Filter the group feed to Show All Updates to view record creation posts.

- All comments on the record creation post display in the group feed. This includes comments made on the post in the record feed, and those made by users who don’t belong to the group. For example, John creates a record in a private group and the record creation post displays in the group feed and in the record feed. Sally isn’t a member of the same private group, but she has access to the record detail page and the record feed. Sally comments on the record creation post in the record feed, and it appears in the private group’s feed.

- Record visibility in groups respects user permissions and sharing access rules in your organization. Group members with permissions can view the record and comment on it from any context (in a group, on the owner’s profile, on the record detail page, in the company’s Chatter feed).

Group members without permissions, such as Chatter Free users, can’t see the record or the record feed in the group or anywhere else.

- You can’t create records in groups that allow customers.
- If your administrator has enabled the ability to add records to groups, as well:
  - Creating a new record within a group automatically creates a group-to-record relationship, same as when you add an existing record.
  - The group records list displays the records you create, in addition to the records you add.
**Add Existing Records to Chatter Groups**

Add records to groups so you can collaborate on and discuss the records as a team.

1. From the group publisher, click **Add Record**.
   
   **Note:** If you don’t see this option, your administrator needs to include the Add Record action to the group publisher. Groups that allow customers don’t allow you to add records.

2. Select the type of record from the **Record** list.
   
   You can add account, contact, lead, opportunity, contract, campaign, case, and custom object records. Other objects aren’t supported.

3. In the blank search field, type the name of the record you want to search for and click . Leave the field blank to search for all available records of the selected type.

4. From the lookup search results list, click the record you want to add to the group to select it.

5. Click **Create**.

A success message confirms when the record is added to the group and the record appears in the Group Records list. If your administrator has added the Groups related list to the record detail page, you can also see the list of groups the record is associated with on the record detail page. There is no limit to the number of records you can add to a group.

**Note:** Adding a record to a group doesn’t affect its visibility. Only users with the necessary permissions (via license, profile, permission sets, or sharing) can see the records in a group. For example, Chatter Free users don’t see any records in groups. Or, a user with permissions to view accounts and contacts can’t view any case records in the group. This sometimes means that users see fewer records than the actual count indicated on the group records list.

**Example:** Here are some ways to use Chatter groups as a collaboration space for records that you’re working on.

- A sales team working together on an account can track the related opportunities, contacts, and leads in one group. Team members with permissions can access records directly from the group. New team members can use the group as a one-stop reference to familiarize themselves with historical discussions about the account and its child records.

- Customer service teams can use groups to track the cases they handle. The group can become the team’s forum to monitor cases, discuss solutions, and analyze trends in common problem areas.

- Marketing teams can use groups to track their campaigns, plan events, and discuss the potential leads and contacts to invite for the event. Groups also make for a great space to collaborate on marketing content or campaign artifacts.
Remove Records from Chatter Groups

Remove records you no longer use from your Chatter groups.

Anyone with access to the record in a group can remove it from the group.

1. On the group detail page, click **Show All** next to the Group Records list.
   - **Note:** The group records list appears on the group detail page only if your administrator allows you to add existing records to groups.

2. Optionally, select an option from the **Filter By** list to view records of that type.

3. Find the record you want to remove, then click **Remove** next to the record’s name.

Removing a record from a group deletes the group-record relationship, but not the record itself. You can restore the group-record relationship from the Recycle Bin.

Chatter Messenger (Chat)

Chat instantly and securely with coworkers. Chatter Messenger is not available in new orgs created after the Spring ’16 release.

IN THIS SECTION:

- **Using Chatter Messenger**
  Click the Chat header to expand or minimize chat. To get the most out of your chat experience, click ![chat](image) in the chat list to pop it out to a separate browser window. Then, you can easily chat with people while you browse other sites and use other applications.

- **Using the Chat List**
  Tips for using the chat list.

- **Adding People to the My Favorites List in Chat**
  The list of people you follow in Chatter can be long. Add up to 100 chats with one or more people to your My Favorites list and they’ll always show up at the top of your chat list.

- **Removing People from the My Favorites List in Chat**
  Remove chats with one or multiple people from your My Favorites list if you chat with them less often. People you follow in Chatter will still show up in your People I Follow list.

- **Changing Your Chat Status**
  Let people know if you’re available to chat, or set your status to **Offline** if you don’t want to chat.

- **Chatting with People**
  Chat with one or more people in Chatter.

- **Chat History**
  View your chat history.

- **Adding Emoticons to a Chat**
  Typing certain combinations of letters and punctuation marks inserts a whimsical icon into your chat conversation.
Popping Out Chat Windows
Keep chatting—even when you minimize your browser or use other applications—by popping out a chat or your chat list into a separate browser window.

Editing Chat Options
Can I change the sounds I hear in chat?

Using Chatter Messenger
Click the Chat header to expand or minimize chat. To get the most out of your chat experience, click in the chat list to pop it out to a separate browser window. Then, you can easily chat with people while you browse other sites and use other applications.

A few considerations apply to using Chatter Messenger:

- Chatter Messenger is not available in new orgs created after the Spring ’16 release.
- Your administrator can disable Chatter Messenger at the organization level. In addition, you can access Chatter Messenger only if your administrator has selected “API enabled” in your profile permissions. If you don’t see Chatter Messenger when you log in to Salesforce, ask your administrator if they have disabled the feature and granted the necessary permissions to access Chatter Messenger.
- Chatter Messenger is not available with Communities. It is available for internal users only when the organization-wide default for the user object is set to Public Read Only.
- Chatter Messenger is not supported on Microsoft® Internet Explorer® version 7.0. Internet Explorer 7 users appear offline to other Chatter Messenger users.

With chat, you can:

- Let people know if you’re available to chat.
- Chat with people.
- Add people to and remove people from your My Favorites list.
- Pop out your chat to a separate browser window.
- Use emoticons when you chat with people.
- Customize your chat options, such as sounds and notifications.
- View your chat history.

SEE ALSO:
Chatter Messages
Using the Chat List

Tips for using the chat list.

- **Note:** Chatter Messenger is not available in new orgs created after the Spring '16 release.
- Use the search box at the top of your chat list to quickly find and chat with any online Chatter user, including the people you don’t follow.
- Switch between active chats by clicking a chat in the Current Chats list.
- To add someone to your chat list, follow them in Chatter.
- Add people you chat with frequently to your My Favorites list.
- Click ☰ to customize your chat options.
- Click your status at the top of the chat list to change your chat status.
- When a chat is minimized, you’ll see the new message indicator 🔄 for new messages.

**SEE ALSO:**
Changing Your Chat Status

Adding People to the My Favorites List in Chat

The list of people you follow in Chatter can be long. Add up to 100 chats with one or more people to your My Favorites list and they’ll always show up at the top of your chat list.

- **Note:** Chatter Messenger is not available in new orgs created after the Spring '16 release.
- In an active chat with one or more people, click ☰ to save the chat as a favorite.
- You can also click and drag a single person’s name from the People I Follow list to the My Favorites list.
- You can rename a chat with multiple people in your My Favorites list. Click Edit next to My Favorites, click the multiple-person chat you want to rename, and type a new name. For example, if you have a favorite chat with Sue, John, Jeff, you could rename it to Sales Team. All names must be unique.

**SEE ALSO:**
Using the Chat List

Removing People from the My Favorites List in Chat

Remove chats with one or multiple people from your My Favorites list if you chat with them less often. People you follow in Chatter will still show up in your People I Follow list.

- **Note:** Chatter Messenger is not available in new orgs created after the Spring ’16 release.
- Next to the My Favorites list, click Edit.
- Next to the name of the chat you want to remove, click the ✗ button.
- When you’ve finished deleting chats from the list, click Done next to the My Favorites list.

**SEE ALSO:**
Using the Chat List
You can also remove chats from the My Favorites list by clicking the icon in an active chat.

SEE ALSO:

Adding People to the My Favorites List in Chat

Changing Your Chat Status

Let people know if you’re available to chat, or set your status to Offline if you don’t want to chat.

People can see your status:

- In their chat lists
- On your profile
- On people hovers

To change your chat status, click Available, Away, or Offline at the top of your chat list. For example, if your status is set to Available but you don’t want to chat with others, click Available and choose Offline.

Your status automatically changes to idle if you’re idle for 15 minutes. To change this setting, click Chat > Options, then select General Settings.

Note: Administrators enable or disable Chat for an organization. Chatter Messenger is not available in new orgs created after the Spring ’16 release.

SEE ALSO:

Editing Chat Options

Chatting with People

Chat with one or more people in Chatter.

Note: Chatter Messenger is not available in new orgs created after the Spring ’16 release.

1. Start a chat with any online Chatter user.
   - Use the search box at the top of Chatter Messenger to find and start a chat with anyone in your organization. Alternatively, click a name in the People I Follow or My Favorites list.
   - From a person’s profile, click Start Chat.
   - From any feed, hover over a person’s name and click Start Chat.

2. Optionally, add up to 10 people to the chat.
   a. Drag people from your chat list to the active chat, or click at the top of the active chat to search for and add any online user in Chatter.
   b. Repeat until you’ve added everyone you need for the chat.

Click to see a list of everyone in the chat.
**Chat History**

View your chat history.

**Note:** Chatter Messenger is not available in new orgs created after the Spring ’16 release.

When you start a chat with someone, your conversations with them from the last 72 hours are automatically shown. Conversations older than 72 hours are deleted and can’t be retrieved. To see a list of all conversations from the last 72 hours:

1. Click the Chat header to expand the chat window.
2. Click 🔄.
3. Click someone’s name to see your chat history with them.

**SEE ALSO:**
- Using Chatter Messenger

---

**Adding Emoticons to a Chat**

Typing certain combinations of letters and punctuation marks inserts a whimsical icon into your chat conversation.

**Note:** Chatter Messenger is not available in new orgs created after the Spring ’16 release.

The following emoticons are available.

<table>
<thead>
<tr>
<th>Emoticon</th>
<th>Typed Characters</th>
</tr>
</thead>
<tbody>
<tr>
<td>😊</td>
<td>:-), :), :, =)</td>
</tr>
<tr>
<td>😞</td>
<td>:- (, :- (, :- (, = (</td>
</tr>
<tr>
<td>😊</td>
<td>:-D, :-D, =D</td>
</tr>
<tr>
<td>😊</td>
<td>:-O, :-O, :-O, :o</td>
</tr>
<tr>
<td>😊</td>
<td>:-P, :-P, :-P, =P</td>
</tr>
<tr>
<td>😊</td>
<td>;-), ;-)</td>
</tr>
</tbody>
</table>

You can turn off emoticons in Chat > 😊 > Options.

**SEE ALSO:**
- Editing Chat Options
Popping Out Chat Windows

Keep chatting—even when you minimize your browser or use other applications—by popping out a chat or your chat list into a separate browser window.

Note: Chatter Messenger is not available in new orgs created after the Spring ’16 release.

- Click in the top-right corner of an active chat or the entire chat list to pop it out.
- Click in the top-right corner of a popped-out chat or chat list to pop it back in to your Salesforce screen.

SEE ALSO:
- Editing Chat Options

Editing Chat Options

Note: Chatter Messenger is not available in new orgs created after the Spring ’16 release.

To edit your chat options, click in the top-right corner of the chat window, then click Options.

Tip: When you click , you can also quickly toggle the visibility of My Favorites, People I Follow, and Offline People in your chat list. You can also toggle the options to Play sounds and Show emoticons.

### General Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change status to Idle after 15 minutes</td>
<td>When selected, your status changes to “idle” if you are idle in your Salesforce app for the length of time you specify.</td>
</tr>
<tr>
<td>Show emoticons</td>
<td>When selected, graphics such as 😄 or 😞 display when people you chat with type standard textual emoticons such as :-( or :-(.</td>
</tr>
<tr>
<td>Show a timestamp only when I hover over a message</td>
<td>When selected, the timestamp for chat messages displays only when you hover over an individual message. When not selected, the timestamp displays inline with each chat message and status change.</td>
</tr>
</tbody>
</table>

### Sounds and Notifications

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play a sound for new messages</td>
<td>When selected, a sound plays when someone starts a new chat with you.</td>
</tr>
<tr>
<td>Note:</td>
<td>Sounds play for all incoming messages when a chat is minimized, a chat is out of focus (for example, if you have multiple chats), or when you’re using another application or browser tab.</td>
</tr>
<tr>
<td>Alert in browser tab for new messages</td>
<td>When selected, a notification saying “You have new chat messages” displays in your browser tab when someone sends you a new chat message.</td>
</tr>
</tbody>
</table>
Chat List
Select the lists of people that you want to see in your chat list:

- My Favorites
- People I Follow
- Show people who are offline

SEE ALSO:
Adding Emoticons to a Chat
Changing Your Chat Status

Can I change the sounds I hear in chat?
To change your sound and notification settings, go to Chat > Options and select Sounds and Notifications.

SEE ALSO:
Editing Chat Options

Private Messages
Use Chatter messages for secure private conversations with other Chatter users.

IN THIS SECTION:
Chatter Messages
Send your a question to another person privately, or to communicate with a few select people when a discussion isn’t relevant to everyone you work with. Messages also notify people when a file has been shared with them.
Searching for Chatter Messages
Sending Chatter Messages
Send messages to communicate privately in Chatter.

Chatter Messages
Send your a question to another person privately, or to communicate with a few select people when a discussion isn’t relevant to everyone you work with. Messages also notify people when a file has been shared with them.

Messages don’t appear in your feed, your profile, global search results, or any other part of Chatter that’s publicly visible.

View your messages by clicking the Messages link in the Chatter tab. On the My Messages page, you can:

- See the most recent message in each of your conversations. The most recent message displays at the top of the list.
- See the photo of the person who sent the most recent message in a conversation.
- See if you have unread messages ( ).
- See if you sent the most recent reply ( ) in a conversation.
Click any message to view the full history of messages exchanged in that conversation.

Send a message by clicking **New Message**.

Your messages are organized into conversations, with each conversation defined by the unique combination of people participating in it. For example, let's say you send a message to Sally Smith. When Sally replies, her message continues your one-on-one conversation. Every new message you send to Sally—even if it's about a different topic—also continues the same conversation. Over time, you build a rich conversation history with Sally that contains every message you've ever exchanged with her. At the same time, let's say you send a message to both Sally Smith and Bob Johnson. That message is considered part of a separate conversation between you, Sally, and Bob. When Sally replies, her message continues a separate conversation from your one-on-one conversation with Sally.

Consider these tips for using Chatter messages:

- You can send messages to anyone in your Chatter organization. It doesn't matter who you follow, who's following you, what groups you belong to, or if the recipient is a customer.
- Conversations can involve just one other person, or up to 10 people total, including yourself. You can't send a message to yourself.
- Conversation participants are established when someone sends the first message in the conversation. No one can add people or remove people from the conversation after the first message is sent.
- As others reply, the **Messages** link on the Chatter tab shows the number of conversations with new messages. If you're already receiving Chatter email notifications, you'll automatically be notified of new messages.
- You can't delete messages or conversations.
- If after reading the messages in a conversation you want to mark the conversation unread, you can do so only via the Chatter REST API, not via the user interface.

### Searching for Chatter Messages

To search for people and text in your Chatter messages:

1. In My Messages, enter your search terms in the search box above your messages. Keep in mind these simple search tips:
   - If you're viewing your list of conversations, search looks for matches across all conversations. If you're viewing a single conversation, search looks for matches only within that conversation.
   - Searching for a person's name (such as **bob johnson**) finds both the conversations where Bob Johnson is named in the text as well as conversations where he's a participant. If you search for your own name, search results will include all of your messages and conversations because you're a participant in every conversation.
   - Searching for **bob jo** finds both Bob Jones and Bob Johnson. We automatically search for terms starting with **bob jo**, as if you had entered the * (asterisk) wildcard (**bob jo*).
   - If you search for the term **customer**, you'll see matches on that term within the text of messages. Matches don't include people who are identified as customers in a conversation's participant list.

2. Click **Search**.

3. Once you see the search results, you can:
   - Refine your search by entering additional search terms or using wildcards or operators.
   - Click a message to view the full conversation if you initially searched across all conversations.

If there are matches on names in the participant list and the conversation involves lots of people, the match might not be visible because the participant list doesn't show everyone's name. In other words, you'll see the conversation included as a match but the highlighted name match might be hidden from view.
Clear your search terms by clicking 📷. Chatter automatically clears your search when you enter a reply, send a new message, or leave My Messages.

SEE ALSO:

Share Files with People in Salesforce Classic

Sending Chatter Messages

Send messages to communicate privately in Chatter.

To send a Chatter message:

1. Start the message from one of these locations:
   - Click the Messages link on the Chatter tab, then click New Message in My Messages.
   - Click a person’s name anywhere in Chatter to view their profile and click Send a message.
   - Click Send a message on a person’s hover.
   - When viewing the full message history of a conversation, use the text box under the most recent message to send a reply.
   - When viewing the email notification about a message you’ve received, if email replies to Chatter are enabled, reply to the email.

Sharing a file with people is another way to send a Chatter message. When you share a file, recipients automatically receive a message that lets them know the file has been shared, as well as any additional information you provided.

2. If you started in the Send a Message dialog box, you can add people’s names to the recipient list. Type a name in the To field and click the name to select it. Add more people to the conversation by entering additional names.
   - If you’re replying within a conversation or via email, the conversation participants can’t be changed.

3. Write your message. Messages can be up to 10,000 characters.

4. Submit your message using the appropriate method:
   - In the Send a Message dialog box, click Send.
   - If you’re replying within a conversation, click Reply (or Reply All if the conversation involves multiple recipients).
   - If you’re replying via email, use the Send option in your email application.

If your message continues an existing conversation, your reply is added to the conversation and appears at the top of the list in My Messages. If your message starts a new conversation because you haven’t previously exchanged messages with that unique combination of recipients, your message appears at the top of the list in My Messages as a brand new conversation.

SEE ALSO:

Replying to Chatter Email Notifications

Chatter Questions

Got questions? Use Chatter Questions to post a question in your Chatter feed, then watch the solutions roll in.
IN THIS SECTION:

Chatter Questions
Extend the best possible self-service community by promoting community engagement internally and externally with questions in Chatter.

Display Similar Questions and Articles in Chatter
When users ask questions, Chatter Questions helps reduce duplicate content in Salesforce—and in any communities with Chatter—by showing similar questions and relevant Salesforce Knowledge articles when the user is typing the question.

Display Similar Questions and Articles in the Customer Service (Napili) Template Search
Your community users may ask similar questions. Chatter Questions helps reduce duplicate content in self-service communities built on the Customer Service (Napili) template by showing similar questions and relevant Salesforce Knowledge articles when a user is entering a question in the Search field.

Enable Similar Articles for Chatter Questions
When users ask questions in Chatter, similar questions appear as they type. If you’d like relevant Salesforce Knowledge articles to appear as well as questions, enable Similar Articles.

Selecting a Best Answer for a Question in Chatter
One of the advantages of asking a question in Chatter is that users can select the best answer for a question. When a question has a best answer, your users can quickly resolve their issue by going directly to the best answer.

Chatter Questions FAQ
Chatter Questions lets users in communities and Salesforce ask questions in the feed. Take a look at some common questions about the feature.

Track Chatter Questions Use in Your Salesforce Organization and Communities
Keep tabs on the use and adoption of Chatter Questions in your organization or community with out-of-the-box reports and dashboards.

Differences Between Q&A Features in Salesforce
Salesforce offers a variety of question-and-answer features that you can implement in your Salesforce organization and communities. Because some of these features use similar terminology, take a moment to review the differences between them.

Question-to-Case Overview
Question-to-Case lets moderators create cases from questions in Chatter, which makes it easier to track and resolve your customers’ issues. Question-to-Case is available in the full Salesforce site and the Salesforce1 mobile browser app, as well as in communities where Chatter Questions is enabled.

Set Up Question-to-Case
Add Question-to-Case to your communities, your Salesforce organization, or both.

Enable Question-to-Case
Question-to-Case lets moderators create cases from questions in Chatter to ensure that your customers’ questions are quickly resolved. Enable Question-to-Case in your communities, Salesforce organization, or both.

Add the Question from Chatter Field to the Case Detail View
When a case is created from a question in Chatter, the Question from Chatter field on case detail pages displays a link to the original question. This field helps agents quickly navigate to the feed.

Add the Escalate to Case Action to the Feed Item Layout
Give moderators the ability to create cases from questions by adding the Escalate to Case action to Chatter Questions pages. This action is created automatically when Question-to-Case is enabled in your organization.
Confirm Access to the Escalate to Case Action
Does your Salesforce org use more than one record type for cases? Make sure that the profiles that need Question-to-Case have access to the record type associated with the Escalate to Case action. If your org has only one record type for cases, skip this process.

Customize the Escalate to Case Action Layout
Choose which fields appear on the Escalate to Case action, and in what order, based on the information you need to track for each case.

Automatically Assign Cases from Questions to a Queue
Case assignment rules aren’t supported in Question-to-Case, so by default, cases created from questions are assigned to the moderator who escalates the question. You can write a workflow rule or process that automatically adds cases that were created from questions to a queue so agents can claim them.

Automatically Create Cases from Unresolved Questions in Chatter
As your community or organization develops, ensure that users get speedy answers to their questions. Question-to-Case lets moderators escalate unresolved questions to cases in the feed, but you can make your case resolution process even more efficient by setting up processes—similar to workflow rules—in the Lightning Process Builder. Set up a process that automatically creates a case from questions that meet specified criteria.

Create a Case from a Question in Chatter
If a question in Chatter hasn’t been resolved, moderators can create a case from the question. Question-to-Case must be enabled in your organization or community.

Chatter Questions
Extend the best possible self-service community by promoting community engagement internally and externally with questions in Chatter.

With Chatter Questions, users can ask questions in their Chatter feed, in groups, and in records by selecting Question in the action drop-down menu of the Chatter Publisher. After a question is asked, moderators and the person who asked the question can select a best answer. The best answer is prominently displayed in the feed, allowing other users to quickly and easily find the information they need.

Your users can organize their information with the question title and details about their question. They can ask the question to their followers, to a group, or to a specific person, as they can with other Chatter feed items.
To enable Chatter Questions in your organization, add the Question action to the global publisher layout. If your organization was created after Summer '14, the Question action is automatically added, but we recommend dragging it to the far left to increase its visibility. If you’re using a customized publisher layout in groups or on records, make sure that the Question action is added to those layouts as well.

Chatter Desktop doesn’t support Chatter Questions.

SEE ALSO:
- Selecting a Best Answer for a Question in Chatter
- Track Chatter Questions Use in Your Salesforce Organization and Communities
- Chatter Questions FAQ

Display Similar Questions and Articles in Chatter

When users ask questions, Chatter Questions helps reduce duplicate content in Salesforce—and in any communities with Chatter—by showing similar questions and relevant Salesforce Knowledge articles when the user is typing the question.

Note:
- Communities with Chatter include those built with Salesforce Tabs + Visualforce.
- The Similar Questions and Similar Articles search features are also available in communities built on the Customer Service (Napili) template. For more information, see Display Similar Questions and Articles in the Customer Service (Napili) Template Search.
- Similar Questions and Similar Articles aren’t available in Salesforce1 or mobile browsers.

When a user enters a question in Chatter, similar questions automatically appear in a drop-down list below the question title field. To display relevant Knowledge articles along with similar questions, enable Similar Articles.

Drop-down search results of similar questions and articles:
1: Book and question mark icons indicate whether a search result is an article or a question.
2: Question results show the question title, the number of answers, and a green flag with the text Answered if a best answer was selected.

Users see up to 10 results in the drop-down list, with questions appearing before articles. Salesforce displays an equal number of questions and articles, but if there aren’t enough of one result type, extra results of the other type are displayed. If no question or article title matches the text entered by the user, the drop-down list doesn’t appear.

The drop-down results are based on whether the question or article title contains the text entered by the user. The search accounts for partially matching terms and non-adjacent terms. For example, the results for “best backpack” could include a question titled “Which backpack is best for day hikes?”, and the results for “backpack” could include an article titled “Backpacking Tips.”

If the user wants to conduct a more in-depth search that also scans question descriptions and article text, they can press TAB or click out of the title field. This displays a separate drop-down list of results below the question publisher.

**Advanced drop-down search results of similar questions and articles:**

If none of the results answer the user’s question, they can post their question by clicking Ask.

**SEE ALSO:**
Track Chatter Questions Use in Your Salesforce Organization and Communities
Display Similar Questions and Articles in the Customer Service (Napili) Template Search

Your community users may ask similar questions. Chatter Questions helps reduce duplicate content in self-service communities built on the Customer Service (Napili) template by showing similar questions and relevant Salesforce Knowledge articles when a user is entering a question in the Search field.

Note: Similar Questions and Similar Articles are also available in internal Salesforce organizations with Chatter and in communities built with Salesforce Tabs + Visualforce. To learn more, see Display Similar Questions and Articles in Chatter.

When a user in a Customer Service (Napili) community enters a question in the Search field, similar questions and Knowledge articles automatically appear in a drop-down list below the field. The drop-down list contains two tabs: Articles and Questions. To also expose an All tab that shows combined results (recommended), enable Similar Articles.

By default, each tab contains up to six results. The All tab shows both matching articles and questions, with articles appearing first. It displays an equal number of questions and articles, but if there aren’t enough of one type of result, more results of the other type are displayed to reach the maximum. To see results of a particular type, users can click the Articles and Questions tabs. If a search only returns one result type (for example, questions), users still see all of the tabs.

Note: For a community user to see similar articles, Knowledge must be enabled in the community and the user must have access to it.

- 1: The Articles and Questions tabs let users view results of each type. Users can use the Up and Down arrow keys to navigate between results on any of the tabs. Clicking a question or article in the drop-down list navigates directly to it.
- 2: Text and chat bubble icons indicate whether a search result is an article or a question.
- 3: Questions in the list show the number of answers and a green checkmark with the text Best Answer if one was selected.
• The drop-down search results are based on whether the question or article title contains the text entered by the user. When the user performs a full search by clicking Search, the search engine also scans question descriptions and article text for matching terms.

You can customize the search settings by editing the properties of the Search Publisher component in Community Builder. For details, see Using Templates to Build Communities.

SEE ALSO:

Enable Similar Articles for Chatter Questions
Track Chatter Questions Use in Your Salesforce Organization and Communities
Question-to-Case Overview

Enable Similar Articles for Chatter Questions

When users ask questions in Chatter, similar questions appear as they type. If you’d like relevant Salesforce Knowledge articles to appear as well as questions, enable Similar Articles.

**Note:** Chatter and Salesforce Knowledge must be enabled in your organization.

Enabling Similar Articles turns on the feature in:

• Your internal Salesforce organization
• Your communities built with Salesforce Tabs + Visualforce or the Customer Service (Napili) template

1. From Setup, enter Knowledge Settings in the Quick Find box, then select Knowledge Settings.

2. Under Chatter Questions Settings, select Display relevant articles as users ask questions in Chatter (also applies to communities with Chatter).

**Note:** Make sure that the Question action has been added to the desired page layouts. Otherwise, users can't see it.

To learn more about how Similar Articles and Similar Questions work, see:

• Display Similar Questions and Articles in Chatter
• Display Similar Questions and Articles in the Customer Service (Napili) Template Search

SEE ALSO:

Display Similar Questions and Articles in the Customer Service (Napili) Template Search
Question-to-Case Overview
Selecting a Best Answer for a Question in Chatter

One of the advantages of asking a question in Chatter is that users can select the best answer for a question. When a question has a best answer, your users can quickly resolve their issue by going directly to the best answer.

Moderators and the person who asked the question can:

• Select the best answer for a question
• Remove the best answer status from an answer

Only one answer can be selected as the best answer. Moderators can be the Chatter moderator, the community moderator, or the Salesforce administrator. If a user doesn’t have permission to select the best answer for a question, they don’t see the Select as Best option.

When an answer is selected as a best answer, a check mark (✓) appears next to it. A copy of the best answer also appears at the top of the list of answers so other users can quickly spot it.
SEE ALSO:
Display Similar Questions and Articles in Chatter

Chatter Questions FAQ

Chatter Questions lets users in communities and Salesforce ask questions in the feed. Take a look at some common questions about the feature.

Why should I use Chatter Questions instead of asking my question in a Chatter text post?
Asking a question in Chatter saves you time. When you ask a question, similar questions and articles appear as you enter your question. Chances are that someone already asked the same question, and it could have many answers or a best answer. Chatter Questions harnesses the value of content that already exists in Chatter.

Can I filter the Chatter feed to show only questions?
Yes. At the top of your Chatter feed, click next to Show and select Questions.

Can I search for questions in Chatter?
Yes. Use the Search This Feed button at the top of your Chatter feed. Questions are included in the feed search results.

Is Chatter Questions available in Salesforce1?
Currently, Chatter Questions is available in the Salesforce1 mobile browser only.
**What happens when someone asks a question?**

Their question appears in the Chatter feed for their followers or the person or group they asked the question of. An email notification is also sent to the person or group they asked the question of. After a user asks a question, other users can then answer the question directly in Chatter.

**Who can select a best answer for a question?**

The person who asked the question and moderators can select the best answer for a question. Moderators can be the Chatter moderator or the community moderator. Your Salesforce administrator can also select the best answer for a question. For details, see [*Selecting a Best Answer for a Question in Chatter*](#).

**Can I track Chatter Questions use and adoption in my Salesforce organization?**

Yes. For details, see [*Track Chatter Questions Use in Your Salesforce Organization and Communities*](#).

**SEE ALSO:**

- [*Display Similar Questions and Articles in Chatter*](#)
- [*Track Chatter Questions Use in Your Salesforce Organization and Communities*](#)

---

**Track Chatter Questions Use in Your Salesforce Organization and Communities**

Keep tabs on the use and adoption of Chatter Questions in your organization or community with out-of-the-box reports and dashboards.

Reports on Chatter Questions help you answer questions such as:

- What kinds of questions are users asking?
- How many questions were asked in the past month?
- What percentage of questions go unanswered?
- Which topics do users ask the most questions about?
- Which departments are asking the most questions?

To track the use of Chatter Questions in your Salesforce organization, download the Salesforce Chatter Dashboards on the AppExchange. For help getting started, see Report on Chatter with the Dashboards Package.

To track the use of Chatter Questions in your communities, download the Salesforce Communities Management (for Communities with Chatter) on the AppExchange. For help getting started, see Report on Communities with the Dashboards and Insights Package.

**SEE ALSO:**

- [*Create a Case from a Question in Chatter*](#)
Differences Between Q&A Features in Salesforce

Salesforce offers a variety of question-and-answer features that you can implement in your Salesforce organization and communities. Because some of these features use similar terminology, take a moment to review the differences between them.

Salesforce has released three features that let users post questions and answers in a public forum setting. While these features share a common purpose, they represent an evolution of Salesforce’s Q&A features.

<table>
<thead>
<tr>
<th>Q&amp;A Feature</th>
<th>Description</th>
<th>Structure</th>
<th>How Users Access It</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version 1: Answers</strong></td>
<td>Answers, released in Winter ’11, was Salesforce’s first Q&amp;A feature for communities. Starting in Summer ’13, Answers isn’t available in new orgs.</td>
<td>Answers is built on the Question standard object.</td>
<td>Internal users access the Answers feature via the <strong>Answers</strong> tab in Salesforce.</td>
</tr>
<tr>
<td><strong>Version 2: Chatter Answers</strong></td>
<td>Chatter Answers, released in Spring ’12, was intended for customers who liked the Answers user experience but wanted additional functionalities. Chatter Answers let companies maintain an out-of-the-box, self-service site where users could help address each other’s questions, and provided a feed view of users’ questions. Starting in Summer ’16, Chatter Answers isn’t available in new orgs.</td>
<td>Chatter Answers is built on the Question standard object.</td>
<td>Internal users access Chatter Answers via the <strong>Q&amp;A</strong> tab, and moderators can view a list of questions in the <strong>Questions</strong> tab.</td>
</tr>
<tr>
<td><strong>Version 3: Chatter Questions</strong></td>
<td>Chatter Questions, released in Winter ’15, represents the most advanced developments in Salesforce Q&amp;A functionality. Because it takes advantage of <strong>Chatter Questions</strong> is built on the Chatter data model, and uses the Feed Post and Feed Comment objects.</td>
<td>Internal users access Chatter Questions within Chatter. They use the Question action in the Chatter publisher to post a question, and all</td>
<td></td>
</tr>
</tbody>
</table>
How Users Access It

<table>
<thead>
<tr>
<th>Q&amp;A Feature</th>
<th>Description</th>
<th>Structure</th>
<th>How Users Access It</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chatter</td>
<td>Chatter’s built-in capabilities, it’s ideal for customers who want their Q&amp;A feature tightly integrated into Chatter. Chatter Questions is available in Salesforce orgs and the Salesforce1 mobile browser app, as well as in communities where Chatter Questions is enabled.</td>
<td></td>
<td>questions are visible in the Chatter feed.</td>
</tr>
</tbody>
</table>

SEE ALSO:
Chatter Questions

**Question-to-Case Overview**

Question-to-Case lets moderators create cases from questions in Chatter, which makes it easier to track and resolve your customers’ issues. Question-to-Case is available in the full Salesforce site and the Salesforce1 mobile browser app, as well as in communities where Chatter Questions is enabled.

When a customer uses the Question action in Chatter to ask a question, similar questions and Knowledge articles appear below the Chatter publisher. If the similar questions and articles don’t address the issue, the customer posts the question.

If a question isn’t resolved, you can escalate the question to a case. Users with the “Moderate Chatter” or “Moderate Communities Feeds” user permission can create cases from questions directly in the feed, or you can set up processes—similar to workflow rules—in the Lightning Process Builder to automatically create cases from questions that meet specified criteria. Cases from questions are added to a queue so support agents can claim them.

When a customer’s question is turned into a case, the customer receives an email with the case number and a link to the case. The customer can view the case via a link on the question that’s visible only to them, while moderators see a note on the question indicating that a case was created.

**Note:** The person who asked the question must have access to cases so they can view their case.

**EDITIONS**

Available in: Salesforce Classic

Available in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions
Moderator Flag

Customer Flag

Note: On escalated questions in Salesforce (as opposed to communities), the notification is visible to all users, not just moderators.

When agents find a solution, they can respond to questions directly from the console, and the customer sees the agent’s response on the question or in the My Cases view. Agents choose whether the reply is visible to the community, or only to the customer who asked the question.

To get started, see Set Up Question-to-Case.

SEE ALSO:
Create a Case from a Question in Chatter
Automatically Create Cases from Unresolved Questions in Chatter
Set Up Question-to-Case

Add Question-to-Case to your communities, your Salesforce organization, or both.

Question-to-Case lets moderators create cases from unresolved questions in Chatter, which makes it easier to track and resolve your customers’ issues. Moderators can create cases from questions directly in the feed, or you can set up processes—similar to workflow rules—in the Lightning Process Builder to automatically create cases from questions that meet specified criteria. Cases from questions are added to a queue so support agents can claim them.

Question-to-Case is only available in communities where Chatter Questions is enabled.

SEE ALSO:
Enable Question-to-Case

Enable Question-to-Case

Question-to-Case lets moderators create cases from questions in Chatter to ensure that your customers’ questions are quickly resolved. Enable Question-to-Case in your communities, Salesforce organization, or both.

1. From Setup, enter Support Settings in the Quick Find box, then select Support Settings.
2. To enable Question-to-Case in all communities where Chatter Questions is enabled, select Enable Question-to-Case in Communities.
3. To enable Question-to-Case in your Salesforce organization, select Enable Question-to-Case in Salesforce.
4. Click Save.

Note: Make sure your case page layout is feed-based. The feed-based case page layout lets agents and moderators use the Community action to respond to escalated questions. If your organization was created before Spring ’14, your case page layout may not be feed-based.

SEE ALSO:
Add the Question from Chatter Field to the Case Detail View
Add the **Question from Chatter Field to the Case Detail View**

When a case is created from a question in Chatter, the Question from Chatter field on case detail pages displays a link to the original question. This field helps agents quickly navigate to the feed.

First, use field-level security to specify which users can see the Question from Chatter field on case detail pages.

1. From the object management settings for cases, go to Fields.
2. Click **Question from Chatter**.
3. Click **Set Field-Level Security**.
4. Select **Visible** for any profile that you want to be able to use Question-to-Case.
5. Click **Save**.

After you make the field visible to users, you can choose to add it to the Case Details view.

1. From the object management settings for cases, go to Page Layouts.
2. Click **Edit** next to the page layout that you want to customize.
3. Drag the Question from Chatter field from the Fields section of the page layout editor palette to the Case Information section of the page.
4. Click **Save**.
5. Click **Page Layout Assignment** to confirm that the user profiles which need Question-to-Case are assigned to the page layout that you customized. In addition, assign internal users who need access to the Question from Chatter field on cases to that page layout.

SEE ALSO:
- [Add the Escalate to Case Action to the Feed Item Layout](#)

Add the **Escalate to Case Action to the Feed Item Layout**

Give moderators the ability to create cases from questions by adding the Escalate to Case action to Chatter Questions pages. This action is created automatically when Question-to-Case is enabled in your organization.

1. From Setup, enter **Feed Item** in the Quick Find box, then select **Feed Item Layouts**.
2. Click **Edit** next to Feed Item Layout.
3. Drag the Escalate to Case action from the Quick Actions category in the palette to the Quick Actions in the Salesforce Classic Publisher section.
4. Click **Save**.
5. Click **Page Layout Assignments** to confirm that the user profiles that need Question-to-Case are assigned to the Feed Item Layout.

SEE ALSO:
- [Confirm Access to the Escalate to Case Action](#)
Confirm Access to the Escalate to Case Action

Does your Salesforce org use more than one record type for cases? Make sure that the profiles that need Question-to-Case have access to the record type associated with the Escalate to Case action. If your org has only one record type for cases, skip this process.

First, check which record type is assigned to the profiles that need access to the Escalate to Case action.

1. From Setup, enter Profiles in the Quick Find box, then select Profiles.
2. Click the name of a profile.
3. In the Record Type Settings section, make a note of which case record types the profile uses.
4. In the Permissions section, make sure that the user profile has either the Moderate Chatter or Moderate Communities Feeds permission enabled.

Then, check which record type the Escalate to Case action uses, and change it if necessary.

1. From Setup, enter Actions in the Quick Find box, then select Feed Item Actions.
2. Click Edit next to the Escalate to Case action.
3. Confirm that the Record Type field shows a record type that’s assigned to the profiles that need access to this action. If it doesn’t, select an appropriate record type from the drop-down list.
4. Click Save.

SEE ALSO:
  Customize the Escalate to Case Action Layout

Customize the Escalate to Case Action Layout

Choose which fields appear on the Escalate to Case action, and in what order, based on the information you need to track for each case.

1. From Setup, enter Actions in the Quick Find box, then select Feed Item Actions.
2. Click Layout next to the Escalate to Case action.
3. Drag any fields you want to add to the action from the action layout editor palette, and reposition them if necessary.
4. Click Save.

Note: In public communities, you can’t look up a contact when the case is submitted, so we recommend that you remove the Contact field from the Case Action layout.

SEE ALSO:
  Automatically Assign Cases from Questions to a Queue
Automatically Assign Cases from Questions to a Queue

Case assignment rules aren’t supported in Question-to-Case, so by default, cases created from questions are assigned to the moderator who escalates the question. You can write a workflow rule or process that automatically adds cases that were created from questions to a queue so agents can claim them.

You can assign escalated questions to a queue in several ways. The basic approach is to write a process in the Lightning Process Builder that automatically assigns a case to a specified queue when the Type field on the case equals Question. You can also build the process to accommodate multiple queues. For example, have your process assign cases with a certain topic to a different queue.

The way you use queues in escalated questions depends on your users, your goals, and more. Find an approach that best fits your business needs.

To learn how to create a queue, see Create Queues.

SEE ALSO:
- Automatically Create Cases from Unresolved Questions in Chatter

Automatically Create Cases from Unresolved Questions in Chatter

As your community or organization develops, ensure that users get speedy answers to their questions. Question-to-Case lets moderators escalate unresolved questions to cases in the feed, but you can make your case resolution process even more efficient by setting up processes—similar to workflow rules—in the Lightning Process Builder. Set up a process that automatically creates a case from questions that meet specified criteria.

⚠️ Important: These steps apply only to organizations and communities that use Chatter Questions. Not sure if that’s you? See Differences Between Q&A Features in Salesforce on page 121.

You can use Question-to-Case in processes in several ways. For example, consider setting up processes that:

- Create a case from a question if a week has passed, the question has received more than 10 likes, and a best answer hasn’t been selected.
- Create a case from a question immediately if the question contains the word “competitor.”

Processes related to Question-to-Case act on the Feed Item object. The process includes a flow that evaluates whether question posts meet your escalation criteria. You can create flow variables based on several Feed Item fields, including:

- BestCommentId: The ID of the comment that was selected as the best answer. If no comment has been selected as the best answer, this field is null.
- CommentCount: The number of comments on a question.
- LikeCount: The number of likes on a question.

Tip:
- Each flow variable’s data type must match the feed item field’s data type. CommentCount and LikeCount are number fields, while BestCommentId is a text field.
• The creation of a feed item can trigger a process, but updates to feed items (such as likes and comments) cannot. Depending on your process, you might need to specify how much time must pass before a related flow runs.

Create a Case from a Question in Chatter

If a question in Chatter hasn’t been resolved, moderators can create a case from the question. Question-to-Case must be enabled in your organization or community.

1. Navigate to the question in the feed.
2. Select Escalate to Case in the action drop-down menu.

A window appears that’s pre-populated with the case subject, contact, and description. Unless Question-to-Case has a queue associated with it, the case is automatically assigned to you.

3. If needed, edit the case details.
4. Create the case.
After a case is created from a Chatter question, the customer who asked the question receives an email notifying them that a case was created from their question. The email provides the case number and a link to the case.

Agents can post a response to the question directly from the case feed using the Community action in the publisher. Agents choose who can view the response by selecting either “Customer Only” or “Everyone”. They can also navigate to the original question from the case’s detail page by clicking the link in the Question from Chatter field.

SEE ALSO:
   - Set Up Question-to-Case
   - Automatically Create Cases from Unresolved Questions in Chatter

Create, Share, and Organize Files

Post files to feeds and records, share files with customers in the Salesforce cloud, and sync files between your local drive and Salesforce.

IN THIS SECTION:
   - Differences Between Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments
     Explore the differences between various ways to manage your files and content.
   - Salesforce Files
     Organize and access your files from the Files tab.
   - Files Connect External Files
     Browse, search, and share files that are stored elsewhere right from Salesforce.
   - Document Libraries
     Store files without attaching them to records.
   - Salesforce CRM Content
     Organize, share, search, and manage all types of files within your organization.
   - Google Apps
     Integrate Google apps like Google Docs and Gmail with Salesforce.

Differences Between Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments

Explore the differences between various ways to manage your files and content.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>Files Home</th>
<th>Salesforce CRM Content</th>
<th>Salesforce Knowledge</th>
<th>Documents Tab</th>
<th>Attachments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purpose</td>
<td>Upload, store, find, follow, share, sync, and collaborate on Salesforce files in the cloud.</td>
<td>Publish and share official corporate files with coworkers and deliver them to customers.</td>
<td>Create and manage content, known as articles, in a knowledge base. Internal users and customers (on your Customer Portal, partner portal,</td>
<td>Store Web resources, such as, logos, DOT files, and other Visualforce materials in folders without attaching them to records.</td>
<td>Attach files to records from the Attachments related list on selected detail pages.</td>
</tr>
</tbody>
</table>
## Collaborate with Everyone

<table>
<thead>
<tr>
<th>Files Home</th>
<th>Salesforce CRM Content</th>
<th>Salesforce Knowledge</th>
<th>Documents Tab</th>
<th>Attachments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Service Cloud Portal, or Force.com Sites) can quickly find and view articles they need.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Common Uses

- **Upload a file and store it privately until you’re ready to share it.** Share the file with coworkers and groups to collaborate and get feedback.
  - Attach files to posts in a Chatter feed on the Home tab, Chatter tab, a profile, a record, or a group. Users with access to Salesforce Files Sync can access, sync, and share files in their Salesforce Files Sync folder.
- **Create, clone, or modify a sales presentation and save it so only you can see it and work on it.** When you’re ready, publish it so other users in your company have access to it. Create a content pack and send it to customers.
- **Write, edit, publish, and archive articles using the Articles Management tab or find and view published articles using the Articles tab.** Customers and partners can access articles if Salesforce Knowledge is enabled in your Customer Portal, partner portal, Service Cloud Portal, or Force.com Sites.
  - Create a public knowledge base so website visitors can view articles.
- **Add a custom logo to meeting requests by uploading your logo to the Documents tab.**
- **Add a file to a specific record, like an event, marketing campaign, contact, or case by attaching it on the Attachments related list.**

### Supported File Types

- **All**
- **All**
- **All**
- **All**
- **All**

### Maximum File Sizes

- **2 GB**
  - 2 GB
  - 2 GB (including headers) when
- **5 MB for attachments**
  - 5 MB
  - 20 KB for a custom-app logo
  - 25 MB for file attachments
Collaborate with Everyone

Create, Share, and Organize Files

<table>
<thead>
<tr>
<th>Files Home</th>
<th>Salesforce CRM Content</th>
<th>Salesforce Knowledge</th>
<th>Documents Tab</th>
<th>Attachments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>uploaded via Chatter REST API</td>
<td>2 GB for feed attachments</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 GB (including headers) when uploaded via REST API</td>
<td>2 GB (including headers) when uploaded via REST API</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>38 MB when uploaded via SOAP API</td>
<td>38 MB when uploaded via SOAP API</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10 MB when uploaded via Bulk API</td>
<td>10 MB when uploaded via Bulk API</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10 MB for Google Docs</td>
<td>10 MB for Google Docs</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10 MB when uploaded via Visualforce</td>
<td>10 MB when uploaded via Visualforce</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

SEE ALSO:
- Using Salesforce Files
- Salesforce CRM Content Overview
- Documents Home

Salesforce Files

Organize and access your files from the Files tab.

IN THIS SECTION:
- Using Salesforce Files
  Use Salesforce Files to share and collaborate on files, store files privately, manage version updates, and follow files that are important to you. Use Files Connect to connect to external file systems right from Salesforce.
- Files Home
  Files Home is the central location for your files in Salesforce. See all files you’ve stored privately, view files shared with you, and share files with others.
- Search for Files
  Use the files-specific search field on Files home in Salesforce to find just what you’re looking for.
- Filter Your Files List
  Use the filters on the Files page to quickly access to your files in Salesforce.
- Create Folders in Libraries in Lightning Experience
  Organize library files into folders to find what you need quickly.
Upload and Share Files
Upload files to Salesforce and share them with others.

File Updates in the Feed
Follow a file to see file updates in your feed, view a file’s version history, and get file recommendations.

File Previews and Details
View and edit file details, and report on files.

Salesforce Files Sync
View and edit file details, and report on files.

Using Salesforce Files
Use Salesforce Files to share and collaborate on files, store files privately, manage version updates, and follow files that are important to you. Use Files Connect to connect to external file systems right from Salesforce.

Working with files in Salesforce means:
• Posting files to Chatter feeds to collaborate with coworkers.
• Adding files directly to records, such as Accounts, Cases, Leads, and more, to keep information right where you need it.
• Sharing files with customers in the secure Salesforce cloud.
• Connecting to external file systems with Files Connect.
• Syncing files between your local drive and Salesforce Classic.
• Running standard and custom file reports to understand how people work with files.

All file types are supported, including everything from Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs and image files. Audio and video files can be uploaded and downloaded, but not parsed or previewed.

Note: In Internet Explorer 11, the Preview option redirects to the file detail page.

As you work with files in Salesforce, keep these file limits in mind:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>File size</td>
<td>• 2 GB when uploaded via the Web interface</td>
</tr>
<tr>
<td></td>
<td>• 2 GB when uploaded via the Salesforce Files Sync desktop client (or 500 MB when using proxy)</td>
</tr>
<tr>
<td></td>
<td>• 100 MB when uploaded from a mobile device</td>
</tr>
<tr>
<td>Maximum number of versions per file</td>
<td>2,048 versions</td>
</tr>
<tr>
<td>Maximum number of synced files and folders</td>
<td>Users can sync up to 10,000 files.</td>
</tr>
<tr>
<td>Maximum number of users who can sync the same file simultaneously</td>
<td>1,000 users</td>
</tr>
</tbody>
</table>
Note:

- For information about the different file tools and solutions in Salesforce, see Differences Between Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments.
- To learn who can perform which actions on a file, see Who Can See My File?
- File syncing functionality, including the Synced filter, is only available if Salesforce Files Sync is set up for you and your organization. Files Sync is available in Salesforce Classic only.
- Files from external repositories like Google Docs and Microsoft® SharePoint® are only available if Salesforce Files Connect is configured in your organization and enabled for you.
- Chatter feeds, groups, and the ability to follow files are only available for orgs that have Chatter enabled.
- If your org uses profile-based Chatter rollout, users must have Chatter permissions enabled for Files to be available.

SEE ALSO:
- View File Details
- Who Can See My File?
- Change File Access
- Sync Files and Folders
- Upload a New Version of a File
- Attach a File to a Post or Comment
- Follow a File

Files Home

Files Home is the central location for your files in Salesforce. See all files you’ve stored privately, view files shared with you, and share files with others.

From Files home, you can:

- See all the files you own or have access to and filter your list of files.
- Search for files using filters and by typing terms in the Files search box, or the search box at the top of the page.
- Upload private files or upload and share files with people, groups, or via a file link.
- Preview a file without downloading it.
- Follow and receive updates about a file in the Chatter feed. Click next to the file you’re following to stop receiving updates about the file. (Requires Chatter.)
- Click to download, upload a new version, share with people, groups, or via link, and see sharing settings.
- If you have the “Sync Files” permission, access synced files in your Salesforce Files Sync folder.
- If Files Connect is enabled in your org, browse, search, and share files stored in an external data source right from Salesforce
- To view the file detail page, click a file name.
- To see a file owner’s profile, click their name.

Files home provides a powerful toolset for working with and managing your files.
To refine the list of files you see, filter your file list (1).

Access files in your libraries from **Libraries** in the left navigation panel.

Search (2) to find the files you need. In Salesforce Classic, filtering your file list also filters your search. To search all files you have access to, select the Recent filter.

Upload files to Salesforce (3).

All file types are supported, including everything from Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs and image files. Audio and video files can be uploaded and downloaded, but not parsed or previewed.

Preview, download, share, and rename files directly from the file list (4).

If Files Connect is enabled for your org, the left navigation panel displays a section for external file sources (5).

Files are automatically added to the file list when:

- You upload a file.
- You attach a file to a record.
- You or someone else attaches a file to a Chatter feed or comment.
- You sync a file in your Salesforce Files Sync folder.
- Someone else shares a file privately with you using the Sharing dialog box.
- You upload a file to a Salesforce CRM Content library.
- Someone else uploads a file to a library you’re a member of.
• You or someone else creates a content pack or uploads a Web link in Salesforce CRM Content. You only see files from content packs and Web links you have access to.

SEE ALSO:
Filter Your Files List
Who Can See My File?

Search for Files

Use the files-specific search field on Files home in Salesforce to find just what you're looking for. Files home lists the files you own and have access to, including files posted to feeds. The 25 most recently viewed files are listed by default. You can see and search a certain group of files by clicking a specific filter on the sidebar. The search results are filtered based on the terms entered.

Note: Users who have the “Sync Files” permission don’t see the All Files, MY FILES, or FILES IN MY GROUPS filters. Users who don’t have the “Sync Files” permission don’t see the Synced filter.

• **All Files**—All files you own and have access to, including:
  – Files that have been shared with you
  – Files you’re following
  – Files in your Chatter groups
  – Files in your libraries
  – Files attached by other people to a Chatter feed, including files attached to all public groups and private groups you’re a member of. You don’t have access to files attached to private groups you’re not a member of.

This filter is only available in Salesforce Classic.

• **Recent**—The most recent files you’ve viewed.

• **MY FILES**—All files you own, files shared with you, and files you follow.
  – **Owned by Me**—Files you have:
    • Uploaded on the Home or Files page. These files are private and not shared with anyone, but you can view them, share them, and attach them to Chatter feeds.
    • Attached to Chatter feeds from your computer.
    • Synced using your Salesforce Files Sync folder.
    • Uploaded to Salesforce CRM Content libraries you’re a member of and your private library.
  – **Shared with Me**—All files that have been shared with you either by a private share or a public post to your profile.
  – **Following**—All files that you’re following. *(Requires Chatter)*

• **FILES IN MY GROUPS**—All files you and other people shared to groups you’re a member of. The last five groups you’ve visited are listed.

• **FILES IN MY LIBRARIES**—All files you and other people uploaded to libraries you’re a member of and all files you uploaded to your private library. The first five libraries you’re a member of, including your private library, are listed. If you’re a member of more than five libraries, click More to see a complete list.

• **Synced**—All files that have been synced in your Salesforce Files Sync folder. This filter is available only to users who have the “Sync Files” permission.
• **EXTERNAL FILES**—All files you have access to in Files Connect external data sources. Search is restricted to the selected external data source.

In Salesforce Classic, to search for files using the Files search:

1. Optionally, click a filter on the sidebar to restrict your search to a specific set of files.
2. Enter your search terms in the Search field on the **Files** tab. You can search by file name, description, owner, type, or within the file's text.
3. Click **Search** to see a filtered list of all relevant files based on your search terms. Or click 🔄 to clear your search terms.

In Salesforce Classic and Lightning Experience, you can search for files from the header search field.

Use **feed search** to find files posted in a specific Chatter feed, such as on a profile, on a record, or in a group.

⚠️ **Note:** The feed search returns the matches for file or link names shared in posts, but not in comments.

The Files list doesn't include:

- Documents from the Documents tab.
- Attachments from the Notes and Attachments related list.

Search supports several file types and has file size limits. If a file exceeds the maximum size, the text within the file isn't searched, but the file's name, description, type, and owner are.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extensions</th>
<th>Maximum File Size for Search</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML</td>
<td>.htm, .html, .xhtml</td>
<td>5 MB</td>
</tr>
<tr>
<td>PDF</td>
<td>.pdf</td>
<td>25 MB</td>
</tr>
<tr>
<td>PPT</td>
<td>.ppt, .pptx, .pptm</td>
<td>25 MB</td>
</tr>
<tr>
<td>RTF</td>
<td>.rtf</td>
<td>5 MB</td>
</tr>
<tr>
<td>Text</td>
<td>.c, .cpp, .css, .csv, .ini, .java, .log, .sql, .txt</td>
<td>5 MB</td>
</tr>
<tr>
<td>Word</td>
<td>.doc, .docx, .docm</td>
<td>25 MB</td>
</tr>
<tr>
<td>XLS</td>
<td>.xls, .xlsx, .xlsm</td>
<td>5 MB</td>
</tr>
<tr>
<td>XML</td>
<td>.xml</td>
<td>5 MB</td>
</tr>
</tbody>
</table>

**SEE ALSO:**

- [Follow a File](#)
- [Filter Your Files List](#)
Filter Your Files List

Use the filters on the Files page to quickly access your files in Salesforce.

The Files page lists all the files you have access to. Filters show you different groups of those files, letting you find what you’re looking for quickly.

<table>
<thead>
<tr>
<th>Filter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Files</td>
<td>All files you own and have access to.</td>
</tr>
<tr>
<td>Recent</td>
<td>The most recent files you’ve viewed.</td>
</tr>
<tr>
<td>Owned by Me</td>
<td>Only the files you own.</td>
</tr>
<tr>
<td>Shared with Me</td>
<td>Only files that have been shared with you either by a private share or a public post to your profile.</td>
</tr>
<tr>
<td>Following</td>
<td>Only the files you’re following in Chatter. This filter is available only in organizations that use Chatter.</td>
</tr>
<tr>
<td>Synced</td>
<td>All files that have been synced in your Salesforce Files Sync folder. This filter is available only to users who have the “Sync Files” permission.</td>
</tr>
<tr>
<td>Libraries</td>
<td>Files anyone has uploaded to libraries you’re a member of, as well as all files you uploaded to your private library, grouped by library name.</td>
</tr>
</tbody>
</table>

SEE ALSO:

View Where a File is Shared
Create Folders in Libraries in Lightning Experience

Organize library files into folders to find what you need quickly.

Library Managers can create, rename, and delete folders in libraries in Lightning Experience. Folders are visible to all users who have access to the library. The New Folder button adds a folder to the library or creates a subfolder within a folder. You can create multiple levels of subfolders. The row-level Move action lets you move a file among folders and subfolders within a library.

To add folders to a library:
- “Manage Salesforce CRM Content”
  OR
  Manage Library checked in your library permission definition

Note:
- An Upload File button is available when you’re in a library. However, when you upload a file here, it shows up in your Owned by Me filter rather than inside the library.
- To add a file to a library, switch to Salesforce Classic. From the library, choose Contribute and add the file. Or, from the file’s row-level actions or from the file detail page, choose Share with library.
Getting Started with Library Folders

- In orgs with Lightning Experience enabled, folders are enabled by default in any new libraries you create. Folders are not enabled by default in existing libraries. To enable folders in a library, click the **New Folder** button. Depending on the size of the library, enabling folders can take a few moments.

  **Note:** In order to enable folders in a library, you need the “Manage Salesforce CRM Content” permission. To enable folders from the user interface, verify that you’re a member of the library with Library Administrator permission. You can also use the SOAP API to enable folders in libraries.

- In orgs that don’t have Lightning Experience enabled, folders aren’t enabled by default in new libraries.

- Folders can’t be enabled in libraries with more than 5,000 files.

Anyone with the Manage Library permission can create, rename, and delete folders. You can view all folders in a library you have access to, and move files among folders within a library.

<table>
<thead>
<tr>
<th>Lightning Experience</th>
<th>Salesforce Classic</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create, rename, and delete library folders</td>
<td>✔</td>
</tr>
<tr>
<td>Move files in a library into folders</td>
<td>✔</td>
</tr>
<tr>
<td>View folders</td>
<td>✔</td>
</tr>
<tr>
<td>View libraries</td>
<td>✔</td>
</tr>
<tr>
<td>Add files to a library</td>
<td>✔</td>
</tr>
<tr>
<td>Create, edit, and delete libraries</td>
<td>✔</td>
</tr>
<tr>
<td>Manage library membership</td>
<td>✔</td>
</tr>
</tbody>
</table>

Upload and Share Files

Upload files to Salesforce and share them with others.

**IN THIS SECTION:**

  - **Upload and File Sharing Overview**
    - Upload and share files from Files home, in feeds, and on opportunities or other records.
  
  - **Upload a New Version of a File**
    - Replace an old version of a file by uploading a new version.
  
  - **File Size Limits in Salesforce**
    - Maximum file size limits for files in Salesforce.
  
  - **Browsers that Support Uploading Multiple Files**
  
  - **Who Can See My File?**
    - Your files in Salesforce can be private to you, privately shared, or visible to your entire company. Learn how to identify a file’s sharing settings and how you can change them.
  
  - **Change File Access**
    - Decide who can view and modify the files you own.
Make a File Private
You can restrict access to shared files you own by making them private.

Share Files with Groups
Share files in Chatter with public or private groups so that members of the groups can view and download the files from their feed.

Share Files with People in Salesforce Classic
Share files with people privately and set Viewer or Collaborator access for each person you share the file with.

Share Files with Libraries in Salesforce Classic
Share files with libraries to take advantage of the permission-setting capabilities of content libraries while still using the features of Salesforce Files.

Attach Files to Records
Attaching files to records is a powerful way to collaborate and stay organized in Salesforce. You keep information on an opportunity, account, or case right where you need it. Share relevant documents with anyone with access to the record.

Prevent Others from Sharing and Unsharing a File
You can prevent others from sharing and unsharing a file you own. This doesn’t affect existing shares.

Share Files with People in Lightning Experience
Share files with people privately and set Viewer or Collaborator access for each person you share the file with.

Share Files via Link

Upload and File Sharing Overview
Upload and share files from Files home, in feeds, and on opportunities or other records.

Upload and share files from:
- Files home
- Any Chatter feed post or comment field
- Files card or list on groups, user profiles, opportunities, and other records

All file types are supported, including everything from Microsoft® PowerPoint presentations and Excel spreadsheets, to Adobe® PDFs and image files. Audio and video files can be uploaded and downloaded, but not parsed or previewed. Files up to 2 GB can be uploaded by default. However, your organization determines the maximum file size.

Files Home
When you upload files, they’re added to the Owned by Me filter on Files home, with you as the owner. Files you upload on Files home are automatically uploaded as private.

You can also add files to Salesforce by:
- Attaching a file to a Chatter feed.
- Uploading files to Salesforce CRM Content private and shared libraries.
- Syncing a file in your Salesforce Files Sync folder.
- Creating content packs or uploading Web links in Salesforce CRM Content.

The Files list doesn’t include:
- Documents from the Documents tab.
- Attachments from the Notes and Attachments related list.
Collaborate with Everyone

Note: Files without a file extension or with an unrecognized file extension show “unknown” in the Type column.

Private Files

A private file is private, not shared with anyone, and you are the file owner. Only file owners and users with the “View All Data” permission can see private files. Private files show a lock icon in the Files list and on the file’s detail page. You can search for your private files in Chatter and on the Files list.

Sharing Private Files

You can share private files from the file detail page or by attaching them to a Chatter feed, a profile, a record, or a group. You can also share a file via a link. When you share a private file, it’s no longer private. To learn who can perform which actions on a file, see Who Can See My File?

SEE ALSO:

File Size Limits in Salesforce
Prevent Others from Sharing and Unsharing a File

Upload a New Version of a File

Replace an old version of a file by uploading a new version.

Uploading a new version replaces all previous versions, but previous versions are still available by clicking Show all versions on the file detail page. If your original file was uploaded via a feed post, use Upload New Version to replace the old version.

1. Click Upload New Version from any of these locations:
   - The file detail page
   - The file previewer
   - The Files page, via the actions arrow for the file
   - On a file in a feed, via the More Actions arrow (available in Salesforce Classic only)

2. Click Choose File, and select a file from your computer.

   At this point you have the option to enter a note about what changed in the What Changed? field. This information is shown on the Version History list.

3. Click Upload New Version (Salesforce Classic) or Start Upload (Lightning Experience).

The file detail page and any previous posts show the updated version.

Note:

- Only file owners, collaborators, and users with the “Modify all Data” permission can upload new versions. To learn who can perform which actions on a file, see Who Can See My File?
- The file owner doesn’t change when a collaborator uploads a new version.
• If the file is from Salesforce CRM Content, you can’t upload a new version from the file detail page. You can click Go to Content Detail Page and upload a new version there. (Available in Salesforce Classic only.)

SEE ALSO:
View File Version History
Follow a File

File Size Limits in Salesforce
Maximum file size limits for files in Salesforce.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Details</th>
</tr>
</thead>
</table>
| Attachments related list      | • 25 MB for file attachments  
• 2 GB for feed attachments    |
| Documents tab                 | • 5 MB  
• 20 KB for a custom-app logo |
| Salesforce CRM Content        | • 2 GB  
• 2 GB (including headers) when uploaded via Chatter REST API  
• 2 GB (including headers) when uploaded via REST API  
• 38 MB when uploaded via SOAP API  
• 10 MB when uploaded via Bulk API  
• 10 MB for Google Docs  
• 10 MB when uploaded via Visualforce |
| Salesforce files              | 2 GB                                                                     |
| Salesforce Knowledge          | 5 MB for attachments                                                     |

The size limit for an attached file is 25 MB when attached directly to the related list.
The size limit for an email message, including attachments, is 25 MB.

SEE ALSO:
Upload and File Sharing Overview
Browsers that Support Uploading Multiple Files

These browsers allow you to upload multiple files on page 140 from the Files tab, the Files Shared With list on a group, or the Files Owned by list on a profile. If your browser does not support uploading multiple files, you can still upload files one at a time.

<table>
<thead>
<tr>
<th>Browser</th>
<th>Additional Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google Chrome®</td>
<td>Must be the latest stable version</td>
</tr>
<tr>
<td>Mozilla Firefox®</td>
<td>Must be the latest stable version</td>
</tr>
<tr>
<td>Internet Explorer® 9</td>
<td>Must have Flash 11 or later installed</td>
</tr>
<tr>
<td>Apple Safari® for Mac</td>
<td>Version 5.1.x</td>
</tr>
</tbody>
</table>

Who Can See My File?

Your files in Salesforce can be private to you, privately shared, or visible to your entire company. Learn how to identify a file’s sharing settings and how you can change them.

This table describes file sharing settings which depend on how the file is shared. The sharing setting and icon appear on a file’s detail page and on the Shared With list on a file detail page.

<table>
<thead>
<tr>
<th>Sharing Setting</th>
<th>Definition</th>
<th>When Does a File Have This Setting?</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗝️ Private</td>
<td>The file is private. It hasn’t been shared with anyone else besides the owner. The file owner and users with “Modify All Data” permission can find and view this file. However, if the file is in a private library, only the file owner has access to it.</td>
<td>A file is private when you: • Upload it in Files home • Publish it to your private library • Sync a file in your Salesforce Files Sync folder • Stop sharing it with everyone (Make Private) • Delete posts that include the file and the file isn’t shared anywhere else</td>
</tr>
</tbody>
</table>

| 🗝️ Private Shared | The file has only been shared with specific people, groups, or via link. It’s not available to all users in your company. Only the file owner, users with “Modify All Data” or “View all Data” permission, and specific file viewers can find and view this file. | A file is privately shared when it’s: • Only shared with specific people or a private group • Posted to a private group • Shared via link • Posted to a feed on a record • Published to a shared library |

| 🗝️ Your Company   | All users in your company can find and view this file.                     | A file is shared with your company when it’s posted to a |
### Sharing Setting

<table>
<thead>
<tr>
<th>Definition</th>
<th>When Does a File Have This Setting?</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>feed that all users can see, a profile, a record, or a public group.</td>
</tr>
</tbody>
</table>

This table describes which actions you can perform on a file depending on your file permissions.

<table>
<thead>
<tr>
<th>Action</th>
<th>File Owner</th>
<th>File Collaborator</th>
<th>File Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>View or Preview</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Download</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Share</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Attach a File to a Post</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Sync a File</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Upload New Version</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Edit Details</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Permission</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Make a File Private</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Restrict Access</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:**

- **No Access** means that only the people in your company with whom this file is shared can find or view the file. If the file is shared with a private group, only the group’s members can find or view the file.
- Users with “Modify All Data” permission can view, preview, download, share, attach, make private, restrict access, edit, upload new versions, and delete files they don’t own. However, if the file is in a private library, then only the file owner has access to it.
- Users with “View All Data” permission can view and preview files they don’t own. However, if the file is in a private library, then only the file owner has access to it.
- Users must have the “Sync Files” permission to sync files.
- Groups (including group members) and records have viewer permission for files posted to their feeds.
- Permissions for files shared with libraries depend on the library.

**SEE ALSO:**

- Make a File Private
- View Where a File is Shared
- Prevent Others from Sharing and Unsharing a File
Change File Access

Decide who can view and modify the files you own.

File owners and collaborators can change file permissions for people and groups from viewer to collaborator and conversely. They can also change file permissions for files shared with their company to viewer, collaborator, or no access.

1. On a file detail page, click Share File > Sharing Settings.
2. Find the person or group whose access you want to change. Or change access for Any Chatter user in your company.
3. Select Viewer, Collaborator, or No Access (for your company). Or, for files shared with records (Salesforce Classic only), change to Set by Record. The change happens immediately.
   - Viewers can view, download, and share files.
   - Collaborators can view, download, share, change permission, edit the file, and upload new versions.
   - Set by Library for a file in a library means that access to the file follows access to the library. This setting can’t be toggled.
   - Set by Record for a file attached to a record means that access to the file follows access to the record. People with read/write access to the record have Collaborator access to the file. People with read-only access to the record have Viewer access to the file. This setting can be toggled in Salesforce Classic only.
   - No Access means that only the people in your company with whom this file is shared can find or view the file. If the file is shared with a private group, only the group’s members can find or view the file.
4. Click Close.

Note:
- A file is shared with your company when it’s posted to a feed that all users can see, a profile, a record, or a public group. Any Chatter user in your company is given viewer permission by default. If you change the permission from viewer or collaborator to no access, you remove the share to company and to public groups.
- When you share a file with someone, they are given Collaborator access by default. When you share a file with a group, the group members are given Viewer access by default. You can change the default access when you share a file for the first time. File owners and collaborators can change access after a file has been shared.
- File link recipients can only view and download files. They can’t be collaborators.

SEE ALSO:
- Who Can See My File?
- Make a File Private
- Prevent Others from Sharing and Unsharing a File

Make a File Private

You can restrict access to shared files you own by making them private.

Available in: Salesforce Classic

Available in: Group, Enterprise, Professional, Performance, Unlimited, Contact Manager, and Developer Editions
To stop sharing a file you own or have the “Modify All Data” permission for, make the file and the file link private.

1. From the file detail page, click either Share File > Sharing Settings or Show All on the Shared With list.
2. On the Sharing Settings dialog box, click Make private (or Restrict access if the file originated in a Salesforce CRM Content library).
3. On the confirmation dialog box, click Make private (or Restrict access).

Making a file private removes it from any posts it’s attached to and removes it from everywhere it’s been shared. Only the owner and people with the “Modify All Data” permission can access it. If the file originated in a Salesforce CRM Content library, it is removed from everywhere it’s been shared, except the library.

If the file is shared using a content delivery, the content delivery becomes inaccessible, but is not deleted. If the file is shared using Share via link in Chatter, the link to the file is deleted.

SEE ALSO:
- Post Visibility
- View Where a File is Shared
- Prevent Others from Sharing and Unsharing a File

Share Files with Groups

Share files in Chatter with public or private groups so that members of the groups can view and download the files from their feed.

Share a file with a private or unlisted group so only members of that group can see it, or share a file with a public group so members of that group and all Chatter users in your company can see it. By default, anyone who can see a file can share it.

To share a file with one or more Chatter groups:

1. Share the file from one of these locations:
   - On the detail page of the file you want to share—Click File Sharing Settings > With group. Or click Show All on the Shared With list then click Groups on the Sharing Settings dialog box.
   - Next to the file in a feed—Click More Actions > File Sharing Settings then click Groups on the Sharing Settings dialog box.
   - Next to the file on the Files page, the Files Owned by list, or the Group Files list—Click Share with groups.
   - On a file hover—Click Share File then click Groups on the Sharing Settings dialog box.
   - In your Salesforce Files Sync folder on your desktop—Right-click on a file, hover on Salesforce Files Sync, then click Share with groups.

2. Type the name of the group you want to share the file with and click the name to select it. Repeat this step to share with more groups.

3. Select access levels for each group. By default, private group access is set to Collaborator, while public group access is set to Viewer.

4. Optionally, add a message to your post. You can @mention people and groups in your message to notify them and post the file in their feed.

5. Click Share and Close. The file is posted to each group you shared it with and @mentioned.
A private file shared with a private or unlisted group becomes a privately shared file and displays the privately shared icon (🔒). The file is posted to the group’s feed and only the file owner and group members can find and view the file. Any file shared with a public group is viewable by all users in your company, displays the your company icon (👥), and is posted to the group’s feed.

On the Sharing Settings dialog box, click ✗ next to a person’s or group’s name to stop sharing the file with them.

**Note:**
- Documents from the Documents tab and attachments from the Notes and Attachments related list aren’t listed on Files home and can’t be shared as Salesforce Files.
- Content files may be shared with more people than shown in Share with People if they are part of a content pack or delivery.
- The maximum number of times a file can be shared is 100. This includes files shared with people, groups, and via links. If a file is privately shared and nears the 100 share maximum, consider making the file public by posting it to your feed.

**SEE ALSO:**
- Group Files Lists
- View Where a File is Shared

**Share Files with People in Salesforce Classic**

Share files with people privately and set Viewer or Collaborator access for each person you share the file with.

Share a file privately so only specific people in your company can see it. By default, anyone who can see a file can share it.

To share a file with one or more users in your company:

1. Start by sharing the file from one of these locations:
   - On the detail page of the file you want to share—Click File Sharing Settings > Share with people. Or click Sharing Settings and then click People on the Sharing Settings dialog box.
   - Next to the file in a feed—Click More Actions > File Sharing Settings then click People on the Sharing Settings dialog box.
   - Next to the file on the Files home page—Click Share with people.
   - On a file hoverClick Share File then click People on the Sharing Settings dialog box.
   - In your Salesforce Files Sync folder on your desktop—Right-click on a file, hover on Salesforce Files Sync, then click Share with people.

2. Type the name of the person you want to share the file with and click the name to select it.

3. Choose the file permission you want them to have. By default, they have collaborator permission which lets them view, download, share, change permission, edit the file, and upload new versions. Select Viewer to give them permission to view, download, and share files.

4. If you want to share the file with more people, enter more names.

5. Optionally, add information to the message that recipients receive.

6. Click Share and Close. Recipients receive a message that you have shared a file with them, along with a link to the file. Lightning Experience users receive this message as an email notification. Salesforce Classic users get a private Chatter message on their My Messages page on the Chatter tab, and also get an email notification if they have email notifications for Chatter messages enabled.
Unless the file was already shared with your company, it’s privately shared and displays the privately shared icon (🔒). It’s not posted anywhere and only the people you specifically shared it with can find and view it. If it was already shared with your company, it retains the your company icon (📔) and anyone in your company can find and view it.

On the Sharing Settings dialog box, click next to a person’s or group’s name to stop sharing the file with them. If you don’t want others to change who can access the file, select Prevent others from sharing and unsharing.

Note:

- Documents from the Documents tab and attachments from the Notes and Attachments related list aren’t listed on Files home and can’t be shared as Salesforce Files.
- Content files may be shared with more people than shown in Share with People if they are part of a content pack or delivery.
- The maximum number of times a file can be shared is 100. This includes files shared with people, groups, and via links. If a file is privately shared and nears the 100 share maximum, consider making the file public by posting it to your feed.

SEE ALSO:

View Where a File is Shared

Share Files with Libraries in Salesforce Classic

Share files with libraries to take advantage of the permission-setting capabilities of content libraries while still using the features of Salesforce Files.

If your admin has turned on this feature for your org, you can share any file with a library. The Libraries tab in Salesforce Classic lists the libraries in your company along with the permissions assigned to each. The Share with library option in Chatter lets you share Chatter files with a library, applying the permissions set for the library.

Note: Sharing files with libraries requires that:

- Your user detail page has the Salesforce CRM Content User setting enabled. Your administrator can enable this setting.
- Your organization has the Files user interface allows sharing files with libraries setting enabled. Your administrator can enable this setting on the Salesforce CRM Content page in Setup.

1. On the Files tab, click next to the file you want to share with a library.

2. Select Share with library. Or, for external file references (only applicable for Files Connect users), select Share a reference, and choose Library in the Sharing Settings dialog box.

3. Do one of the following, depending on what happens next:

   - If the Publish Content to Multiple Libraries dialog box appears, this means that another library already manages the file. Select one or more additional libraries, and click Publish.
   - If the Share files with a library confirmation message appears, it means that the file has been shared with people who have Collaborator access, or it has been synced. If you proceed, Collaborators and anyone who has synced the file will have only Viewer access. (A library administrator can give them editing access later.) Click Share to continue, or Cancel if you’ve changed your mind.
   - If the Publish Content dialog box appears, enter a title for the file. Select the library you want to share it with, and enter any tags as metadata. Select a record type, enter any optional information, and click Publish.
The file is now listed on the Libraries tab and in Files in My Libraries on the Files tab.

SEE ALSO:
Create Folders in Libraries in Lightning Experience

Attach Files to Records
Attaching files to records is a powerful way to collaborate and stay organized in Salesforce. You keep information on an opportunity, account, or case right where you need it. Share relevant documents with anyone with access to the record.

You can attach files—such as Microsoft® Office documents, Adobe® PDFs, images, and videos—to most Salesforce records. Add files using the Files related list.

Note: If you don’t see the Files related list on a record, ask your admin to add it to the page layout for that record type.

To attach files to records:
• In Lightning Experience on the Files related list, click Add File to add a local file or a Salesforce file.
• In Salesforce Classic, click Upload File file from the Files related list.

Note: In Lightning Experience, all files uploaded to the Notes & Attachments related list are uploaded as Salesforce Files, not as attachments. In Salesforce Classic, files uploaded to Notes & Attachments are either Salesforce Files or attachments, depending on how your org’s preferences are set. Files uploaded to the Files related list always become Salesforce Files, whether in Lightning Experience or Salesforce Classic.

Limits
• The size limit for an attached file is 25 MB when attached directly to the related list, including a file attached to a solution.
• The file size limit for Chatter feed attachments is 2 GB.
• The size limit for an email message, including attachments, is 25 MB.
• If the Don’t allow HTML uploads as attachments or document records security setting is enabled for your organization, you cannot upload files with the following file extensions: .htm, .html, .htt, .htx, .mhtm, .mhtml, .shtm, .shtml, .acgi, .svg.

Prevent Others from Sharing and Unsharing a File
You can prevent others from sharing and unsharing a file you own. This doesn’t affect existing shares.

1. On Files home, find the file you want.
2. Go to Sharing Settings or Share File for the file. (Or, if the file is in a library, open the Content Detail page from the Libraries tab.)
3. Select the Prevent others from sharing and unsharing checkbox.
4. Click Save.

Example: Let’s say I post a file in Chatter, and share it with a private group. I’m okay with members of the group having access to the file, but I don’t want them to share it further. I can prevent sharing and unsharing so the existing shares remain but new ones can’t be added, except by me or an admin.
You can also prevent others from sharing and unsharing a file in the API by using the `SharingOption` field on `ContentVersion` and other objects.

**Share Files with People in Lightning Experience**

Share files with people privately and set **Viewer** or **Collaborator** access for each person you share the file with.

Share a file privately so only specific people in your company can see it. By default, anyone who can see a file can share it.

To share a file with one or more users in your company:

1. **Start by sharing the file from one of these locations:**
   - Next to the file on Files home—Click **Share**.
   - On the detail page of the file you want to share—Click **Share**.
   - From the file preview player—Click **Share**.

2. **Type the name of the person you want to share the file with and click the name to select it. Enter additional names if you wish to share with more than one person.**

3. **Choose the file permission you want them to have. By default, they have collaborator permission which lets them view, download, share, change permission, edit the file, and upload new versions. Select **Viewer** to give them permission to view, download, and share files.**

4. **Optionally, add information to the message that recipients receive.**

5. **Click **Share** and **Close**. Recipients receive a message that you have shared a file with them, along with a link to the file. Lightning Experience users receive this message as an email notification. Salesforce Classic users get a private Chatter message on their My Messages page on the Chatter tab, and also get an email notification if they have email notifications for Chatter messages enabled.**

On the Sharing Settings dialog box, click **next to a person’s or group’s name to stop sharing the file with them.**

From the Share File window, click **Who Can Access** to see everyone the file has been shared with. Update file permissions or click X next to the name of a person or group to stop sharing the file with them. If you want to prevent others from changing who can access the file, select **Prevent others from sharing and unsharing.**

**Note:**

- Documents from the Documents tab and attachments from the Notes and Attachments related list aren’t listed on Files home and can’t be shared as Salesforce Files.
- Content files may be shared with more people than shown in **Share with People** if they are part of a content pack or delivery.
- The maximum number of times a file can be shared is 100. This includes files shared with people, groups, and via links. If a file is privately shared and nears the 100 share maximum, consider making the file public by posting it to your feed.

**Share Files via Link**

Available in: Salesforce Classic

Available in: **Group, Enterprise, Professional, Performance, Unlimited, Contact Manager**, and Developer Editions
In Salesforce Classic, you can share a file with anyone by creating a file link and sending it via email or IM. Creating a link generates an encrypted URL that you can send to any recipient, such as leads, customers, partners, and coworkers, inside or outside of your company. When your recipients click the link, they see a web-based version of the file that they can easily view and download. Sharing via link is available in Salesforce Classic, and is on by default for most orgs. Administrators can enable sharing via link by enabling these permissions:

1. From Setup, enter Content Deliveries in the Quick Find box, then select Content Deliveries. Select Enable content deliveries and Enable Creation of Content Deliveries for Salesforce Files.

2. From Setup, enter Permission Sets in the Quick Find box, then select Permission Sets. Select a permission set, click System Permissions, and select Create and Share Content Deliveries for Salesforce Files.

3. From Setup, enter Profiles in the Quick Find box, then select Profiles. Select a profile, click Edit. In General User Permissions, select Create and Share Content Deliveries for Salesforce Files. You don't need this permission for files in a shared Salesforce CRM Content library. Instead, complete steps 1 and 2 and then ensure that the user is a library member and that Deliver Content is checked in the library permission definition.

Create and share a file link:

1. Start by sharing the file from one of these locations:
   - On Files home — Click Upload files, select a file from your device, then click Sharing Settings and choose Anyone with Link. Copy the link provided to share with people inside or outside your company.
   - On the Home page — Click Create New > File, click Choose File and select a file from your computer, then click Share via link from the dropdown menu.
   - On a file detail page — Click File Sharing Settings > Via link.
   - On the Sharing Settings dialog box — Click Anyone with link from the Share with list.
   - Next to the file on the Files page, the Files Owned by list, or the Group Files list — Click ▼ > Share via link.
   - Next to the file in a feed or on a file hover — Click More Actions > File Sharing Settings, then click Anyone with link from the Share with list.
   - In your Salesforce Files Sync folder on your desktop — Right-click on a file, hover on Salesforce Files Sync, then click Share via link.

2. Click Copy if available (or copy the link manually), and paste the link into an email or IM. File link recipients can only view and download files. They can’t be collaborators.

Unless the file was already shared with your company, it’s privately shared and displays the privately shared icon (🔒). It’s not posted anywhere and only the people you specifically shared it with can find and view it. If it was already shared with your company, it retains the your company icon (галза) and anyone in your company can find and view it.

On the Sharing Settings dialog box, click x next to a link to stop sharing it. Anyone with the link will no longer be able to access the file.

**Note:**
- Documents from the Documents tab and attachments from the Notes and Attachments related list aren’t listed on Files home and can’t be shared as Salesforce Files.
- The maximum number of times a file can be shared is 100. This includes files shared with people, groups, and via links. If a file is privately shared and nears the 100 share maximum, consider making the file public by posting it to your feed.

SEE ALSO:
- Creating Content Deliveries
File Updates in the Feed

Follow a file to see file updates in your feed, view a file’s version history, and get file recommendations.

IN THIS SECTION:

Follow a File

Follow a file to see updates in your Chatter feed, including when a new version of the file is uploaded. If you stop following a file, the file remains in your Files list, but you won’t see updates about it in your feed anymore.

View File Version History

File Recommendations

Follow a File

Follow a file to see updates in your Chatter feed, including when a new version of the file is uploaded. If you stop following a file, the file remains in your Files list, but you won’t see updates about it in your feed anymore.

Click + Follow to start seeing updates, or click x Unfollow to stop seeing updates. In Lightning Experience, follow a file from the file detail page. In Salesforce Classic, follow a file from a feed, file detail page, or files list.

Note: The option to follow files is only available in organizations that use Chatter.

SEE ALSO:

Upload a New Version of a File

View File Version History

The file detail page shows the current version number of the file. View the Version History list to see all versions of the file that have been uploaded, including the current version. From the list you can download the file, see who updated it and when, and see the description if provided. The file detail page always shows the most current version of a file.

SEE ALSO:

Upload a New Version of a File
Follow a File
File Recommendations

Chatter recommends files that you might want to follow based on the popularity of the file, determined by the number of people who have viewed or downloaded the file. To see an expanded list of your recommendations, click More in the Recommendations section. If no recommendations appear, then you already follow all the recommended files.

SEE ALSO:

Follow a File

File Previews and Details

View and edit file details, and report on files.

IN THIS SECTION:

View File Details
Edit File Details
Delete a File from the File Detail Page
View Where a File is Shared

Find out who can see a file, and what level of access they have. From the File Detail page, you can access a full list of every person or object the file is shared with.

File and Content Engagement Report

See how many times a file has been downloaded, shared, liked, and commented on.

View File Details

To open file details, click a file name in a feed, on a files list, on a file hover, or by clicking More Actions > Preview next to the file in a feed. On the file detail page, you can see details about Salesforce Files.

From a file detail page, you can:

• View the file without downloading it. Use the arrow keys in the document previewer to see each page, zoom in or out, or change the preview width and screen size. Files owners and anyone with access to the file can preview it.

  Note: Not all files can be previewed, such as encrypted files, password-protected files, copy-protected PDFs, unknown file types, and any file larger than 25 MB. For files that can’t be previewed, the Preview option isn’t available on feeds or list views, and files appear as generic file type icons in the feed. Some Microsoft Office 2007 features don’t display correctly in previews. If a file can be previewed, but a preview doesn’t exist, contact your Salesforce administrator who may be able to regenerate the preview.

• See if the file is private (🔒), privately shared (👤), or shared with your company (👥).
• Click Download to open or save the file. Anyone who can see a file can download it.
Click File Sharing Settings to share a file with people, groups, or via file link, or see the Sharing Settings. By default, anyone who can see a file can share it.

Click Make private on the Sharing Settings dialog box to remove the file and file link, if applicable, from everywhere it’s been shared. Or click Restrict access if the file originated in a Salesforce CRM Content library to remove the file from everywhere it’s been shared except the library. Only owners and users with the “Modify all Data” permission can make a file private (✓) or restrict access.

Click Upload New Version to update the file with a newer version. Only file owners, collaborators, and users with the “Modify all Data” permission can upload a new version of a file.

Click Edit Details to edit the name or description of the file. Only file owners, collaborators, and users with the “Modify All Data” permission can edit file details.

If you have the “Sync Files” permission and are the owner of the file, click Sync to sync a file between your Salesforce Files Sync folder on your computer and Chatter. Click Unsnc to stop syncing the file.

Click Delete to delete the file. Only file owners and users with the “Modify All Data” permission can delete files.

See who the file is owned by and when it was last modified.

See the file’s description and click the edit icon (✓) to edit the description, or add a description by clicking Add Description.

See the file’s current version number and click Show all versions to see the file’s version history.

Click Show file report to see data about the file, such as how many times the file has been downloaded, shared, liked, and commented on. Show file report is visible only to users with the “Run Reports” and “View Reports in Public Folders” permissions.

Click Follow to follow the file or click to stop following the file.

See who’s following the file.

See who and what locations the file is shared with.

If the file originated in Salesforce CRM Content, click Go to Content Detail Page to see the content detail page of that file. Most actions performed on files that originated in Salesforce CRM Content must be done on the file’s content detail page instead of the file detail page.

Click the Files or Chatter links at the top of the page to go to the Files list or the Chatter page.

See other files that people who viewed this file also viewed. If no other files have been viewed by the same people, the People Also Viewed section doesn’t appear on the file detail page.

SEE ALSO:
View File Version History
View Where a File is Shared

Edit File Details

To edit a file’s name and description:

1. On a file detail page, click Edit Details or click the edit icon (✓) next to the description.
2. Optionally, edit the file name and description.
3. Click Save.

If there is no description and you want to add one, click Add Description or click the edit icon (✓) next to the description.
File owners, collaborators, and users with the “Modify All Data” permission can edit file details.

SEE ALSO:
  View File Details

Delete a File from the File Detail Page

Click **Delete** on a file’s detail page to delete the file and remove it from all locations where it’s been shared. If the file is shared via link, anyone with the link will no longer have access to the file. To restore the deleted file, click on the **Recycle Bin** link on the **Home** page. Select the file and click **Undelete**. The file is restored as well as all of the shares that were associated with it.

**Note:** Only file owners and users with the “Modify All Data” permission can delete files. To learn who can perform which actions on a file, see **Who Can See My File?**.

SEE ALSO:
  Delete Files and Links from Feeds

View Where a File is Shared

Find out who can see a file, and what level of access they have. From the File Detail page, you can access a full list of every person or object the file is shared with.

The **Shared With** list on a file detail page shows you who the file is shared with, and their level of access.

In Salesforce Classic, click **Show All** to open Sharing Settings, where you can:

- See who the file is shared with and their permission: owner, collaborator, viewer, or no access.
- Click **People** on the Sharing Settings dialog box to share the file with specific people.
- Click **Groups** on the Sharing Settings dialog box to share the file with specific groups.
- Click **Library** to share the file with a library.
- Click **Anyone with link** on the Sharing Settings dialog box to create and share a file link.
- Click **Make private** to remove the file and file link, if applicable, from everywhere it’s been shared. Or click **Restrict access** if the file originated in a Salesforce CRM Content library to remove the file from everywhere it’s been shared except the library. Only owners and users with the “Modify all Data” permission can make a file private (or restrict access).
- On the Sharing Settings dialog box, click **x** next to a person’s or group’s name to stop sharing the file with them.

SEE ALSO:
  Make a File Private
  Who Can See My File?

EDITIONS

Available in: both Salesforce Classic and Lightning Experience

Available in: **Group**, **Enterprise**, **Professional**, **Performance**, **Unlimited**, **Contact Manager**, and **Developer** Editions
File and Content Engagement Report

See how many times a file has been downloaded, shared, liked, and commented on.

From the file detail page, click Show file report to run and view the File and Content Engagement report, which has these fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Number of times users...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Downloads</td>
<td>Downloaded the file.</td>
</tr>
<tr>
<td>Posts</td>
<td>Posted the file to a feed. This number doesn’t count the number of times the file has been attached to comments on posts.</td>
</tr>
<tr>
<td>Post Comments</td>
<td>Commented on file posts in feeds.</td>
</tr>
<tr>
<td>Likes</td>
<td>Liked file posts on feeds. This number doesn’t count likes received by comments on the file post.</td>
</tr>
<tr>
<td>Shares</td>
<td>Shared the file using Share with people and Share with groups. If a user clicks Share on a file post, it’s counted as a post and not as a share.</td>
</tr>
<tr>
<td>Links</td>
<td>Shared the file using Share via link. If the file is uploaded to a Salesforce CRM Content library, then content deliveries are also counted.</td>
</tr>
</tbody>
</table>

Example: Numbers in the File and Content Engagement report are cumulative for all versions of a file. For example, if there are 2 versions of the file, and version 1 has been downloaded 4 times while version 2 has been downloaded 5 times, then Total Downloads reports 9 downloads.

Salesforce Files Sync

View and edit file details, and report on files.

IN THIS SECTION:

- Get Started with Salesforce Files Sync
- Salesforce Files Sync makes file management, syncing, and sharing easier than ever!
- Salesforce Files Sync System Requirements
- Salesforce Files Sync runs best on systems that meet the minimum recommended system requirements.
- Install Salesforce Files Sync
- Install the Salesforce Files Sync client on your desktop to sync files between your computer, Salesforce, and Salesforce1 on mobile devices.
- Salesforce Files Sync System Requirements
- Salesforce Files Sync runs best on systems that meet the minimum recommended system requirements.
Connect Salesforce Files Sync to Other Salesforce Organizations

Configure Salesforce Files Sync to connect to other Salesforce organizations.

Sync Files and Folders

Sync files and folders by saving them in your Salesforce Files Sync folder on your computer or by clicking Sync while viewing a file in a feed post, comment, file list, or file detail page.

Access Synced Files on Your Computer, Online, and on Mobile Devices

Access synced files in your Salesforce Files Sync folder on your desktop, in Salesforce online, and in Salesforce1 on your mobile device.

Working with Synced Files and Folders

Synced files and folders are just like any other file in Salesforce, but they have a few additional features.

Share Synced Files

Synced files can be shared directly from the Salesforce Files Sync folder on your desktop.

Manage Versions of Synced Files

Just like all Salesforce files, you can work with prior versions of a synced file as needed.

Salesforce Files Sync Limits

Be aware of file syncing limits while using Salesforce Files Sync.

Salesforce Files Sync Storage Limits

Two storage limits affect Salesforce Files Sync: shared organization-wide storage and individual storage.

File Names and Extensions that Prevent Syncing

Some file characteristics can prevent files from syncing between your devices and the Web.

Synced Folder Name Restrictions

Some folders aren’t synced by Salesforce Files Sync because of folder name restrictions.

Get Started with Salesforce Files Sync

Salesforce Files Sync makes file management, syncing, and sharing easier than ever!

Watch a Demo: Get Started with Salesforce Files Sync

Getting started with Salesforce Files Sync is almost effortless. Just save your files in the Salesforce Files Sync folder on your desktop, and Salesforce Files Sync does the rest.

Access your synced files anywhere

Saving a file in Salesforce Files Sync means that the file is automatically available everywhere you need it. Just look in the Synced filter in Files home — it’ll be there.

Share files right from the Salesforce Files Sync folder on your desktop

Right-click on a file to share it with people and groups in Chatter, or share the file with anyone using a link.

Always have the latest version of every file

Whenever you or one of your collaborators edit a file saved in the Salesforce Files Sync folder on your desktop, the file is instantly updated for everyone. Salesforce Files Sync supports versioning, so you can access older versions of the file, just in case.

Salesforce Files Sync System Requirements

Salesforce Files Sync runs best on systems that meet the minimum recommended system requirements.

To use Salesforce Files Sync, we recommend:
**System Requirement** | **Windows** | **Mac**
---|---|---
Supported operating systems | Microsoft® Windows® 7 and later | Apple® Mac OS X 10.8 Mountain Lion and later
Processors | 2.33 GHz or faster x86-compatible processor, or Intel® Atom™ 1.6 GHz or faster processor for netbook devices | Intel® Core™ Duo 1.83 GHz or faster processor
Memory | 512 MB of RAM (1 GB recommended) | 512 MB of RAM (1 GB recommended)
Hard drive | 4 GB of free space recommended for sync operations | 4 GB of free space recommended for sync operations

**Install Salesforce Files Sync**

Install the Salesforce Files Sync client on your desktop to sync files between your computer, Salesforce, and Salesforce1 on mobile devices.

1. From your personal settings, enter *Files Sync* in the Quick Find box, then select *Salesforce Files Sync*. Multiple results? Select the one under Personal Setup.
2. Click *Download*.
3. Follow the installation instructions for your operating system.
4. Log in with your Salesforce credentials.

After Salesforce Files Sync is installed, you’re notified automatically when an update is available.

> **Note:** Salesforce Files Sync client must run on a local drive. External locations such as network drives or mounted devices are not supported.

**Salesforce Files Sync System Requirements**

Salesforce Files Sync runs best on systems that meet the minimum recommended system requirements.

To use Salesforce Files Sync, we recommend:

<table>
<thead>
<tr>
<th>System Requirement</th>
<th><strong>Windows</strong></th>
<th><strong>Mac</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Supported operating systems</td>
<td>Microsoft® Windows® 7 and later</td>
<td>Apple® Mac OS X 10.8 Mountain Lion and later</td>
</tr>
<tr>
<td>Processors</td>
<td>2.33 GHz or faster x86-compatible processor, or Intel® Atom™ 1.6 GHz or faster processor for netbook devices</td>
<td>Intel® Core™ Duo 1.83 GHz or faster processor</td>
</tr>
<tr>
<td>Memory</td>
<td>512 MB of RAM (1 GB recommended)</td>
<td>512 MB of RAM (1 GB recommended)</td>
</tr>
<tr>
<td>Hard drive</td>
<td>4 GB of free space recommended for sync operations</td>
<td>4 GB of free space recommended for sync operations</td>
</tr>
</tbody>
</table>

**Connect Salesforce Files Sync to Other Salesforce Organizations**

Configure Salesforce Files Sync to connect to other Salesforce organizations.
After disconnecting Salesforce Files Sync from one Salesforce organization, your synced files are backed up in a folder called “Salesforce Files_Old.” On Windows, the backup folder is located at C:\Users\User Name\Salesforce Files_Old where User Name is your Windows user name. On Mac, the backup folder is located at /Users/User Name/Salesforce Files_Old where User Name is your Mac user name. Your synced files are always accessible online in the Salesforce organization they’re synced with.

⚠️ Warning: Before connecting Salesforce Files Sync to a new Salesforce organization, close all files and folders saved in your Salesforce Files Sync folder. Any files and folders that are open when you disconnect Salesforce Files Sync from a Salesforce organization aren’t backed up and automatically sync with the next Salesforce organization that you connect Salesforce Files Sync to.

To sync files with a different Salesforce organization, set up a new connection for Salesforce Files Sync.

1. In your system tray or menu bar, right-click Salesforce Files Sync.
2. Click Preferences.
3. If necessary, click Log out to disconnect your from your current Salesforce organization.
4. Under New Connection, enter a Name for the new connection.
5. Enter the https:// login URL for your Salesforce organization.
6. Click Log in.
7. Enter your login credentials and click Log in.
8. Click Allow to enable Salesforce Files Sync.

After connecting to the new organization, any files you add to your Salesforce Files Sync folder sync with that organization. If you’ve already synced files with the organization that you’re connecting to, the synced files automatically download to the Salesforce Files Sync folder on your desktop.

Sync Files and Folders

Sync files and folders by saving them in your Salesforce Files Sync folder on your computer or by clicking Sync while viewing a file in a feed post, comment, file list, or file detail page.

Watch a Demo: Salesforce Files Sync (Salesforce Classic)

Before you can sync files, you must install Salesforce Files Sync on your desktop.

Synced files are private by default. That means that after saving a file in your Salesforce Files Sync folder on your desktop, only you can access it in Salesforce online. Collaborate with others by sharing your synced files.

You always have the latest version of synced files available in your Salesforce Files Sync folder on your desktop, online in Salesforce, and in Salesforce1 on mobile devices. Just like other files in Salesforce, you can access previous versions of synced files.

To sync your files:

1. From the Salesforce Files Sync client, either save your files in your Salesforce Files Sync folder or drag and drop the files you’d like to sync into your Salesforce Files Sync folder.

   On Windows, your Salesforce Files Sync folder is located at C:\Users\User Name\Salesforce Files, where User Name is your Windows user name. On Mac, your Salesforce Files Sync folder is located at /Users/User Name/Salesforce Files, where User Name is your Mac user name.

   From the Files tab, a feed post, or anywhere in the full Salesforce site where a file is posted or listed, click Sync.

2. The files sync.
After your files sync, you can easily access them in Salesforce and in Salesforce1 on mobile devices. If you delete a file from your Salesforce Files Sync folder, you can still access the file in the Owned by Me filter in Files home.

Access Synced Files on Your Computer, Online, and on Mobile Devices
Access synced files in your Salesforce Files Sync folder on your desktop, in Salesforce online, and in Salesforce1 on your mobile device.

Find Synced Files on Your Desktop
On your desktop, your synced files are kept in your Salesforce Files Sync folder. On Windows, the Salesforce Files Sync folder is located at C:\Users\User Name\Salesforce Files, where User Name is your Windows user name. On Mac, the Salesforce Files Sync folder is located at /Users/User Name/Salesforce Files, where User Name is your Mac user name.

To open your Salesforce Files Sync folder from your system tray or menu bar, right-click Salesforce Files Sync > Open Salesforce Files Sync Folder.

⚠️ Warning: Moving your Salesforce Files Sync folder from its default directory location prevents file syncing. To ensure that your files always sync, don’t move your Salesforce Files Sync folder.

Find Synced Files in Salesforce
In Salesforce, your synced files are available in Files home.

From Files home, click Synced to view your synced files and folders. Your most recently synced files are listed first.

Find Synced Files on Your Mobile Device
On your mobile device, your synced files are accessible in Salesforce1.

From Files home, tap and select Synced to view a list of your synced files.

Working with Synced Files and Folders
Synced files and folders are just like any other file in Salesforce, but they have a few additional features.

Synced files are private by default. That means that after saving a file in your Salesforce Files Sync on your desktop, only you can access it in Salesforce online. Collaborate with others by sharing your synced files.

You always have the latest version of synced files available in your Salesforce Files Sync folder on your desktop, online in Salesforce, and in Salesforce1 on mobile devices. Just like other files in Salesforce, you can access previous versions of synced files in Chatter.

Share Synced Files
Synced files can be shared directly from the Salesforce Files Sync folder on your desktop.

Share synced files with people and Chatter groups in your organization, or people outside your organization using a generated link.

Synced files are private by default, but when you share them you can assign view-only or collaborator privileges.

If you share a file with a person or group with Collaborator rights, then when collaborators download, edit, and upload a new version of the file, you’ll get the latest version automatically synced. When you edit and sync a new version of the file, the people and groups you’ve shared with will automatically get the latest version too.

To share a file directly from your Salesforce Files Sync folder:

1. On your desktop, in your Salesforce Files Sync folder, right-click the file you’d like to share.
2. Choose a menu option under Salesforce Files Sync: share with people in your organization, with Chatter groups, or with people outside your organization via link.

3. When prompted, enter the names of the people or groups in your organization, assign Viewer or Collaborator permission, and enter an optional message to share the file with them. If you’re sharing the file via link, copy the link.

4. Click Share.
   An email notification is sent to everyone you shared the file with.

**Manage Versions of Synced Files**

Just like all Salesforce files, you can work with prior versions of a synced file as needed.

After you first sync a file, you see that file as Version 1 in your files list. If you make changes to it on your computer or mobile device, a new version is automatically created each time you save the file. To view previous versions, just visit the file detail page.

Anyone who is following the synced file receives a notification in their Chatter feed when new versions are created. File collaborators can upload new versions of your synced files.

⚠️ **Warning:** If a synced file is open on your desktop when a collaborator uploads a new version, then you won’t receive the new version until you close the file without saving. If you save your open file, your version will overwrite your collaborator’s changes.

**Salesforce Files Sync Limits**

Be aware of file syncing limits while using Salesforce Files Sync.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Organization-wide storage</td>
<td>Storage is based on the number of Salesforce licenses purchased.</td>
</tr>
<tr>
<td>Maximum number of synced files</td>
<td>Users can sync up to 10,000 files.</td>
</tr>
<tr>
<td>Maximum number of synced folders</td>
<td>500 folders</td>
</tr>
<tr>
<td><strong>File size</strong></td>
<td></td>
</tr>
<tr>
<td>Maximum number of versions per file</td>
<td>2,048</td>
</tr>
<tr>
<td>Maximum number of users who can sync the same file simultaneously</td>
<td>1,000 users</td>
</tr>
</tbody>
</table>

Salesforce Files Sync continues to sync existing files, but won’t sync new files if:
• Your Salesforce Files Sync folder exceeds 10 GB of files.
• Your organization reaches its shared file storage limit.
• Your Salesforce Files Sync folder contains more than 10,000 files or 500 folders.
• The new file’s file size exceeds the individual file size limit.

Salesforce Files Sync stops syncing files if:

• You move your Salesforce Files Sync folder from its default directory location. On Windows, the default directory location is \Users\User Name\Salesforce Files, where User Name is your Windows user name. On Mac, the default directory location is /Users/User Name/Salesforce Files, where User Name is your Mac user name. Salesforce Files Sync resumes syncing after the Salesforce Files Sync folder is returned to the default directory location.

Salesforce Files Sync Storage Limits

Two storage limits affect Salesforce Files Sync: shared organization-wide storage and individual storage.

Shared Organization-Wide Storage

Your organization’s shared file storage equals the file storage allocation per organization, plus the per-user allocation multiplied by the number of users in your organization.

If your organization is using its entire shared storage allocation, then Salesforce Files Sync will continue to sync your existing files, but won’t sync new files unless you or your organization removes existing files or purchases more storage from Salesforce.

<table>
<thead>
<tr>
<th>Salesforce Edition</th>
<th>File Storage Allocation Per Organization</th>
<th>File Storage Allocation Per User License</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact Manager</td>
<td>10 GB</td>
<td>612 MB</td>
</tr>
<tr>
<td>Group</td>
<td>10 GB</td>
<td>612 MB</td>
</tr>
<tr>
<td>Professional</td>
<td>10 GB</td>
<td>612 MB</td>
</tr>
<tr>
<td>Enterprise</td>
<td>10 GB</td>
<td>2 GB</td>
</tr>
<tr>
<td>Performance</td>
<td>10 GB</td>
<td>2 GB</td>
</tr>
<tr>
<td>Unlimited</td>
<td>10 GB</td>
<td>2 GB</td>
</tr>
<tr>
<td>Developer</td>
<td>20 MB</td>
<td>N/A</td>
</tr>
<tr>
<td>Personal</td>
<td>20 MB</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Note: If your organization uses custom user licenses, contact your administrator to determine if these licenses provide additional storage.

Individual Storage

Salesforce Files Sync syncs up to 10 GB of files between the Salesforce Files Sync folder on your desktop, Salesforce on the Web, and mobile devices with Salesforce1. Salesforce Files Sync will continue to sync your existing files, but won’t sync your new files if you add more than 10 GB of files to your Salesforce Files Sync folder. If you reach the individual 10 GB storage limit, you must remove existing files to sync new files.
File Names and Extensions that Prevent Syncing

Some file characteristics can prevent files from syncing between your devices and the Web.

- Zero-byte files
- Files without an extension
- Files with names that start with:
  - AUX.
  - CLOCK$.
  - COM1.
  - COM2.
  - COM3.
  - COM4.
  - COM5.
  - COM6.
  - COM7.
  - COM8.
  - COM9.
  - CON.
  - LPT1.
  - LPT2.
  - LPT3.
  - LPT4.
  - LPT5.
  - LPT6.
  - LPT7.
  - LPT8.
  - LPT9.
  - NUL.
  - PRN.
  - ~
  - .

- Files with these names:
  - desktop.ini
  - thumbs.db
  - .DSStor

- Files with these extensions:
  - .tmp
  - .conflicted
  - .part
  - .partial
Different operating systems have different file name restrictions. Salesforce Files Sync syncs any file whose name is allowed by your operating system. That means that if you can name a file on your desktop, you can sync it using Salesforce Files Sync. If you sync a file from Mac® OS X®, it will sync to the Web, but if the file name isn’t allowed by Microsoft Windows®, the file won’t download to your Windows desktop.

To ensure all your files sync between all your computers, avoid using these characters in file names:

- \ (backslash)
- : (colon)
- * (asterisk)
- ? (question mark)
- ' (apostrophe)
- < (less than sign)
- > (greater than sign)
- / (slash mark)
- | (pipe)
- TM (trademark symbol)
- ∞ (infinity sign)
- § (section)
- • (bullet point)
- ≠ (not equal to)
- ` (grave accent)
- " (quotation marks)
- ... (ellipsis)
- ≥ (greater than or equal to sign)
- ≤ (less than or equal to sign)
- & (ampersand)

- Files with names longer than 254 characters

**Synced Folder Name Restrictions**

Some folders aren’t synced by Salesforce Files Sync because of folder name restrictions.

Different operating systems have different folder name restrictions. Salesforce Files Sync syncs any folder whose name is allowed by your operating system. That means that if you can name a folder on your desktop, you can sync it using Salesforce Files Sync. If you sync a folder from Mac® OS X®, it will sync to the Web, but if the folder name isn’t allowed by Microsoft Windows®, the folder won’t download to your Windows desktop.

To ensure all your files sync between all your computers, avoid using folder names that:

- Contain these characters:
  - / (forward slash)
  - \ (backslash)
• Exceed 255 characters
• Are identical to another folder name in the same directory

Files Connect External Files

Browse, search, and share files that are stored elsewhere right from Salesforce.

IN THIS SECTION:

Authenticate to Files Connect External Data Sources
If your administrator configured a data source like SharePoint to employ per-user authentication, provide your credentials for that system in Salesforce.

Access and Share External Files Using Files Connect
After your admin enables Files Connect, you can access files from external sources like Google Drive and SharePoint, or share them via feeds and Files home.

Search for External Files with Files Connect
Search an external data source like Google Drive, Box, or SharePoint right within Salesforce.
Authenticate to Files Connect External Data Sources

If your administrator configured a data source like SharePoint to employ per-user authentication, provide your credentials for that system in Salesforce.

IN THIS SECTION:

Set Up Authentication to an External Data Source
When you connect to a Files Connect external data system for the first time, set up your authentication in just a few clicks.

Manage Your External Data Source Authentication Credentials
You or your Salesforce admin can set up and manage your authentication settings for external data sources using Files Connect. With valid authentication settings, you can access files from external systems right from Salesforce.

EDITIONS
Available in: both Salesforce Classic and Lightning Experience
Files Connect for cloud-based external data sources is available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions
Files Connect for on-premises external data sources is available for an extra cost in: Enterprise, Performance, Unlimited, and Developer Editions

USER PERMISSIONS
To access cloud-based data sources like SharePoint Online:
• “Files Connect Cloud”
To access on-premises data sources like SharePoint 2010:
• “Files Connect On-premises”
Set Up Authentication to an External Data Source

When you connect to a Files Connect external data system for the first time, set up your authentication in just a few clicks.

If you haven’t set up your authentication to an external data system in My Settings, you are prompted to authenticate the first time you try to access an external system in Salesforce. Click the link or button to complete most of the authentication automatically.

• If you are connecting to Box, Google Drive, SharePoint Online, or OneDrive for Business:
  1. Select OAuth 2.0 as the authentication protocol.
  2. When you see a message requesting permission for Salesforce to access information from your external system, click Allow.
  3. After the authentication process has finished, you are redirected to Salesforce.

• If you are connecting to SharePoint 2010 or SharePoint 2013:
  1. You are redirected to Authentication Settings for External Systems.
  2. Enter your username and password credentials for the external system.

EDITIONS
Available in: both Salesforce Classic and Lightning Experience

Files Connect for cloud-based external data sources is available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Files Connect for on-premises external data sources is available for an extra cost in: Enterprise, Performance, Unlimited, and Developer Editions

USER PERMISSIONS
To access cloud-based data sources like SharePoint Online:
• “Files Connect Cloud”
To access on-premises data sources like SharePoint 2010:
• “Files Connect On-premises”
Manage Your External Data Source Authentication Credentials

You or your Salesforce admin can set up and manage your authentication settings for external data sources using Files Connect. With valid authentication settings, you can access files from external systems right from Salesforce.

Your admin defines external systems in external data sources and named credentials. Before you begin, your administrator:

• Sets up the external data source or named credential to use per-user authentication.
• Grants you access to the external data source or named credential.
• Tells you the authentication settings to enter.

If you don’t see the expected settings or options, ask your admin for help.

1. From My Settings, enter Authentication in the Quick Find box, then select Authentication Settings for External Systems.
2. Click New to set up a new connection. Click Edit to modify an existing external data source.
3. From the External System Definition menu, select “External Data Source.”
4. From the External Data Source menu, select a data source created by your administrator.
5. Select the authentication protocol required by the external system.

For SharePoint 2010 or 2013, set the following options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Protocol</td>
<td>Choose Password Authentication</td>
</tr>
<tr>
<td>Username and password</td>
<td>Enter your SharePoint username and password</td>
</tr>
</tbody>
</table>

For Box, Google Drive, SharePoint Online, or OneDrive for Business, set the following options.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Protocol</td>
<td>Choose OAuth 2.0</td>
</tr>
<tr>
<td>Authentication Provider</td>
<td>Choose the provider created for this data source by your administrator</td>
</tr>
<tr>
<td>Scope</td>
<td>Leave blank</td>
</tr>
<tr>
<td>Start Authentication Flow on Save</td>
<td>Select to immediately verify your login credentials with the external data source. When you click Save, the external system prompts you to log in. After successful login, the external system grants you an OAuth token for accessing its data from this org. Redo the OAuth flow when you need a new token—for example, when the token expires—or if you edit the Scope or Authentication Provider fields.</td>
</tr>
</tbody>
</table>
6. Click **Save**.

**Access and Share External Files Using Files Connect**

After your admin enables Files Connect, you can access files from external sources like Google Drive and SharePoint, or share them via feeds and Files home.

**Download or Share Files on Files Home**

Download external files to your local system or share them with a general set of people in your organization from Files home.

1. Navigate to Files home.
2. The External Files list in the left column shows available external data sources. Select one and navigate through the folders, or use the search bar to find a file.

   **Note:** Salesforce supports Google documents, spreadsheets, presentations, and drawings.

   In the Recent list, Google Drive content is limited to the 24 most recently accessed documents from the last 30 days.

3. Click **next to the file name, and choose one of the following:**
   - **Open** the file in the external data source, such as SharePoint.
   - **Download** the file to your local system. (From on-premises systems like SharePoint 2010, 2 GB is the maximum download size.)
   - **Share** the file either as a copy or as a reference. Your admin has determined which type of sharing is used at your organization. When sharing, you do one of the following:
     - **Share a copy** of the external file stored in Salesforce. If files are shared with a Chatter group, all group members can access the files, even if they lack access to the external system. Salesforce Files doesn’t reflect any revisions to the file in external systems.
     - **Share a reference** to the external file stored outside Salesforce. Only users with access to the external system can download files. (Users must enter credentials for the system in the Authentication Settings for External Systems section of personal setup). Salesforce Files doesn’t reflect any revisions to the file in external systems, but the reference does point to the latest version of the file in those systems.

   **Note:** To download files referenced from an external system, users must enter credentials for the system in the Authentication Settings for External Systems section of personal setup.

   When a user selects an external file from the file selector, a file reference or copy is created in Salesforce. If a file reference already exists, it is reused.

**Share Files in the Feed**

If you want to include external files in a specific Chatter conversation, use the feed. All files shared in the feed are either copies or references, as determined by your administrator.

In Salesforce Classic

1. While authoring a post, click **File** above the feed, and then click **Select a file from Salesforce**.
2. In the left column, click the external source, such as SharePoint.
3. Next to the file you want to share, click Attach.

4. In the body of your post, @mention the groups or people you want to share with.

In Lightning Experience

1. While authoring a post, click the paperclip icon below the post to open the Select File window.
2. From the left column, click the external source, such as SharePoint or Google Drive.
3. Select the file you want to share and click Add.
4. In the body of your post, @mention groups or people that you want to share with.

When you paste a link to an external document into a Chatter post, it’s converted into a Files Connect file reference. Under the body of your post, the file title and icon appear. Click the icon to open the file preview right from your feed. A file reference is created for the first link in each post. File references are not created for links in comments.
SEE ALSO:

Share Files with People in Salesforce Classic
Share Files with Groups
Share Files with Libraries in Salesforce Classic
Search for External Files with Files Connect

Search an external data source like Google Drive, Box, or SharePoint right within Salesforce.

Search in a Specific External Data Source

In Salesforce Classic

1. From the left column of Files home or your Chatter feed, click the data source name.
2. In the search box, enter terms such as document title or author. (The specific information you can search for depends on the configuration of the external data source.)

Note: You can also search external data sources from the file selector when attaching a file to a Chatter post. In Salesforce Classic, click File above the feed, and then select a file from Salesforce. In Lightning Experience, click the paperclip icon below the post to open the Select File window.

Search Globally for Salesforce and External Data

If your administrator enables global search for an external data source, you can conveniently search its contents along with your Salesforce data.

In Salesforce Classic

1. In the global search box at the top of the Salesforce window, enter your search terms.
2. To filter the results down to a specific external data source, click its name in the left column (for example, “SharePoint Online”).

Tip: If you often want to see content from a specific external data source, pin it to the top of global search results: In the left column, hover over the data source name, and click the pin icon. (If you don’t see the data source listed, click Search All.)

In Lightning Experience

1. From Files home, enter a search term into the global search box in the header.
2. You can filter your search results to return only Files by selecting “In Files” after entering your search in the global search box, or by doing a global search and then selecting Files from the global search results.

Available in: both Salesforce Classic and Lightning Experience

Files Connect for cloud-based external data sources is available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Files Connect for on-premises external data sources is available for an extra cost in: Enterprise, Performance, Unlimited, and Developer Editions

To access cloud-based data sources like SharePoint Online:
• “Files Connect Cloud”

To access on-premises data sources like SharePoint 2010:
• “Files Connect On-premises”
Document Libraries

Store files without attaching them to records.

IN THIS SECTION:

Document Library Overview
Each document that is stored in the document library resides in a folder. The folder’s attributes determine the accessibility of the folder and the documents within it.

Documents Home
View Document Lists
Upload and Replace Documents
Search for Documents
Delete Documents
Moving Documents to Salesforce Files
As you make the move to Lightning Experience, you may have questions about the files you have stored in the Documents tab in Salesforce Classic.

Document Library Overview

Each document that is stored in the document library resides in a folder. The folder’s attributes determine the accessibility of the folder and the documents within it.

Document libraries store documents that aren’t attached to records. Access your library documents via the Documents tab. If your Documents tab is not visible, customize your display to show it.

Note: The Documents tab is not part of Salesforce CRM Content.

SEE ALSO:

Differences Between Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments
Clicking on the Documents tab displays the documents home page.

- **Note:** If the Documents tab is not visible, you can customize your display to show it.
- Under **Find a Document**, enter keywords to search for a document.
- In the **Document Folders** section, select a folder to view all the documents contained in that folder.
- The **Recent Documents** section displays the last ten or twenty-five documents you viewed, with the most recently-viewed document listed first. This list is derived from your recent items and includes records owned by you and other users. Toggle the **Show 25 items** and **Show 10 items** links to change the number of items that display.
- In the **Recent Documents** section, click **New** to upload a new document.
- **Note:** The Documents tab is not part of Salesforce CRM Content.

**SEE ALSO:**
- Upload and Replace Documents
- View Document Lists

### View Document Lists

The documents list page displays a list of documents in a selected folder. From this page, you can view detailed document information or manipulate the document.

- Click the document name to **view the document properties**.
- Click **Edit** next to a document to **edit the document properties**.
- Click **Del** to **move the document to the Recycle Bin**.
- Click **View** to open the file in its associated application. If a file type is not recognized or the application is not loaded on your machine, Salesforce displays a standard download dialog prompting you to choose a save option.
- Choose a folder to view a list of documents stored in that folder.
- Click any column heading to sort the documents in ascending or descending order by the information in that column.
- At the top of the list, click a letter to display the contents of the sorted column that begin with that character.
- Click **Next Page** or **Previous Page** to go to the next or previous set of documents.
- At the bottom of the document list, select **fewer** or **more** to view a shorter or longer display list.
- Click **Printable View** to display the current list view in a format that is ready for printing.
- **Note:** If you can’t find a document, you may not have access to the folder that contains it.

**SEE ALSO:**
- Change Document Authors
Upload and Replace Documents

Uploading a New Document

To upload a document:

1. Click **New Document** from the Documents tab or click **New** next to **Recent Documents** on the documents home page. If you do not have a New Document option, check if you have the correct permissions.

2. On the Upload New Document page, specify a descriptive **Document Name**. If you want to use the file name, leave this field blank. The file name will appear automatically when you upload the file.

3. If you have the “Customize Application” permission, enter a unique name to be used by the API and managed packages.

4. You can check one of the following:
   - **Indicate Document is Internal**: When checked, a flag is added to the document indicating that document viewers should not share the file outside of the organization.
     - **Note**: Checking this box does not expressly enforce any security rules.
   - **Externally Available Image** if the document is an image, such as a logo, that’s not confidential. Check this box to:
     - Make the image available from HTML email templates without requiring a Salesforce username and password
     - Use the image as a custom tab icon or custom app logo, which do require a Salesforce username and password to view
     - Display the image as a custom logo in meeting requests

   The **Indicate Document is Internal** and **Externally Available Image** checkboxes are mutually exclusive; you cannot select both.

5. Select a folder for the document.

6. Enter a description to use later as search criteria.

7. Enter keywords that you can use later as search criteria.

8. Select a document or path option.
   - To upload a document, click **Browse**, choose the file, and click **Open**.
   - To store a link to the document, enter the location of the document. Enter a path and file name or a URL such as:
     - C:\Quotes\quote.doc, \Server\Departments\Marketing\logo.doc, or
     - http://www.salesforce.com

9. Click **Save**.

Replacing a Document

To replace a document with an updated version:

1. Display the document you want to replace. For instructions on locating a document in the document library, see **Search for Documents**.

2. Click **Replace Document**.

3. Select a document or path option.
   - To upload a replacement, click **Browse**, choose the file, and click **Open**.
To store a link to the replacement, enter the location of the replacement. Enter a path and file name or a URL such as: C:\Quotes\quote.doc, \Server\Departments\Marketing\logo.doc, or http://www.salesforce.com.

4. Click Replace Document.

Tips for Uploading or Replacing Documents

• Documents stored as links cannot be attached to emails, but they save space in your document library.
• If your administrator enables document content search, Salesforce also performs a full-text search of the document. When a new document is uploaded or an old one is replaced, its contents are available for searches.
• Salesforce stores the most recent upload date as the modified date.
• You can upload documents that have file names of up to 255 characters including the extension.
• The size limit for any document you upload is 5 MB. The maximum size for a custom-app logo is 20 KB.
• Your organization’s used file storage includes all files stored in the document library.
• If the Don’t allow HTML uploads as attachments or document records security setting is enabled for your organization, you cannot upload files with the following file extensions: .htm, .html, .htt, .htx, .mhtm, .mhtml, .shtm, .shtml, .acgi, .svg.

SEE ALSO:
Display and Edit Document Properties

Search for Documents

To find specific documents, use the Find Document button on the documents home page.

1. Click the Documents tab.
2. Enter your search terms. Salesforce searches the following fields:
   • Document Name
   • Keywords
   • Description
3. Click Find Document.

The search returns a list of documents that match all your search terms. The search results are listed in order of the closest matches. The Keywords and Document Name fields are used to determine the closest matches. The fields you see are predefined and cannot be changed.

Tip: Use quotation marks around a phrase to search for the words in that sequence. For example, a search for “my logos” returns documents whose fields or content contains that exact phrase, as well as my and logos. Without quotation marks, your search returns any document whose fields or content includes any of the words in the search. For example, my logos returns documents whose fields or content contains my and logos.

4. Select any document to jump directly to the detail page for that document, or click View to open the document in a new window.

If your administrator enables document content search, Salesforce also performs a full-text search of the document. When a new document is uploaded or an old one is replaced, its contents are available for searches.
Note: Salesforce automatically determines if the contents of a document can be searched. If the Document Content Searchable property is checked on a document, then its contents have been processed successfully and can be searched. If your document is large, it may take several minutes before Salesforce searches the contents of a document and marks the Document Content Searchable property.

You can also find documents using global search.

1. Enter your search terms in the header search box.
2. Select Search Options... from the drop-down and select Documents to narrow your search results.
3. Click Search.

The following file types are supported for a document content search.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extensions</th>
<th>Maximum Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML (only the text within a &lt;body&gt; tag)</td>
<td>.htm, .html, .xhtml</td>
<td>5 MB</td>
</tr>
<tr>
<td>PDF</td>
<td>.pdf</td>
<td>25 MB</td>
</tr>
<tr>
<td>PPT</td>
<td>.pot, .pps, .ppt</td>
<td>25 MB</td>
</tr>
<tr>
<td>RTF</td>
<td>.rtf</td>
<td>5 MB</td>
</tr>
<tr>
<td>Text</td>
<td>.c, .cpp, .css, .csv, .ini, .java, .log, .sql, .txt</td>
<td>5 MB</td>
</tr>
<tr>
<td>Word</td>
<td>.doc, .dot</td>
<td>25 MB</td>
</tr>
<tr>
<td>XLS</td>
<td>.xls, .xlt</td>
<td>5 MB, or a maximum cell limit of 100,000 cells</td>
</tr>
<tr>
<td>XML</td>
<td>.xml</td>
<td>5 MB</td>
</tr>
</tbody>
</table>

In some instances documents are not searched. These include:

- If a file extension is changed to a different format, it is not searched, even if both extensions are valid. For example, a .txt file that is renamed to .rtf is not searched.
- PDF and Word documents may have security restrictions that prevent them from being searched. To ensure that the content is searchable, the “content extraction” property on your file must be set to “Enabled” when creating your document.

SEE ALSO:

Search for Content
Search for Files
Delete Documents

To delete a document, click Del next to the document on the documents list page. Alternatively, click Delete on the documents detail page.

When you delete a document, Salesforce stores it in the Recycle Bin. You can restore the document to your document library within that time by clicking Undelete from the Recycle Bin.

**Note:**
- You can delete any document in your personal folder but you can only delete a document in a public folder if you have the “Manage Public Documents” permission.
- If you delete a document that’s included in a letterhead or HTML email template, any emails using the letterhead or template display a broken link in its place. You can fix the broken link by removing the document from the Recycle Bin.
- You can’t delete a document that’s being used as a custom logo in meeting requests. To delete it, you must either select another document to use as a logo or uncheck the option to display a custom logo in meeting requests.

SEE ALSO:
- Document Properties

Moving Documents to Salesforce Files

As you make the move to Lightning Experience, you may have questions about the files you have stored in the Documents tab in Salesforce Classic.

**Can I see the files in the Documents tab in Salesforce Classic in Lightning Experience?**

The Documents tab isn’t available in Lightning Experience, but your document files aren’t going away. In fact, some features continue to rely on files in your Documents tab, like email templates. Don’t delete these documents, but do take this opportunity to add your working files and images as Salesforce Files so they’re usable in Lightning Experience.

**How will I work with my documents in Lightning Experience?**

Lightning Experience uses Salesforce Files to manage and collaborate on files. Salesforce Files unifies various content types to streamline and improve your experience: they can be stored privately, shared to libraries and groups, and updated with version history.

**How do I move files from the Documents tab into Lightning Experience?**

While there isn’t a one-click solution, you do have some options once you identify the files in the Documents tab that you want to use in Lightning Experience and your communities.

1. Export documents in the weekly export, and then upload the documents into Salesforce Files
2. Use a third-party data export tool from the AppExchange, like FileExporter from Salesforce Labs
3. Use an API-based tool (The Chatter REST API supports uploading asset files.)

Salesforce Files are the best way to save, organize, and share files in Salesforce. Salesforce Files continue to see improvements, so move your documents to Salesforce Files now and start taking advantage of them.
Properties

**Display and Edit Document Properties**

<table>
<thead>
<tr>
<th>USER PERMISSIONS</th>
<th>EDITIONS</th>
</tr>
</thead>
<tbody>
<tr>
<td>To view documents:</td>
<td>&quot;Read&quot; on documents</td>
</tr>
<tr>
<td>To update properties:</td>
<td>&quot;Edit&quot; on documents</td>
</tr>
<tr>
<td>To replace documents:</td>
<td>&quot;Edit&quot; on documents</td>
</tr>
<tr>
<td>To move documents:</td>
<td>&quot;Edit&quot; on documents</td>
</tr>
<tr>
<td>To delete documents:</td>
<td>&quot;Delete&quot; on documents</td>
</tr>
</tbody>
</table>

**Displaying Documents** - Once you have located a document on the documents home or list pages, click the document name to display detailed information.

**Editing Document Properties** - To update document properties, click **Edit**.

**Deleting Documents** - To delete a document, click **Delete**.

**Updating Documents** - To replace a document with an updated version, click **Replace Document**.

**Emailing Documents** - To email a document to a contact, click **Email Document**, fill in the details of the email, and click **Send**. The document is sent as an attachment to the email and is logged in the Activity History for the contact. Documents that reference URLs rather than physical files cannot be emailed. For a document that is an image embedded in an HTML email template, such as a logo in a letterhead, make sure the document is marked as **Externally Available** on the Documents tab so that a user who does not have a Salesforce username and password can view the image when it is received in an email.

**Searching a Document** - To search for a document, enter search terms and click **Find Document**. A list of documents that match your search terms displays. You can search for terms using the following fields:

- Document Name
- Keywords
- Description

If **Document Content Searchable** is checked, the content of a document can also be searched.

**Viewing Folder Contents** - To view all the documents in a folder, click the folder name.

**Moving Documents** - To store a document in a different folder, click **Edit**, choose a new folder, and click **Save**.

SEE ALSO:

  - Change Document Authors
Document Properties

Below is a description of the properties in alphabetical order that are stored for each document in the document library.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author</td>
<td>The main point of contact for a document. Initially, the person uploading the document is the author. Thereafter, the author can be any selected user.</td>
</tr>
<tr>
<td>Created By</td>
<td>The name of the person who originally uploaded the file.</td>
</tr>
<tr>
<td>Modified By</td>
<td>The name of the person who last uploaded the file.</td>
</tr>
<tr>
<td>Folder</td>
<td>The name of the folder that contains the document.</td>
</tr>
<tr>
<td>Document Content Searchable</td>
<td>A checkbox that indicates if the content within a document can be searched via the Find Document button on the Documents tab. This checkbox is automatically set by Salesforce.</td>
</tr>
<tr>
<td>Document Name</td>
<td>The name of the document including its file extension.</td>
</tr>
<tr>
<td>Document Unique Name</td>
<td>A unique name used to refer to the document when using the Force.com API. In managed packages, this name prevents naming conflicts on package installations. This name can contain only underscores and alphanumeric characters, and must be unique in your org. It must begin with a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores. With this field, a developer can change certain components’ names or titles in a managed package and the changes are reflected in a subscriber's organization.</td>
</tr>
<tr>
<td>Description</td>
<td>A statement distinguishing this document from others.</td>
</tr>
</tbody>
</table>
| Indicate Document is Internal| A checkbox that adds a flag to the document indicating that document viewers should not share the file outside of the organization. Checking this box does not expressly enforce any security rules. The Indicate Document is Internal and Externally

Available in: Salesforce Classic

Available in: All Editions except Database.com
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Image</td>
<td>Available Image checkboxes are mutually exclusive; you cannot select both.</td>
</tr>
<tr>
<td>Externally Available Image</td>
<td>A checkbox that indicates if the document is an image available for HTML email templates, such as a logo in a letterhead, and does not require a Salesforce username and password to view in an email. This checkbox indicates if the document is an image used as a custom app logo or custom tab icon, which requires a Salesforce username and password to view. The Indicate Document is Internal and Externally Available Image checkboxes are mutually exclusive; you cannot select both.</td>
</tr>
<tr>
<td>Keywords</td>
<td>An open text field containing one or more words that describe the document. The program checks for matches in this field when doing a search.</td>
</tr>
<tr>
<td>Path</td>
<td>Stored in place of Document Name if you prefer to create a link to the document instead of uploading it.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the document in bytes.</td>
</tr>
<tr>
<td>Type</td>
<td>The file type is determined by the file extension. For example, filename.ppt is recognized as a PowerPoint file. If the Don't allow HTML uploads as attachments or document records security setting is enabled for your organization, you cannot upload files with the following file extensions: .htm, .html, .htt, .htx, .mhtm, .mhtml, .shtm, .shtml, .acgi, .svg.</td>
</tr>
</tbody>
</table>

SEE ALSO:

- Change Document Authors
Change Document Authors

Since documents are stored in folders that control user access, documents do not have owners like other types of records, but they do have authors. The author represents the user that originally uploaded the document file.

To change the author of a document:

1. View the document you want to modify.
2. Click Change next to the Author field.
   
   The Change link displays only on the detail page, not the edit page. If you do not see the Change link, you may not have sufficient privileges to change a document author.
3. Enter a new author name. Alternatively, click the lookup icon to choose from a list of users.
4. Check the Send Notification Email box if you would like to alert the new author of this change.

Note: When you change document authorship, Salesforce does not change the document’s visibility.

SEE ALSO:
Display and Edit Document Properties

Salesforce CRM Content

Organize, share, search, and manage all types of files within your organization.

IN THIS SECTION:
Salesforce CRM Content Overview
Organize, share, search, and manage content within your organization and across key areas of Salesforce with Salesforce CRM Content. Content includes all file types, from traditional business documents such as Microsoft® PowerPoint presentations to audio files, video files, Web pages, and Google® docs.
View and Edit Libraries
Manage Libraries

Salesforce CRM Content Overview

Organize, share, search, and manage content within your organization and across key areas of Salesforce with Salesforce CRM Content. Content includes all file types, from traditional business documents such as Microsoft® PowerPoint presentations to audio files, video files, Web pages, and Google® docs.

To learn the different ways files are used in Salesforce, see Differences Between Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments.

Salesforce CRM Content simplifies content management by incorporating user-friendly features into the following tasks:
Organizing
Rather than keep files in folders that make content difficult to find, Salesforce CRM Content stores files in fully searchable file repositories known as libraries. Administrators can create multiple libraries based on any classification, such as department name, job function, or team, then configure user permissions within the library to balance content access with security. Authors assign descriptive labels called tags to help classify and organize content across libraries. You can view a list of all content that belongs to a particular tag or filter search results based on a tag or tags. Salesforce CRM Content also provides private libraries, which allow users to reduce the clutter on their desktops while using content-management benefits such as document search and version control.

Searching
The powerful Salesforce CRM Content search engine scans the entire body of the document as well as content properties such as the title, description, tags, categorization data, and author name. You can filter searches by featured content, file format, author, tags, libraries, or custom fields and then view the results with various levels of detail, providing an easy way to find relevant content quickly. If Chatter is enabled for your organization, you can also filter your search results by Chatter files. The “smart bar” graphic for downloads, comments, ratings, and subscribers allows you to compare documents within a search result set.

Subscribing
Once a file is located, subscribing to it ensures that you receive an email notification when new versions are published or changes are made to the file's properties. You can also subscribe to authors, tags, and libraries, thus reducing the time spent searching for new or updated content. Notification emails will arrive real-time or once daily, depending on your preferences.

Previewing
In Salesforce CRM Content you do not need to download a large document to determine if its content is relevant to you. The content details page provides document details at a glance, including document title, author, description, tags, libraries, comments, votes, versions, subscribers, and downloads. If the document is a Microsoft PowerPoint, Word, Excel, or Adobe PDF file, you can preview the entire file in your browser without downloading it. Some aspects of files may not be displayed in previews. Copy-protected PDFs can’t be previewed.

Contributing
Uploading new or revised files in Salesforce CRM Content is fast and easy. During the upload process you choose a library and record type for your file or Web link, write a description, assign one or more tags, and fill out any customized fields that help categorize and define your content. Version management does not require checking files in and out, rather, you simply upload a new version of the file and Salesforce CRM Content maintains a version list accessible from the content details page. You can download past versions of a file and read all reason-for-change comments that an author may have included with a new version.

Reviewing Usage and Providing Feedback
Salesforce CRM Content provides several methods for determining whether content is valuable to readers. Featuring a piece of content increases its visibility in search results. Voting thumbs up or thumbs down on a file, Web link, or Google doc and adding comments allow you to participate directly in content improvement. You can also see who has subscribed to a file, link, or doc and how many times files have been downloaded. The Reports tab allows you to create standard or custom reports on Salesforce CRM Content data. If the content delivery feature is enabled, you can send content to colleagues, leads, and contacts and then track how often the content has been previewed or downloaded.

Sharing Content in Salesforce
Salesforce CRM Content is also integrated with leads, accounts, contacts, opportunities, cases, products, and custom objects. If Salesforce CRM Content functionality is enabled on the Opportunity tab, for example, Salesforce CRM Content uses the fields on the opportunity detail page to search for files that may be relevant to that opportunity. You can drill down in the search results as needed or run your own search and then attach one or more files to the opportunity. The most current version of the file will be available on the detail page for the life of the opportunity.
Sharing Content in Salesforce Mobile Classic
Salesforce CRM Content is available in Salesforce Mobile Classic. Users can share content with customers and colleagues from the mobile application when they’re away from their desks. Ask your administrator to set up mobile Content.

SEE ALSO:
Differences Between Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments

Contribute Content

Publish Files to Libraries
Publish files to libraries by uploading them from your computer, contributing them from your private library to a shared library, or sharing them from Chatter.

1. On the Libraries tab, do one of the following:
   - To upload a file, click Contribute and choose a file from your local drive.
   - To publish files from your private library, click the My Private Files tab, select one or multiple files, and click Publish Selected.

Or, to share files from Chatter with a library, see Share Files with Libraries on page 148 (and skip the rest of these steps).

2. Enter a title for each file. Optionally, enter descriptions.

3. If you are adding a new file that you just uploaded, choose either Save in my private library or Publish to a shared library. If you choose the second option, select a library. This becomes the managing (home) library, meaning that the content can be shared with another library but only revised by a user with author permissions in the managing library.

4. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you do not choose a language, Salesforce associates your content with your personal language setting. If users restrict their content searches to a particular language, only content associated with that language is displayed in the search result set.

5. To publish the content on behalf of another author, choose that author from the drop-down list.

6. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:
   - If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags in the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags list and the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows the 20 tags you have used most recently. Click a tag to add it to the Tags field automatically.
   - If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new tag. Click a suggested tag to add it to the Tags field automatically.
   - If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When you select a tag it turns green.
   - You can’t change or delete tag names. You can remove tags from a document, but that doesn’t delete the tag.
   - Tags are case insensitive. You can’t have two tags with the same name even if they use different upper and lowercase letters. The case of the original tag is always used.
7. If multiple record types are available, choose one from the drop-down list. The record type determines which custom fields appear for you to categorize and define your content.

8. After completing the custom fields, click **Publish** or **Save**.

**Note:**

- Unique values in custom fields that are set for the first version of a file aren’t included if you upload a new version. You can set the unique values in the new version as long as they aren’t the same as a previous version.
- Files published to a shared library are added to your Files tab and available to other Chatter users in your organization. Files published to your private library are added to your Files tab, but are private and not shared with anyone. For information about the different file tools and solutions in Salesforce, see [Differences Between Files, Salesforce CRM Content, Salesforce Knowledge, Documents, and Attachments](#).
- Contact Manager, Group, Professional, Enterprise, Unlimited, and Performance Edition customers can publish a maximum of 36,000 new versions per 24-hour period. Developer Edition and trial users can publish a maximum of 2,500 new versions per 24-hour period.

**SEE ALSO:**
- Update Content Versions
- Create and Modify Content Packs in Salesforce CRM Content

### Upload and Publish Content

Add files to libraries to take advantage of the permission setting and content delivery capabilities of Salesforce CRM Content.

The Libraries tab has several publishing-related options at the top of the page that let you upload, classify, and publish files, content packs, Web links, and Google docs in Salesforce CRM Content.

**Note:** The **Add Google Doc** button on the Libraries tab is available only if your Salesforce admin has enabled the Add Google Doc to Salesforce service.

To publish files, Web links, and Google docs in Salesforce CRM Content, or to create content packs, refer to the following topics:

- **Publish Files to Libraries**
- **Contribute Web Links to Salesforce CRM Content**
- **Create and Modify Content Packs in Salesforce CRM Content**

**SEE ALSO:**
- Update Content Versions
- Creating Content Deliveries

---

### EDITIONS

**Available in: Salesforce Classic**

**Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions**

**USER PERMISSIONS**

To upload and publish files and Web links:

- **Manage Libraries** checked in your library permission definition
  OR
- **Add Content** checked in your library permission definition

To publish Google docs:

- **Google Apps account**
Salesforce CRM Content File Size Limits

The following are maximum file size limits for files in Salesforce CRM Content:

- 2 GB
- 2 GB (including headers) when uploaded via Chatter REST API
- 2 GB (including headers) when uploaded via REST API
- 38 MB when uploaded via SOAP API
- 10 MB when uploaded via Bulk API
- 10 MB for Google Docs
- 10 MB when uploaded via Visualforce

SEE ALSO:
- File Size Limits in Salesforce

Contribute Web Links to Salesforce CRM Content

To classify and publish a Web link in Salesforce CRM Content:

1. Click the Libraries tab.
2. To add a new link, click Contribute > Do you want to link to a website instead?, then enter the URL, and click Contribute. To publish a link that is already in your private library, click the My Private Files tab, locate the link, and click Publish.
3. Assign a title and description to your Web link.
4. Choose a library. This becomes the managing (home) library, meaning that the Web link can be shared with another library but its content details page can only be edited by a user with relevant permissions in the managing library. If you do not want the link to be visible to other users in your organization, choose Save in my private library.
5. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you do not choose a language, Salesforce associates your content with your personal language setting. If users restrict their content searches to a particular language, only content associated with that language is displayed in the search result set.

To publish the content on behalf of another author, choose that author from the drop-down list.

7. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:
   - If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags in the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags list and the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows the 20 tags you have used most recently. Click a tag to add it to the Tags field automatically.
   - If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new tag. Click a suggested tag to add it to the Tags field automatically.
   - If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When you select a tag it turns green.
   - You can’t change or delete tag names. You can remove tags from a document, but that doesn’t delete the tag.
• Tags are case insensitive. You can’t have two tags with the same name even if they use different upper and lowercase letters. The case of the original tag is always used.

8. If multiple record types are available, choose one from the drop-down list. The record type determines which custom fields appear for you to categorize and define your content.

9. After completing the custom fields, click Publish or Save.

SEE ALSO:
Manage Libraries

Update Content Versions
Clicking a file name on any Salesforce CRM Content tab opens the content details page.

Publishing a New Version
To publish a new version of the file and update its properties:
1. Click Edit > Upload New Version. This option does not appear for Web links, content packs, or Google docs.
   To add or remove files from a content pack, see Create and Modify Content Packs in Salesforce CRM Content.
2. Click Browse to find and select the updated file.
3. As needed, update the Title and Description fields.
4. Fill out the Reason for change field. This text is included on the email notifications sent to subscribers and the version list located on the content details page.
5. To publish the content on behalf of another author, choose that author from the drop-down list.
6. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:
   • If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags in the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags list and the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows the 20 tags you have used most recently. Click a tag to add it to the Tags field automatically.
   • If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new tag. Click a suggested tag to add it to the Tags field automatically.
   • If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When you select a tag it turns green.
   • You can’t change or delete tag names. You can remove tags from a document, but that doesn’t delete the tag.
   • Tags are case insensitive. You can’t have two tags with the same name even if they use different upper and lowercase letters. The case of the original tag is always used.
7. Update any custom fields as needed.
8. Click Publish.
Notes on Content Versions

Consider the following information when creating or modifying a new version:

- You cannot edit a file within Salesforce CRM Content. To edit a file, download it from Salesforce CRM Content to your computer, make your changes, then upload the updated version using the Upload New Version button.
- The Versions subtab on the content details page lists all content versions. The Recent Activity list on the Libraries tab also notifies users of new content versions.
- Contact Manager, Group, Professional, Enterprise, Unlimited, and Performance Edition customers can publish a maximum of 36,000 new versions per 24–hour period. Developer Edition and trial users can publish a maximum of 2,500 new versions per 24–hour period.

SEE ALSO:
Upload and Publish Content

Delete, Archive, and Restore Content

There are two methods for removing content from libraries: archiving and deleting.

Archiving lets you continue to store files in Salesforce without them being in a library or exposed in search results. Deleting files moves them to the Recycle Bin, where files remain for 15 days before being permanently, automatically deleted. Within 15 days of deleting a file, you can restore it from the Recycle Bin. You can also restore archived files.

Before you delete or archive content, it’s important to know what’s similar and different about these two methods:

<table>
<thead>
<tr>
<th>Effects of Archiving or Deleting Content</th>
<th>Archived Content</th>
<th>Deleted Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>Counts towards file storage limits (storage size as well as number of documents)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Removed from libraries</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>New versions can no longer be uploaded</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Content can no longer be downloaded (until restored)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Content no longer appears in search results</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Content can be restored</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatically removed from subscription lists (without notifying subscribers)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Permanently deleted by emptying recycle bin</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

To archive or delete content files:

1. On the Libraries, Content, or Subscriptions tab, click the name of the file you want to remove.
2. On the Content Details page, click Edit > Archive Content or Edit > Delete Content.

To delete files in content packs:
By default, you must first delete the content pack, and then delete the file.

If your admin has enabled the Salesforce CRM Content setting that allows files to be deleted from content packs, you can delete a file without having to first remove it from a content pack. This removes all versions of that file from all content packs, including content packs you don’t have access to, like those in Private Libraries.

**To restore archived content files:**

1. Do one of the following to open the Content Details page for an archived file:
   - Follow a bookmark to the archived content.
   - On the Libraries tab, click a library name to open the Library Details page. Click the View Archived Content link to see a list of archived content on the Content tab. Click the name of the content file you want to restore.
     
     **Note:** The View Archived Content link only displays if you have the Archive Content, Add Content, or Manage Libraries privileges in your library permission. If you have the Archive Content or Manage Libraries privileges, you will see a list of all archived content in the library, regardless of author. If you do not have those privileges but have the Add Content privilege, you will only see archived content that you authored and archived.

2. On the Content Details page, click Edit > Restore Content.

**To restore deleted content:**

1. On either the Libraries or Subscriptions tab, or on the Content Details page, go to the Recycle Bin.

2. Select the checkbox for the content file you want to restore, and click Undelete.

**Note:**
- Authors can always archive and restore their own content. Authors do not require the Archive Content library permission option.
- If a file is in Salesforce CRM Content and also posted in Chatter, archiving it doesn’t remove the Chatter post.
- Deleting a Chatter file from the content details page deletes the file from Salesforce CRM Content and from Chatter.

**SEE ALSO:**

Delete a File from the File Detail Page
Create and Modify Content Packs in Salesforce CRM Content

A content pack is a collection of related documents or files that are stored as a group in Salesforce CRM Content. For example, you may want to create a content pack with a product list, price quote, and contract to send to a particular customer. Any file in Salesforce CRM Content can be added to a content pack, from traditional business documents such as Microsoft® PowerPoint presentations and Adobe® PDF files, to audio files, video files, and Google docs. Using email or instant messaging, you can distribute the content pack to colleagues in your organization or leads and contacts outside your organization. The recipient of a content delivery can click a single URL to open a preview player with which he or she can preview and download the content. You can then view tracking information to see how often the content pack was viewed and which documents were downloaded.

Note: Content packs support all files types; however, the preview player launched by the content-delivery URL displays only PowerPoint, Word, Excel, and PDF files. The preview player does not display copy-protected PDFs. Also, working with content packs requires Adobe Flash® Player, version 9.0.11.5 or higher. If you do not have Flash installed, Salesforce provides a link to Adobe’s website where you can download Flash for free.

To work with content packs:

1. Depending on whether you want to create, customize, or modify a content pack, use one of the following options:

   Note: The following options are available only if Enable content pack creation is selected on the Salesforce CRM Content page in Setup. If content pack creation is disabled after packs have been created, Salesforce doesn’t delete the packs, but they can’t be customized or modified.

   • To create a new content pack, click the Libraries tab and then choose Create New > Content Pack.
   • To create a new content pack by copying an existing pack and adding, removing, or reordering files, open the content details page for the pack and click Clone & Customize.
   • To update a content pack and publish a new version, open the content details page for the pack and click Edit > Edit Content Pack.

2. Click Search files to display all the content in your libraries. To refine your results, select a specific library to search or enter a search term in the text box.

   In addition to files and documents, search results also list content packs.

3. Drag the desired content from the search results into the assembly section in the lower half of the window. The following options help you assemble your content pack:

   • In the search results, click a document to preview it in the lower half of the window. Choose Add to Content Pack or Hide preview as needed.
   • In the search results, hover over a document and click the folder icon ( ) to view the content packs that use the document.
   • In the search results, hover over a content pack and click the folder icon ( ) to view all the documents in the pack.
   • In the assembly section, hover over a document and click the garbage can icon ( ) to remove that document from the pack you are assembling.
   • Click Clear at any time to revert your changes; click Cancel to return to the Libraries tab.

   Note: The maximum number of files that can be included in a content pack is 50.
4. When you are done assembling or modifying your content pack, click Save and assign or change the content pack’s name.

5. In the Save or Publish Content dialog:
   a. Select a library. If you do not want the content pack to be visible to other users in your organization, for example if your work is still in progress, choose Save in my personal library.
   b. Optionally, add or modify the content pack’s description.
   c. Optionally, choose a language. The Language drop-down list is displayed if multi-language support is enabled. If you do not choose a language, Salesforce associates your content with your personal language setting. If users restrict their content searches to a particular language, only content associated with that language is displayed in the search result set.
   d. If you are modifying the content pack, complete the Reason for Change field.
   e. To publish the content on behalf of another author, choose that author from the drop-down list.
   f. Tag your content. Your tagging permission depends on the tagging rule assigned to the library:
      • If the library does not have a tagging rule or if your administrator assigned the open tagging rule, you can enter tags in the Tags field. As you type a tag, Salesforce CRM Content autosuggests tags based on your My Recent Tags list and the Popular Tags section on the Libraries tab. The My Recent Tags list on the Contribute window shows the 20 tags you have used most recently. Click a tag to add it to the Tags field automatically.
      • If your administrator assigned the guided tagging rule, you can choose from the list of suggested tags or enter a new tag. Click a suggested tag to add it to the Tags field automatically.
      • If your administrator assigned the restricted tagging rule, you must choose from the list of suggested tags. When you select a tag it turns green.
      • You can’t change or delete tag names. You can remove tags from a document, but that doesn’t delete the tag.
      • Tags are case insensitive. You can’t have two tags with the same name even if they use different upper and lowercase letters. The case of the original tag is always used.
   g. If multiple record types are available, choose one from the drop-down list. The record type determines which custom fields appear for you to categorize and define your content.
   h. Click Publish. You can then view the content details page, return to the Libraries tab, or publish another file.

SEE ALSO:
Viewing and Editing Content Deliveries
Find Content

Find Salesforce CRM Content Related to Records

Quickly find content files that are related to leads, accounts, contacts, opportunities, products, cases, or custom objects by using the related lists on those records.

If your organization has Salesforce CRM Content enabled, you can take advantage of Salesforce CRM Content functionality on detail pages for leads, accounts, contacts, opportunities, products, cases, or custom objects. The Related Content related list allows you to search for files, content packs, Web links, or Google docs and attach them to the record. When you attach a file, the latest version will be available for the life of the record unless the file is removed.

Note: The Related Content and Content Deliveries related lists are only available on a record if they have been added to the corresponding page layout by an administrator.

From the Related Content related list, you can:

- Click the content’s title to view the content details page where you can perform several tasks, such as commenting and voting on content, downloading files, opening Web pages and Google docs, and subscribing to content, authors, tags, or libraries. For more information, see View and Edit Content Details.

- Click Del next to a piece of content to remove it from the record. This does not delete the content from the Salesforce CRM Content library.

- If content deliveries are enabled in your organization, click Deliver Content to create a content delivery. A content delivery allows you to easily convert documents such as Microsoft® PowerPoint and Word files into an optimized web-based version for easy online viewing. Once you create your delivery, you can send its encrypted URL to any recipient, such as leads, customers, partners, and colleagues, and then track how often the content is viewed or downloaded. Content deliveries are available in Salesforce Classic only. However, Lightning Email generates delivery-based links as email attachments for Lightning Experience users who have access to the Content Deliveries feature. For more information, see Creating Content Deliveries.

- Search for related content:
  1. Click Find Content or Search All. In both cases, Salesforce CRM Content searches within the libraries that you have access to. If you click Search All, the search results display all the content in your libraries. For the Find Content search, your search results contain content that is relevant to the record; Salesforce CRM Content searches for content with text or attributes that match the following fields:
     - On an opportunity, the Opportunity Name, Account Name, and all competitors and products.
     - On an account, the Account Name and Industry.
     - On a case, the Case Reason, Subject, Account Name, and Industry.
     - On a lead, the Name, Company, Industry, and Title.

     Note: On a custom object, clicking Find Content returns search results that contain the full custom object name in the document’s text or attributes. If no content meets this criterion, the search results will be empty and a Search All search should be used instead.

  2. On the search results page, filter your results as needed by entering search terms or selecting filter criteria from the sidebar.

  3. Click Attach for any file that you want to attach to the record.

  4. Click the Back link to return to the detail page.
Search for Content

The Content tab displays files, content packs, Web links, and Google docs published in your Salesforce CRM Content libraries. If Chatter is enabled, and your administrator has enabled the setting to show Salesforce Files in Salesforce CRM Content, files posted to Chatter groups, and other files that aren't private or privately shared, are also displayed on the Content tab. The top twenty most recently modified items are listed by default. You can filter the list using the Filter Your Results sidebar.

To search for specific content:

1. From the Search drop-down list, restrict your search to a specific library or choose to search in all libraries. If available, restrict your search to just Salesforce Files or just files in Chatter groups you’re a member of.

   Tip: To display all the locations where the content appears, click Display Options and select Display Locations. The locations are listed under each title.

2. Enter your search term(s) and click Go! Salesforce CRM Content performs a full-text search of the following document types: rich text format (RTF), UTF-8 encoded TXT, HTML, XML, Adobe® PDF, and Microsoft® Office 97 through Microsoft Office 2007 Word, Excel, and PowerPoint files.

3. If your administrator has enabled multi-language support, you can restrict your search to a specific language. By default, Salesforce CRM Content searches all the content in your libraries that is published in your default user language. Searching in all languages also searches the titles, author names, tags, file extensions, and custom fields of content in all languages.

   Note: Searching in all languages does not search the text or description of documents that were published in languages other than your default user language.

4. Optionally, in the Filter Your Results sidebar, filter your search results by file format, featured content, author, tag, libraries, language, custom field, or Chatter group (if available). The number in parentheses next to each filter type shows you how many matching files, content packs, Web links, and Google docs are in the search results.

The Content tab provides several options:

- Click Display Options to customize your view by adding sortable columns for various content criteria (such as Size and Publication Date), or choosing to display descriptions, tags and locations. Display Locations shows the libraries and Chatter groups where the content appears. My Libraries: none or My Chatter Groups: none means that the file is a Salesforce file and is not part of any libraries or Chatter groups. The “smart bar” graphic for downloads, comments, ratings, and subscribers allows you to compare files, content packs, Google docs, and links within a search result set.

   Note: Chatter groups are only included in Display Locations if Chatter is enabled, and your administrator has enabled the setting to show files in Salesforce CRM Content.

- Select one or more files and click Download to create a zip file with your selected content. Web links and Google docs cannot be included in zip files.

- Hover over a file icon to see a snapshot of information about the specific file, content pack, Google doc, or Web link and options such as subscribing, voting, and downloading.

- Click the subscription icon next to the file name to toggle a subscription on or off. For more information, see View and Edit Content Subscriptions.

- Click the file name to view the content details page. The content details page provides all the available information about a file, content pack, Google doc, or link. For more information, see View and Edit Content Details.

Search supports several file types and has file size limits. If a file exceeds the maximum size, the text within the file isn’t searched, but the file’s author name, tags, file extension, and custom fields are.
<table>
<thead>
<tr>
<th>File Type</th>
<th>File Extensions</th>
<th>Maximum File Size for Search</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTML</td>
<td>.htm, .html, .xhtml</td>
<td>5 MB</td>
</tr>
<tr>
<td>PDF</td>
<td>.pdf</td>
<td>25 MB</td>
</tr>
<tr>
<td>PPT</td>
<td>.ppt, .pptx, .pptm</td>
<td>25 MB</td>
</tr>
<tr>
<td>RTF</td>
<td>.rtf</td>
<td>5 MB</td>
</tr>
<tr>
<td>Text</td>
<td>.c, .cpp, .css, .csv, .ini, .java, .log, .sql, .txt</td>
<td>5 MB</td>
</tr>
<tr>
<td>Word</td>
<td>.doc, .docx, .docm</td>
<td>25 MB</td>
</tr>
<tr>
<td>XLS</td>
<td>.xls, .xlsx, .xlsm</td>
<td>5 MB</td>
</tr>
<tr>
<td>XML</td>
<td>.xml</td>
<td>5 MB</td>
</tr>
</tbody>
</table>

**SEE ALSO:**
- [Search for Files](#)

**View and Edit Content Details**

**USER PERMISSIONS**

<table>
<thead>
<tr>
<th>Permission</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To preview and download shared content</td>
<td>Member of the library</td>
</tr>
<tr>
<td>To preview and download private content</td>
<td>None</td>
</tr>
<tr>
<td>To upload a new version</td>
<td>Add Content checked in your library permission definition</td>
</tr>
<tr>
<td>To archive and restore content</td>
<td>Archive Content checked in your library permission definition OR Author of the content</td>
</tr>
<tr>
<td>To permanently delete content</td>
<td>Delete Content checked in your library permission definition</td>
</tr>
<tr>
<td>To view and edit comments</td>
<td>Modify Comments checked in your library permission definition</td>
</tr>
<tr>
<td>To delete comments</td>
<td>Delete Comments checked in your library permission definition</td>
</tr>
<tr>
<td>To tag content</td>
<td>Tag Content checked in your library permission definition</td>
</tr>
<tr>
<td>To mark content as featured</td>
<td>Feature Content checked in your library permission definition</td>
</tr>
</tbody>
</table>

**EDITIONS**

Available in: Salesforce Classic

Available in: [Contact Manager](#), [Group](#), [Professional](#), [Enterprise](#), [Performance](#), [Unlimited](#), and [Developer](#) Editions
Collaborate with Everyone

Create, Share, and Organize Files

<table>
<thead>
<tr>
<th>To deliver content from a shared library:</th>
<th>Deliver Content checked in your library permission definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>To deliver content from a personal library:</td>
<td>Deliver Uploaded Files and Personal Content checked in your library permission definition</td>
</tr>
<tr>
<td>To post content from a library to a Chatter feed:</td>
<td>Post Content to Chatter Feeds checked in your library permission definition</td>
</tr>
</tbody>
</table>

Clicking a file name on the Libraries, Content, or Subscriptions tabs opens the content details page, which is a central access point to preview content and gather information about a particular file, Web link, content pack, or Google doc in Salesforce CRM Content. Starting with the Summer ’10 release, if Chatter is enabled for your organization, files posted to Chatter are also listed.

The Preview tab displays if your file is one of the following types:

- Adobe® PDF. Copy-protected PDFs can’t be previewed.
- JPG, BMP, GIF, and PNG.

The following options may be available on the Content Details page, depending on: the type of content you are viewing; your library permissions; and whether the content is in a public or private library, or from Chatter:

- Click the thumbs up or thumbs down icon to vote for the file, Web link, content pack, or Google doc. To change your vote, click the opposite icon. After you cast a vote, the Recent Activity list on the Libraries tab indicates whether you like or dislike the content.
- Click Deliver Content to create a content delivery. Click Deliver Content > Show Content Deliveries to view a list of deliveries associated with the content.
- For Web links or Google docs, click the Open button to open the Web page in a separate window. For files, click the Download button to open or save the file.
- Click Subscribe or Subscribed to toggle your subscription on or off.
- For files, click the Content Packs subtab to see which content packs include this file.
  - Library administrators can click Remove from all to remove the file from all content packs that include the file.
  - Click the name of the content pack that includes the file to view the details of that content pack.
- For content packs, click Clone & Customize to create a new pack by adding or removing files and slides. Salesforce CRM Content saves or publishes your customized pack as new content, not a version of the pack you copied.
- Click Edit > Edit Content Details to modify standard and custom fields.
- Click Edit > Edit Content Pack to create a new version of a content pack by adding or removing files.
- For files, click Edit > Upload New Version to replace the file with a new version. The version option is not available for Web links, content packs, or Google docs.

**Note:** If the Add New Version button is grayed out, your organization has exceeded its file storage allowance and new content cannot be uploaded.

- Click Edit > Archive Content to remove the file, Web link, content pack, or Google doc from the library. Authors can archive and restore their own content regardless of library permissions. If a file is in Salesforce CRM Content and also posted in Chatter, archiving it doesn’t remove the Chatter post.
- Click Edit > Delete Content to delete the file, Web link, content pack, or Google doc from Salesforce CRM Content by moving it to the Recycle Bin. Authors can delete and undelete their own content regardless of library permissions. Deleting a Google doc removes the doc’s association with Salesforce CRM Content but does not delete the doc in Google Apps. You cannot delete a file that is
included in a content pack or content delivery. Deleting a Chatter file from the content details page deletes the file from Salesforce CRM Content and from Chatter.

- Click **Edit > Library Actions** and choose **Move to Another Library** to move the content to a different managing (or “home”) library. Choose **Share to Another Library** to share content into additional libraries without changing the managing library. Sharing or linking content to other libraries enables members of those libraries to find your content. If the managing library and shared library have different tagging rules, the most restrictive tagging rule applies. If you want to remove content from a library where the content is shared, click **Remove from Libraries**. This option does not remove content from its managing library.

- Click the Comments subtab to view, add, edit, or delete comments.

- Click the Versions subtab to view a list of all file versions and the reason-for-change statements provided by the authors.

- Click the Downloads subtab to view a list of all Salesforce CRM Content users who have downloaded the file. Download data is not available for Web links or Google docs.

- Click the Subscribers subtab to view a list of all Salesforce CRM Content users subscribed to the file, Web link, or Google doc. To subscribe to an author, click the drop-down button next to the author’s name. To subscribe to a library, click the drop-down button next to the library name.

- Click a tag name to view all the content associated with that tag. Click the arrow next to the tag to remove the tag or to subscribe to all content with that tag.

- To add a new tag, enter a tag name in the **Add Tags** field and click **Save**. As you type a tag, Salesforce CRM Content autosuggests tags based on the tags in your My Recent Tags list in the Save or Publish window and the Popular Tags section on the Libraries tab.

  **Note:** If your administrator applied a library tagging rule, you may not be able to enter new tags. If the guided tagging rule is applied, you can click **Add Tags** and choose from the list of suggested tags or enter new tags. If the restricted library tagging rule is applied, you can click **Add Tags** and choose from the list of suggested tags, but you cannot enter your own tags.

- Click the author’s name to see a list of the author’s published content. Click the arrow next to the author’s name and choose **Subscribe to Author** to subscribe to all content published by that author.

- Click **Feature or Don’t Feature** to toggle the “feature” designation on or off. Featured content receives a higher priority than similar content in search results; for example, if 100 files contain the search criteria term *sales asset*, any featured files with that term will appear at the top of the search results list. Featured content is also listed on the library overview and library detail pages for quick access.

- Click a library name to view details about the library. Click the arrow next to the library name and choose **Subscribe to Library** to subscribe to all content in the library or **Show Library Content** to view a list of all files, content packs, Web links, and Google docs published to the library.
Using the Content Related List

The Content related list on a record detail page includes links to all of the content that has been associated with that record in Salesforce CRM Content. Click the file name to open the content details page.

Only Salesforce CRM Content users who are members of the library where the content was published can see the published file in the Content related list. For example, if you select the “Big Deal” opportunity when publishing BigDealStrategy.doc into the Sales Collateral library, the Content related list on the “Big Deal” opportunity includes a link to BigDealStrategy.doc only for members of the Sales Collateral library. Users who are not members of that library do not see the link.

You can use the Related Content related list to access Salesforce CRM Content from leads, accounts, contacts, opportunities, products, cases, or custom objects. For more information, see Find Salesforce CRM Content Related to Records on page 192.

SEE ALSO:

Salesforce CRM Content Overview

View and Edit Content Subscriptions

Clicking the Subscriptions tab displays the Subscriptions home page, where you can view your Salesforce CRM Content subscriptions and toggle them off or on.

Note: To subscribe to a file, content pack, Web link, or Google doc, view its content details page and click Subscribe. From the content details page you can also subscribe to a tag, author, or library by using the drop-down menus next to the tag, author, or library name.

On the Subscriptions tab, click the Content, Tags, Authors, or Libraries subtabs to view your subscriptions. Depending on your notification settings, you are notified of changes to your subscribed content via real-time emails or a once-daily email.

Tip: To configure your notification settings, go to your personal information page, click Edit, and select Receive Salesforce CRM Content email alerts. If you want to receive a once-daily summary rather than real-time email alerts, also select Receive Salesforce CRM Content emails as daily digest.

Subscriptions generate the following notifications:

- If you subscribe to a file, you are notified when a viewer adds comments to the file or when a new version of the file is published. If you subscribe to a Web link or Google doc, you are notified when comments are added but not when the link is changed or the doc is edited.
- If you subscribe to a content pack you are notified when a new version of the pack is published. Unless you are subscribed to the individual files within a content pack, you are not notified when new versions of the files are published.
- If you subscribe to a tag, you are notified of any newly published content that is associated to the subscribed tag. To be notified that new versions of the tagged content are available, subscribe to the content.
- If you subscribe to an author, you are notified when the author publishes new content. To be notified that new versions of an author's content are available, subscribe to the content.
If you subscribe to a library, you are notified when new content is added to the library, including existing content that has been newly linked to your subscribed library. To be notified that new versions of the library content are available, subscribe to the content.

Note: External community or portal users who subscribe to content will not see the Download and View Details links in email notifications.

SEE ALSO:
- Update Content Versions
- Follow a File
- Upload a New Version of a File

View and Edit Libraries

Once you have located a Salesforce CRM Content library in the My Libraries area of the Libraries tab home page or on a content details page, click the library name to display detailed information. For details about the publishing options at the top of the page, see Upload and Publish Content.

From the library title area, you can click the following quick links:

- **Browse** to view search results showing all the content in the library.
- **Edit** to change the library name or description.
- **Delete** to delete an empty library. If you want to delete a library that contains content, you must first move the content to another library or delete it and empty the Recycle Bin.

Note: If your Recycle Bin is empty and you are unable to delete the library, another user’s Recycle Bin may contain deleted content from the same library. A library cannot be deleted until all its content is permanently deleted or moved to another library.

- **Edit Members** to add or remove library members or change their library permission.
- **Tagging Rules** to change the tagging method permitted in the library.
- **Record Types** to restrict the record types available to library contributors.
- **View Archived Content** to view a list of archived content in the library. If you do not have the Archive Content or Manage Libraries privilege in your library permission, the archived content list only contains content that you authored and archived, not content that other authors archived.

The library detail page contains the following sections:

**Members**

This section lists all the Salesforce CRM Content users who are members of the library. To limit the member list, enter a username and click Filter. You can filter by the beginning of a username but not the last name.

To add new members to the library:

1. Click Add Members.
2. If the member you want to add isn’t listed, start to enter their first name in the search box and click Find.
3. Select members from the Available Members box. Members can include individual Salesforce CRM Content users or public groups containing Salesforce CRM Content users.
Tip: If you have many Salesforce CRM Content users, create a public group and add it to a library rather than adding users to the library individually.

4. Click Add to add the members to the library.
5. Click Next.
6. Select a library permission for each user or public group and click Save.

To remove a member from the library, click Remove. To change a member’s library permission, click Edit and choose a new library permission from the drop-down list.

Featured Content
This section lists the five pieces of content in the library most recently designated as “featured.” If no content has been featured, this section does not display. Featured content receives a higher priority than similar content in search results; for example, if 100 files contain the search criteria term sales asset, any featured files with that term will appear at the top of the search results list. To see all featured content, click Show All. To toggle the feature status on or off, go to its content details page.

Top Content
This section includes lists that summarize content activity in your library. Within a list, click a file icon to download the content or click the title to open the associated content details page. In the Top Content section you can choose from the following categories:

- **Publication Date**—This content is sorted in descending order according to the most recent publication date. Choose the number of records you want to view from the accompanying drop-down list, or click the Show All button to list all the published files, Web links, and Google docs.

- **Num Downloads**—This content is sorted in descending order according to the highest number of downloads. The bar graphic indicates how one record compares to another. Choose the number of records you want to view from the accompanying drop-down list, or click the Show All button to list all the downloaded content.

- **Rating**—This content is sorted in descending order according to the highest number of thumbs-up votes. Green and red in the bar graphic represent positive and negative votes, respectively. Choose the number of records you want to view from the accompanying drop-down list, or click the Show All button to list all the content with votes.

- **Num Comments**—This content is sorted in descending order according to the highest number of viewer comments. The bar graphic indicates how one record compares to another. Choose the number of records you want to view from the accompanying drop-down list, or click the Show All button to list all the content with associated comments.

Popular Tags
This “tag cloud” shows you how the content in your library has been labeled. Tags are descriptive terms assigned during upload or revision that help classify and organize content. Click a tag name to view search results containing all the files, Web links, and Google docs with that tag. The tag names increase in size within the tag cloud according to popularity, meaning that the largest tags have been assigned to the most content. You can choose to sort the tags alphabetically or by popularity. The tag cloud contains the 30 most popular tags.

Recent Activity
This section is a snapshot of activity within your library. It shows the most recent files, Web links, and Google docs to receive comments, votes, or subscriptions. Featured content and newly published content are also included, but new versions of existing content, archived content, and deleted content do not appear in the Recent Activity section. Use the Older and Newer buttons to scroll through records. The Recent Activity section contains a maximum of 100 records.
Most Active Contributors
This section shows the authors who have uploaded content into your library most frequently. The names increase in size according to activity, so the largest names are the authors who have contributed the most content.

SEE ALSO:
Manage Libraries
Update Content Versions

Manage Libraries
On the Libraries tab, access your private library, create new libraries, choose libraries to view or edit, and analyze library usage and activity. For details about the publishing options at the top of the page, see Upload and Publish Content. The libraries home page has two tabs: Shared Content, which provides information about shared libraries, and My Private Files, which contains information about your private library.

Shared Content
The Shared Content tab on the libraries home page contains the following sections:

My Libraries
This section lists all the libraries to which you have access. Click a library name to view details about that library or click Browse to view a list of all the content in the library. Click the New button to create new libraries, add users to a library, or assign library permissions to users.

Featured Content
This section lists the five pieces of content in your libraries most recently designed as “featured.” Featured content receives a higher priority than similar content in search results; for example, if 100 files contain the search criteria term sales asset, any featured files with that term will appear at the top of the search results list. To see all featured content, click Show All. To toggle a piece of content’s feature status on or off, go to its content details page.

Top Content
This section includes lists that summarize content activity across all your libraries. Each list sorts content according to specific criteria. Within a list, click a file icon to download content or click a title to open the associated content details page. In the Top Content section you can choose from the following categories:

- **Publication Date**—This content is sorted in descending order according to the most recent publication date. Choose the number of records you want to view from the accompanying drop-down list, or click the Show All button to list all the published files, Web links, and Google docs.

- **Num Downloads**—This content is sorted in descending order according to the highest number of downloads. The bar graphic indicates how one record compares to another. Choose the number of records you want to view from the accompanying drop-down list, or click the Show All button to list all the downloaded content.

- **Rating**—This content is sorted in descending order according to the highest number of thumbs-up votes. Green and red in the bar graphic represent positive and negative votes, respectively. Choose the number of records you want to view from the accompanying drop-down list, or click the Show All button to list all the content with votes.
- **Num Comments**—This content is sorted in descending order according to the highest number of viewer comments. The bar graphic indicates how one record compares to another. Choose the number of records you want to view from the accompanying drop-down list, or click the **Show All** button to list all the content with associated comments.

**Popular Tags**
This section, commonly referred to as a “tag cloud,” shows you how the content in your libraries has been labeled. Tags are descriptive terms assigned during upload or revision that help classify and organize content. Click a tag name to view search results containing all the files, Web links, and Google docs with that tag. The tag names increase in size within the tag cloud according to popularity, meaning that the largest tags have been assigned to the most content. You can choose to sort the tags alphabetically or by popularity. The tag cloud contains the 30 most popular tags.

**Recent Activity**
This section is a snapshot of activity within your libraries. It shows the most recent files, Web links, and Google docs to receive comments, votes, or subscriptions. Featured content and newly published content are also included, but new versions of existing content, archived content, and deleted content do not appear in the Recent Activity section. Use the **Older** and **Newer** buttons to scroll through records. The Recent Activity section contains a maximum of 100 records.

**Most Active Contributors**
This section shows the authors who have published content into your libraries most frequently. The names increase in size according to activity, so the largest names are the authors who have contributed the most content.

**My Private Files**
The My Private Files tab on the libraries home page is your private library. When you upload or create content and do not select a public library, your content is stored in your private library. You can publish content to a public library at any time or leave content in your private library indefinitely. Content in your private library can be assembled in content packs. It can also be sent to leads and contacts outside your organization using the content delivery feature. See Set Up Content Deliveries for more information. The My Private Files tab has the following sections:

**Private Library**
If you choose the **Save to my private library** option when publishing a file, Web link, content pack, or Google doc, your content is saved here. You can publish or delete files from this list or click the file’s name to view its content details page. The following options that are available on the content details page for shared content are not available for private-library content: tagging, rating, subscribing, tracking downloads, tracking subscriptions, or using custom fields. If you publish a file from the Private Library list and click **Cancel** during the publishing process, your file is deleted.

**Upload Interrupted**
If an error occurs when you are uploading a new file, for example your browser crashes or your session times out, the file you were uploading is saved here. Click **Publish** to publish the file to a public library or save it to your private library. If you click **Cancel** on the Save or Publish Content dialog, your file will be deleted.

**Revision Upload Interrupted**
If an error occurs when you are uploading a new version of a file, the file you were uploading is saved here. Users can continue to access the original version. Click **Publish** to publish the file to a public library or save it to your private library. If you click **Cancel** on the Save or Publish Content dialog, your file will be deleted.

SEE ALSO:

- Create and Modify Content Packs in Salesforce CRM Content
Content Deliveries

Creating Content Deliveries

A content delivery allows you to easily convert documents such as Microsoft® PowerPoint and Word files into an optimized web-based version for easy online viewing. Once you create your delivery, you can send its encrypted URL to any recipient, such as leads, customers, partners, and colleagues, and then track how often the content is viewed or downloaded. Content deliveries are available in Salesforce Classic only. However, Lightning Email generates delivery-based links as email attachments for Lightning Experience users who have access to the Content Deliveries feature.

A content delivery can be created from the Content Deliveries related list on most Salesforce objects. Salesforce CRM Content users can also create a content delivery from the content details page or the Related Content related list.

To create a new content delivery:

1. From the Content Deliveries related list, Related Content related list, or the content details page, click Deliver Content.

2. Upload a file or confirm the file name. If you are a Salesforce CRM Content user, search for the content in your libraries that you want to deliver. Salesforce CRM Content users can search for content in shared libraries or a personal library.

3. Optionally, modify the Delivery Name field. This is the name that identifies your content delivery in Salesforce. We recommend using a name that will make the delivery easily distinguishable from other deliveries on the same record. The default delivery name includes the file name and today’s date.

4. Select the delivery methods that determine how your content can be viewed. The options that appear depend on the file format you uploaded.
   - Choose Allow Recipient to View in the Browser to create an online version of the file that recipients can view in their browser.
   - Choose Allow Recipient to Download as [file type] file to allow the recipient of your content delivery to view the content in its original format. For example, if you uploaded a Microsoft® Word file, this field will be Allow download as .doc file.

   **Note:** If a preview of the file doesn’t exist in Salesforce, users can download the delivered file regardless of whether or not downloading is allowed. File previews are made the first time they are requested in Salesforce, but not before. Viewing a file’s detail page or posting it to a feed generate file previews.

   - Choose Allow Recipient to Download as PDF to allow recipients to download a .pdf version of the file. This option is only available for Microsoft® PowerPoint, Word, and Excel files.

5. Select Notify Me of First View or Download if you want to receive an email the first time your recipient clicks the content-delivery URL.

6. If the content you are delivering is time-sensitive, select the Remove Access to Content on checkbox and enter an expiration date. By default, the expiration date is 90 days from the current date. After creating your content delivery, you can change the expiration date at any time on the delivery detail page.
7. Optionally, select **Require a Password to Access Content**. When you create the content delivery you will receive a password to include with the delivery URL that you send to your recipients. The password is available for the life of the delivery on the delivery detail page.

8. Optionally, use the lookup to associate your content delivery with a Salesforce record. The record you were viewing when you clicked **Deliver Content** is selected by default.

9. Click **Save & Next**. Your delivery will usually be ready within a few moments, but you can click **Notify Me** to exit the content delivery wizard and be notified via email when your content delivery is ready.

10. If you did not exit the content delivery wizard, click **Preview** to verify that you are satisfied with the delivery.

   **Important:** Formatting in the original file may not display correctly in the online version. If you chose **Allow Recipient to View in the Browser**, preview your content delivery before sending its URL to your recipients. If you are not happy with the quality of the online version, click **Previous** and choose to make your content available in its original file format or a PDF only.

11. Copy and paste the delivery URL and, if applicable, its password into an email or instant message for delivery. The URL is available on the delivery detail page. For more information, see **Viewing and Editing Content Deliveries**.

SEE ALSO:

Share Files via Link
Viewing and Editing Content Deliveries

On the Content Deliveries related list or the Content Deliveries list page, click the name of a content delivery to open the detail page.

Viewing Content Delivery Details

The delivery detail page provides all the information associated with a content delivery, including the number of times the delivery has been viewed, and the delivery settings. The URL providing access to the content delivery is visible only if you have access to the content or to a record associated with the content, or are the content delivery owner. For a description of each field, see Content Delivery Fields.

Editing Content Delivery Details

Click **Expire Now** to immediately remove access to the content delivery. Click **Edit** to modify details such as the delivery methods, expiration date, or the record the delivery is associated with. For a description of each field, see Content Delivery Fields.

Deleting Content Deliveries

Click **Delete** to remove access to the content delivery and delete the delivery record from Salesforce. Salesforce CRM Content users cannot delete files that are associated with a content delivery until the content delivery is deleted.

Tracking Content Deliveries

Each time a content delivery’s URL is opened, Salesforce records the event as a *view*. The Views related list on the content delivery detail page lists every view associated with the delivery. Information about the view includes the date and time, whether the view was by an internal (Salesforce) user, and whether the view included a download. If the content delivery provided the ability to download the file in its original file format or as a PDF file, the **File Downloaded** flag indicates that a download occurred, but you cannot distinguish between file types.

SEE ALSO:

*Create and Modify Content Packs in Salesforce CRM Content*
Using the Content Deliveries Related List

A content delivery allows you to easily convert documents such as Microsoft® PowerPoint and Word files into an optimized web-based version for easy online viewing. Once you create your delivery, you can send its encrypted URL to any recipient, such as leads, customers, partners, and colleagues, and then track how often the content is viewed or downloaded. Content deliveries are available in Salesforce Classic only. However, Lightning Email generates delivery-based links as email attachments for Lightning Experience users who have access to the Content Deliveries feature.

From the Content Deliveries related list on leads, business accounts, contacts, opportunities, cases, campaigns, and custom objects you can:

- Click Deliver Content to create a new content delivery and associate it with the record you are viewing. For more information, see Creating Content Deliveries.
- Click Preview to open the content delivery. Each time you view a content delivery, it is recorded as one internal view on the Views related list.
- Click the content delivery name to open the detail page for that delivery. For more information, see Viewing and Editing Content Deliveries.

Google Apps

Integrate Google apps like Google Docs and Gmail with Salesforce.

IN THIS SECTION:

Google Apps Overview
Use Google Docs in Salesforce
Add Google Docs to Salesforce

Google Apps Overview

Note: Not all Google Apps features are available in Lightning Experience. Those that are available may not look the same as they do in Salesforce Classic.

Google Apps™ is a suite of on-demand communication and collaboration services hosted by Google and designed for business users. Salesforce integrates key Google Apps services and provides several AppExchange apps that enhance and customize Google-related functionality.

The following services for Google Apps are integrated with Salesforce and require a simple activation by a Salesforce administrator:

Add Google Docs to Salesforce

Google Docs™ allows you to create on-demand documents, spreadsheets, and presentations, edit them in your browser, and work together in real time with other collaborators. When the Add Google Docs to Salesforce service is activated, you can:

- Use the Google Docs, Notes, & Attachments or Google Docs & Attachments related list on any Salesforce record to create, edit, or view Google docs and associate them to a record.
- Share a Google doc with any Google Apps user in your organization.
• Associate Google docs with Salesforce records even when you are not working in Salesforce by using the Add Google Doc to Salesforce browser button.
• Add Google docs to Salesforce CRM Content, which allows you to manage all types of content in a centralized location.

Gmail to Salesforce
Gmail™ is a Web-based email application that operates on all standard browsers and can be used with your company’s domain. Use Gmail to Salesforce to automatically log emails you send from your Gmail account as activities on lead and contact records in Salesforce.

Gmail Buttons and Links
Gmail Buttons and Links adds Gmail links next to email fields on all records and adds Compose Gmail buttons in Activity History on leads and contacts. When you select a Gmail link or Compose Gmail, Salesforce automatically logs you in to your Gmail account and automatically populates the To field. If Gmail to Salesforce is activated, Salesforce also populates the BCC field with your Email to Salesforce address.

Use Google Docs in Salesforce
Use Google Docs™ to create and share on-demand documents, presentations, and spreadsheets (“Google docs”) and see your changes in real time as you collaborate with other users. Because your content is stored within Google, there is no need to manage versions or send attachments by email—simply log in with your Google Apps account and view the current document or its revision history.

Salesforce and Google Apps allows you to integrate Google Docs with Salesforce. The Docs home page in your Google Apps account lists all the Google documents, presentations, and spreadsheets that you have created or that other Google Apps users have shared with you.

For information about Google Docs, refer to Google’s online help.
Add Google Docs to Salesforce

Add an existing Google doc to any record or library in Salesforce.

Note: To use a Google Apps service in Salesforce, you must be logged in to your Google Apps business account. Business accounts use your organization’s domain; for example, john.doe@company.com. If you are unsure of your Google Apps username and password, contact your administrator.

Add a Google Doc to a Salesforce Record

1. Open a case, opportunity, or other record.
2. On the Google Docs, Notes, & Attachments related list or the Google Docs & Attachments related list, click Add Google Doc.
3. Enter the name of the Google doc.
4. Enter the Google doc URL.
5. Click Save.

Add a Google Doc to a Salesforce CRM Content Library

1. On the Libraries tab or on a library detail page, click Add Google Doc. Log in to Google Apps if prompted.
2. Enter the Google Doc URL.
3. Click Contribute.
4. Enter a title and select a library. See Publish Files to Libraries for detailed instructions on publishing content to a library.
5. Click Publish.

Note: While you have your Google doc open, remember to share it with other Google Apps users in your organization. Only people with access to the Google doc in their Google Apps account can open the doc from Salesforce.

Tip: For information about using Google Docs, refer to Google's online help.

SEE ALSO:
Use Google Docs in Salesforce

Skype for Salesforce (Beta)

Skype for Salesforce integrates Salesforce and Skype for Business®, allowing your users to chat with and make audio and video calls to other users without leaving Salesforce. Skype for Salesforce is available only if your business has a Skype for Business online license.

Note: This release contains a beta version of Skype for Salesforce, which means it’s a high-quality feature with known limitations. Skype for Salesforce isn’t generally available unless or until Salesforce announces its general availability in documentation or in press releases or public statements. We can’t guarantee general availability within any particular time frame or at all. Make your purchase decisions only on the basis of generally available products and features. You can provide feedback and suggestions for Skype for Salesforce in the IdeaExchange.
In this section:

**Enable Skype for Salesforce**
Enable Skype for Salesforce in your org, and authorize Salesforce to access Skype for Business®.

**Give Users Skype Conversation Permissions**
Skype for Salesforce integrates Salesforce and Skype for Business®, allowing you to communicate with other users in your org. Your users can’t use Skype for Salesforce until you’ve created a permission set and assigned it to them.

**Chat Using Skype for Salesforce**
Initiate Skype chat, video calls, and audio calls within Salesforce.

---

**Enable Skype for Salesforce**
Enable Skype for Salesforce in your org, and authorize Salesforce to access Skype for Business®.

1. From Setup, enter *Skype for Salesforce* into the Quick Find box, then click *Skype for Salesforce*.
2. Click *Enable Skype Presence, Chat and Audio/Video (Beta)*.
3. Click *Authorize Skype for Salesforce* and ask your org’s Microsoft Office 365® administrator to sign in. This gives Salesforce access to Skype for Business.
   a. From Setup, enter *Critical Updates* in the Quick Find box, then click *Critical Updates*.
   b. For the Enable Lightning LockerService Security critical update, click *Deactivate*.
   c. Enter a comment, and then click *Deactivate*.
5. Enable Notes for your org if you want to give users the ability to save chat conversations.

   **Note:** Users can chat using Skype for Salesforce on any supported browsers for Lightning Experience. Users can make audio and video calls using Skype for Salesforce only from Microsoft Edge or Apple Safari®.

---

**SEE ALSO:**

**Give Users Skype Conversation Permissions**

---

**EDITIONS**

Available in: Lightning Experience

Available in: **Developer**, **Enterprise**, **Performance**, **Professional**, and **Unlimited** Editions

**USER PERMISSIONS**

To enable Skype for Salesforce:

- “Customize Application”

---

208
Give Users Skype Conversation Permissions

Skype for Salesforce integrates Salesforce and Skype for Business®, allowing you to communicate with other users in your org. Your users can’t use Skype for Salesforce until you’ve created a permission set and assigned it to them.

1. From Setup, enter Permission Sets into the Quick Find box, then click Permission Sets.
2. Either create a permission set or click an existing one.
3. Click System Preferences.
4. Click Edit.
5. Select the Skype Conversation permission, and click Save.
6. Click Manage Assignments.
7. Select which users you want to give access to Skype for Salesforce, and click Add Assignments.

When Skype for Salesforce is enabled, users who have the Skype Conversation permission see a banner prompting them to sign in to Microsoft Office 365®. After they link their Office 365 account to Salesforce, users can see who’s online, initiate audio and video calls, and chat.

SEE ALSO:
Enable Skype for Salesforce

Chat Using Skype for Salesforce

Initiate Skype chat, video calls, and audio calls within Salesforce.

To use Skype for Salesforce, you must have a Microsoft Office 365® account. Also make sure that your Salesforce admin has enabled the feature, and given you the Skype Conversation permission.

1. When you log in to Salesforce, a banner prompts you to log in to Office 365. Click Connect Office 365.
2. Click Sign in and use your Office 365 or Skype for Business® credentials to sign in.

Now that you’ve signed into Office 365, on any Lightning Experience page, hover over someone’s name. You see their Skype presence—whether they are online or offline—and the Message button.

To start a chat, click Message. If Notes is enabled for your org, click Save Conversation to save your chat as a note. Saved chats are accessible on the Notes tab in Salesforce.

To start a conversation, click Message. In the messenger window, click Call or Video Call to initiate a voice or video conversation, respectively.

Note: Users can chat using Skype for Salesforce on any supported browsers for Lightning Experience. Users can make audio and video calls using Skype for Salesforce only from Microsoft Edge or Apple Safari®.

SEE ALSO:
Enable Skype for Salesforce
Collaborate with Partners and Customers

Share updates with customers and partners in Chatter groups.

IN THIS SECTION:

About Chatter Customers in Private Groups

Adding or Removing Customers in Chatter Groups

About Chatter Customers in Private Groups

Chatter customers are users outside your company’s email domains who can only see groups they’re invited to and interact with members of those groups; they can’t see any Salesforce information.

Chatter customers:

- Can only be added to Chatter if:
  - A manager or owner of a group that allows customers invites them to the group.
  - An administrator adds them in Setup by entering Users in the Quick Find box, then selecting Users.

- Can only see:
  - Groups they belong to.
  - People in groups they belong to. Customers only see limited profiles including photo, name, title, email, common group memberships, common files, and activity statistics and influence. They can’t post to profiles.
  - Files shared to groups they belong to.

- Can’t see:
  - Records or other Salesforce information, even in search results.
  - Topics, including topics in the feed, the topics list, topic detail pages, Recently Talked About, and Trending Topics. (Customers can see hashtag (#) topics.)
  - Recommendations and can’t be recommended to others. Additionally, groups that allow customers can’t be recommended.

- Are identified as a customer in profiles and groups they belong to. Customers and groups with customers are easily identified by the orange upper left corner of their photo.

- Have limited profiles, including name, photo, title, company, email, feed, group membership, file ownership, and activity statistics and influence.

- Can’t be followed. Additionally, customers can’t follow people or files.

- Can be group members and managers. If the customer is a manager, they will be able to see users who request to join the group, even if they aren’t in other common groups, and approve requests.

- Can’t own, create, delete, moderate, join, or ask to join groups.

- Can invite people that they’re in common groups with to join groups that they manage.

- Can’t invite people inside your company’s domain whose profiles they can’t see.

- Can’t chat on page 104 with other users.
Note:

- When you invite someone as a customer to your group, they are given a unique username and password to log in to this group within your organization, even if they’re already a member of another Salesforce organization. They will not be able to use other Salesforce logins to access your customer group.
- If a customer has an issue logging in to the group, verify that they are using the username and password from the welcome email they received after registering for the group. If the problem persists, ask your administrator for help.
- If a customer loses their password, they can use the Forgot Password option to reset it. If they don’t have their username, they should contact the administrator of the organization in which they’re a customer to recover it.

Considerations for Mobile Users

Chatter customers are able to log in and use the Salesforce1 apps and the Chatter Mobile for BlackBerry app. The same restrictions are applied to customer users as when using Chatter on the Web.

SEE ALSO:

Chatter Groups
Adding or Removing Customers in Chatter Groups

Adding or Removing Customers in Chatter Groups

If customer invitations are enabled for your organization, you can add, remove, and invite customers in private groups you own or manage that allow customers.

1. Navigate to a group detail page.
2. To add people who aren’t already customers in your company, click Invite People, or Add/Remove Members > Invite them to Salesforce Chatter!. Enter email addresses separated by commas, and an optional message, and click Send.

When someone accepts your invitation, they join Chatter and become a member of the group.

3. To add people who are already customers in your company, click Add/Remove Members, then:
   - Search using the Find People search box.
   - Toggle between Members of the group and Everyone in your company.
   - Use the Next and Previous links to see more of the list.
   - Click Add to add a customer, or x to remove a customer.
   - Click Done when you’re finished.

Note:

- When you invite someone as a customer to your group, they are given a unique username and password to log in to this group within your organization, even if they’re already a member of another Salesforce organization. They will not be able to use other Salesforce logins to access your customer group.
- If a customer has an issue logging in to the group, verify that they are using the username and password from the welcome email they received after registering for the group. If the problem persists, ask your administrator for help.
• If a customer loses their password, they can use the Forgot Password option to reset it. If they don’t have their username, they should contact the administrator of the organization in which they’re a customer to recover it.

SEE ALSO:
Add and Remove Chatter Group Members
View Chatter Group Members

Other Resources

Need more info? Check out these videos and tipsheets.

IN THIS SECTION:
Tip Sheets
Videos for Collaboration

Tip Sheets
In addition to online help, Salesforce publishes printable documentation to help you learn about our features. These documents include tip sheets, user guides, and other resources that describe the features and capabilities of Salesforce. These documents are available as Adobe® PDF files. Adobe Reader® is required to open PDF files; to download the latest version of Reader, go to www.adobe.com/products/acrobat/readstep2.html.

Salesforce CRM Content
• Tips for Using Content Deliveries

Videos for Collaboration
In addition to online help, Salesforce creates video demos to help you learn about our features.

Communities and Chatter

<table>
<thead>
<tr>
<th>Video Title</th>
<th>For End Users</th>
<th>For Admins</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎥 Discover and Organize with Chatter Topics (Salesforce Classic)</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Use Chatter topics to see what people are talking about, organize the conversations you want to be a part of, and discover people and groups that are interested and knowledgable in the same areas.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>🎥 Get Started with Salesforce Files Sync</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Learn how to sync files between your computer or mobile device and Salesforce so you always have the latest version of every file.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
INDEX

@mentions
  mentioning groups in posts and comments 48
  mentioning people in posts and comments 48
#tags 63

A
Accounts
  finding related content 192
Action Layout
  customizing 126
Adding
  documents 175
Answers 121
Archived groups 93
Archiving
  content 188
Attachments
  Salesforce CRM Content 192

B
bookmarks
  removing 25
Bookmarks
  adding in Chatter 25
  broadcast groups 84

C
Cases
  finding related content 192
Chat
  available 106
  away 106
  emoticons 107
  history 107
  offline 106
  options 108
  pop-out 108
  starting a chat 106
  status 106
  using 104
  using the chat list 105
Chatter
  activity 73
  add records 102
  adding customers 211
  adding hashtag topics 63
  adding topics 63
  assigning moderator 75
  attaching files 52
  attaching links 57
  auto-following 12
  automatically following records 77
  bookmarks 24
  broadcast groups 84
  chat history 107
  chat status 106
  Chatter Desktop 4
  chatting 104
  comments, live 44, 46
  configuring digests 17
  configuring email notifications 17
  customers 210
  deleting files 56
  direct messages 109
  downloading files 54–55
  email digests 16
  email notifications 16
  email replies 14
  favorites 30
  feed attachments 50
  feed search 26
  feeds overview 20
  file recommendations 26, 153
  Followers list 71
  following files 54
  Following list 71
  following topics 61
  group feeds, live 44
  group recommendations 26, 98
  groups page 86
  influence 73
  inviting people to join 74
  join groups 87
  leave groups 87
  liking posts and comments 13
  link previews 57
  managing email 17
  mentioning people and groups in posts and comments 48
  messages 109
  moderator 75
  mute posts 43
Index

Chatter (continued)
  overview 2
  owned files 73
People page 69
  people recommendations 26, 72
polls 58–59
  pop out chat 108
  post by email 99
  post comments 14
  posting to feeds 37
posts 37, 66–68
  private messages 109
  recommendations 26, 72
  record recommendations 26, 78
records 77
  remove records 103
  removing customers 211
  removing topics 65
search 26
  searching 27
  searching feeds 27
  searching files 53
  sharing files 54
  single updates 68
  starting a chat 106
  tab 3
  thanking people 72
  topics groups are talking about 66
  topics people are talking about 65
  trending topics 66
updates 25
  uploading new versions of files 54
  using Chatter Messenger 104
  using the chat list 105
  viewing files 54–55
Chatter activity 73
Chatter Answers 121
Chatter Desktop
  configuring 6
  connecting 5
  disabling remotely 9
  installing 4
  overview 4
  release information 9
  troubleshooting tips 8
  uninstalling 9
  using 6
Chatter email notifications
  navigate to 16
Chatter email settings
  navigate to 16
Chatter favorites 30
Chatter feed searches
  adding as Chatter favorite 29
Chatter Feeds
  dashboard component snapshot 80
  list views 79
Chatter file recommendations 153
Chatter files
  change permission 145
  deleting 155
  editing file details 154
  external 169, 172
  file detail page 153
  file size limits 142
  filtering 137
  following 152
  make private 145
  searching 135
  shared with 155
  sharing settings and permissions 143
  sharing, privately shared 147, 150
  sharing, via link 150
  sharing, with groups 146
  supported browsers for uploading multiple files 143
  uploading a new version 141
  uploading overview 139–140
  using the Files tab 133
  version history 152
Chatter group recommendations 98
Chatter groups
  accepting requests 91
  adding members 91
  announcements 100
  archiving 89, 93–95
  changing owner 89
  changing roles 93
  comments, live 44
  creating 88
  declining requests 91
  deleting 95
  editing 89
  feeds, live 44
  group files 100
  members 98
  overview 82
  post by email 99
  records 101
Index

Chatter groups (continued)
  removing members 91
  roles overview 92
  unlisted 83
  viewing group details 96
  viewing membership 98
Chatter influence 73
Chatter Moderator
  deactivating free users 76
Chatter Moderators
  assigning moderator privileges 75
Chatter posts
  visibility 38, 49
Chatter publisher
  records 101
Chatter Questions
  reporting 120
Chatter streams
  creating 32
  deleting 35
  editing 34
Chatter Thanks 72
Chatter topics
  topic detail page 60
Chatter updates 68
Collaboration 2
Comments, live 44, 46
Communities
  reporting 120
Contacts
  finding related content 192
Content
  about 182
  archiving 188
  contributing 185
  contributing files 184
  contributing Web links 186
  deleting 188
  downloading 194
  editing a library 198
  file size limits 186
  finding 193
  managing libraries 200
  previewing 194
  publishing 184–186
  related list 192
  removing 188
  restoring 188
  revising 187
Content (continued)
  searching 193
  subscribing 197
  uploading 184–186
  using the Content Related list 197
  versions 187
Content deliveries
  creating 202, 205
  deleting 204
  modifying 204
  tip sheet 212
  viewing 204
Content packs
  creating 190
  modifying 190
  creating groups 88
  custom group 90
  customer groups 101
  Customer Service (Napili)
    Similar Articles 116
    Similar Questions 116
D
Dashboard Components
  following 80
Dashboard Feed
  component snapshot 81
Dashboards
  following components 80
  posting snapshots to a dashboard feed 81
  posting snapshots to group feeds 80
  posting snapshots to user feeds 80
Deleting
  documents 178
Digests, Chatter
  configuring group digests 17
  configuring personal digests 17
  managing 17
Displaying
  documents 179
Document library
  overview 173
Documentation
  implementation guides 212
  printable 212
  tip sheets 212
  user guides 212
Documents
  changing authors 182
Documents (continued)
- deleting 178
- displaying and editing 179
- home page 174
- properties 180
- searching 176
- uploading 175
- viewing from Documents tab 174

E
Editing
- documents 179

Email
- configuring Chatter digests 17
- configuring Chatter notifications 17
- managing 17
- replying to Chatter notifications 14

Email digests
- overview 16
- email to post 99

Emoticons
- chat 107

Escalate Question to Case 125
Escalate to Case
- access 126
- external 167
- external data source 166
- external file 166

F
Favorites, Chatter 30

Feed
- sorting 22
- feed search 27

Feeds
- adding hashtag topics 63
- adding topics 63
- attaching links 57
- attachments 50
- automatically following records 77
- Chatter feed posts 37
- Chatter feeds 20
- Chatter streams 30
- Custom feeds 30
- filtering 21
- filters 22
- following topics 61
- liking posts and comments 13
- mentioning groups 48
- mentioning people 48
- mute posts 43
- posts 37
- removing topics 65
- sorting 21
- streams, creating 32
- streams, deleting 35
- streams, editing 34
- updates 25
- view a single update 68
- viewing feeds 20

Feeds, live 44
file sharing 149
files
- sharing, libraries 148

Files
- attaching to posts 52
- change permission 145
- deleting 155
- editing file details 154
- external data 168–169, 172
- file detail page 153
- file engagement report 156
- file size limits 142
- filtering 137
- following 152
- make private 145
- overview 132
- searching 135
- shared with 155
- sharing settings and permissions 143
- sharing, libraries 148
- sharing, privately shared 147, 150
- sharing, via link 150
- sharing, with groups 146
- supported browsers for uploading multiple files 143
- uploading a new version 141
- uploading overview 139–140
- using the Files tab 133
- version history 152

Files Connect
- external 168

Files home 133

Files tab
- filters 137
- using 133
- find in feed 27
- freeze sharing 149
frozen file 149

G
Getting started
  implementation guides 212
tip sheets 212
  user guides 212
Google Apps
  overview 205
Google Docs
  creating 207
  overview 206
group announcements 100
group type 90
Groups
  mentioning in posts and comments 48

H
Hashtag topics
  adding to posts and comments 63
Hashtags 63

I
Implementation guides 212
Inviting people to join Chatter 74

K
Knowledge Deflection 117
Knowledgeable people
  about topics 61

L
Leads
  finding related content 192
Links
  attaching to feed 57
  content preview 57
List views
  adding as Chatter favorite 79
  Chatter 79
  feeds 79
  following 79

M
Mentions
  in posts and comments 48
Messages
  searching 110
  sending 111
Moderating Chatter
  deactivating users 76
My Favorites chat list
  adding people 105
  removing people 105
  using 105

N
Navigate to
  Chatter email notifications 16
  Chatter email settings 16
Notifications, Chatter email
  configuring 17
  managing 17
  replying to 14

O
Opportunities
  finding related content 192
Options
  chat 108
Overview
  document library 173

P
People
  auto-following 12
  mentioning in posts and comments 48
My Favorites list (chat) 105
My Favorites list (Chat) 105
page 69
  profile best practices 71
  profile overview 70
  starting a chat 106
  using the chat list 105
People recommendations 72
Posts
  attaching files 52
Posts, Chatter 66–68
  prevent file sharing 149
  prevent file unsharing 149
Process Builder 127
Products
  finding related content 192
Profile
  best practices 71
  overview 70
Properties
  documents 180
Index

Q
Question from Chatter 125
Question-to-Case
  enabling 124
  processes 127
  workflows 127
Questions in Chatter 113–114, 116–119
Queues 127

R
Recommendations 26
Record recommendations 78
records
  add to Chatter group 102
  remove from Chatter groups 103
Records
  auto-following 12
  automatically following 77
Reports
  file engagement report 156

S
Salesforce CRM Content
  See Content 182
Salesforce Files
  overview 132
  tab 132
Salesforce Files Sync
  about synced files and folders 160
  access synced files 160
  authenticating 158
  collaborating 160
  connecting 158
  install the desktop client 158
  sharing files 160
  storage limits 162
  sync files and folders 159
  sync limits 161
  system requirements 157–158
  unsupported extensions 163
  unsupported file names 163
  unsupported folder names 164
  using 157
  versioning 161
searching
  Chatter feeds 27
  Chatter groups 27
  groups 27
  profiles 27
searching (continued)
  records 27
Searching
  Chatter 27
  Chatter favorites 29
documents 176
  Salesforce CRM Content 193
Searching messages 110
Sending Chatter messages 111
Sharing
  a link to a Chatter post 68
  Chatter posts 66–67
  Chatter posts with a group 67
Similar Articles 114, 117
Similar Questions 114
Streams
  creating 32
  deleting 35
  editing 34

T
Tip sheets 212
topics 64
Topics
  adding as Chatter favorite 65
  adding hashtags 63
  adding to posts 63
  endorse people for 61
  following 61
  knowledgeable people 61
Recently Talked About 65–66
removing from posts 65
topic detail page 60
Topics
  on files 64
  on notes 64
Trending topics 66

U
unlisted groups
  limitations 83
User
  owned files 73
  profile best practices 71
  profile overview 70
User guides 212

V
Videos 212
Index

Viewing documents 174

viewing a single update 68